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DISCLAIMER
The answers to the frequently asked questions given in this handbook are based on 
an analysis of the query submitted to us on various occasions citing specific cases 
and hence the answers may kindly be treated as indicative, as the responses could 
be varied based on specific facts.  The contents of this handbook are for information 
and broad guidance and do not have any independent legal sanctity. Any use of the 
contents of this handbook may be carried out having due regard to the provisions 
of extant and relevant Acts, Rules, judicial Pronouncements, and Administrative/ 
Technical instructions / Circulars/ Advisories/ Notifications of competent authorities 
wherever applicable. The hyperlinks to websites that have been included as per the 
status as on date of the publication and that are provided for the sake of convenience 
only. CPC is not responsible for the contents or reliability of the hyperlinked websites 
and does not necessarily endorse the views expressed in the third party websites 
and also does not guarantee the availability of the linked pages all the time. Though 
every effort has been made to provide accurate and updated information, it is likely 
that some details may require to be updated or corrected on a continual basis. This 
is a publication for general usage of taxpayers and taxpayers’ representatives at 
large for reference purpose and hence the publisher is not responsible in any manner 
for any damages caused due to references made herein and the Department is not 
responsible. You are required to adhere to the Acts, Rules, Circulars and notifications 
issued from time to time. No part of this handbook can be used as reference in any 
court of law or other statutory purposes as the handbook is an indicative reference 
material only for high level introduction to services provided by the Centralized 
Processing Center, Bangalore. No part of the content may be re-used for any 
publication without prior permission of the Director of Income Tax (CPC), Bangalore 
in writing. Suggestions to improve the handbook are welcome and it is requested 
that errors, if any, may kindly be brought to notice.



MESSAGE
I am happy to see that Centralized Processing Center, Bangalore has prepared 
a handbook in order to provide guidance to taxpayers and taxpayers’ representatives 
regarding e-filing of returns, processing of returns, issue of refunds, validation of bank 
accounts, filing of rectification applications and various other connected topics. The 
answers to the Frequency Asked Questions given in the handbook will definitely 
serve as a ready reckoner on all matters connected to the functioning of CPC. 
I congratulate the CPC Bangalore team for preparing this handbook which will be of 
great help to all. It gives me immense pleasure to release this handbook.

Ms. Anu J Singh, IRS
Principal Chief Commissioner of Income Tax (Delhi)

and Director General of Income Tax (Systems), CBDT
ARA Centre, Ground Floor, 

E-2 Jhandewalan Extension, 
New Delhi 



FOREWORD
Central Processing Center (CPC), Bangalore processes 98% of all the electronic 
returns filed in India. Apart from focusing on the taxpayer services like e-filing of 
returns and other Firms, verifying the returns filed, processing and accounting of 
income tax returns, communication of intimations to taxpayers, issue of refunds and 
grievance redressal, CPC also does the accounting of assessment orders passed 
by Assessing Officers. CPC which was established 10 years ago, has reached a new 
milestone in 2020 by upgrading to a platform that provides near real time processing 
of returns and quicker issue of refunds. 

This handbook, briefly describes services offered by CPC and provides guidance to 
taxpayers and taxpayers’ representatives on all aspects of return filing, processing, 
rectifications, demand management, bank validations, and issue of refunds in a 
simplified manner. CPC had conducted a series of webinars in 2020 in association 
with Regional Chapters of ICAI across the country. Thousands of persons actively 
participated in those webinars and raised questions to the panel of Officers from CPC. 
This handbook is a compilation of all the information that can guide the taxpayers 
and representatives. All Frequently Asked Questions have been classified under 
various domains and answered by a panel of experts from CPC in this handbook. I 
am sure, the contents in the handbook can help in clarifying most of the queries of 
taxpayers and their representatives. 

I would like to emphasize the following for making your tax filing experience smoother 
and quicker. First: Fill all columns in your Income Tax Return Forms correctly, after 
carefully reading all instructions and attach the relevant details that are required. 
Second: Please give the correct e-mail id and cell phone number of the taxpayer as 
primary contact details in the return. Third: Respond promptly to any communication 
from CPC which is received in the mail or mobile number. Fourth: Please contact the 
CPC Help Desk (details given in this handbook) for any queries you have in respect 
of your income tax return. Your suggestions are always welcome!

With best wishes,

Dr Sibichen K Mathew IRS,  

Director of Income Tax (CPC), 
Centralized Processing Center, 

Prestige Alpha, Bertenaagrahara, 
Begur Hobli, Hosur Road, 

Bengaluru – 560 500
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1.1.	 Central Board of Direct Taxes (CBDT) has approved a Scheme for processing of  
	 returns of income ‘Centralised Processing of Returns Scheme, 2011’, in exercise  
	 of the powers conferred by sub-section (1A) of section 143 of the Income Tax  
	 Act, 1961 (43 of 1961) which governs the processing of Returns at CPC, Bengaluru.

1.2.	 CPC commenced the development of the software and processes for  
	 processing of Income Tax Returns (ITR) in February 2009. It processed the first  
	 return on 26/10/2009.

1.3.	 The software and the processes were verified and tested by Standardisation  
	 Testing and Quality Certification (STQC), Department of Information  
	 Technology, Government of India at the time of deployment of the services  
	 to the taxpayers.A quarterly audit is conducted by STQC to verify the  
	 adherence of the Service Level Agreements of the Project. 

1.4.	 CPC has processed more than 38 crore returns since inception in 2009 and 
	 76 lakh of returns during the FY 2020-21 as on 30/9/2020. The accuracy of 
	 processing of ITR has steadily improved over the years and from AY2017-18  
	 onwards all the adjustments u/s.143(1) are made after issuance of notice to  
	 taxpayer and giving an opportunity of hearing using the e-proceedings module  
	 on the website of the Department.

1.5. 	 Over 10.79 Crore refunds totaling to Rs.6 lakh Crores (inclusive of interest)  
	 have been issued directly to taxpayers through a central refund banker without  
	 any manual intervention (till September 2020). Online tracking of the status  
	 of refunds processing from the Department website is enabled for the benefit  
	 of taxpayers. Several improvements have been made by the Department to  
	 ensure secure transmission of the refund to the taxpayers over the years by  
	 evaluating the risks involved. From 1st March 2019, all the refunds are issued only  
	 by Electronic Clearing Service (ECS) mode using the validations of bank account  
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	 numbers in coordination with National Payments Corporation of India. Option  
	 to Pre-validate Bank account number has been enabled for taxpayers. Taxpayer  
	 can select and Pre-validate any active bank account number for which the ECS  
	 remittance of refund is required. 

1.6.	 CPC has achieved a peak processing capacity of 12 lakh returns per day during  
	 the Financial Year 2019-20. Average processing capacity is 3 lakh returns per  
	 day. The average processing time for AY 2019-20 has reduced to 35 days. Efforts  
	 are on, to reduce the timelines further as much as possible. The timelines are also  
	 dependent on the correctness of the inputs provided by the taxpayers in the ITRs.

1.7.	 CPC has minimized the use of paper, by switching over to electronic mode of  
	 service of communications from the Department. Communication to taxpayer  
	 by print mode for notice, order or other communication is sent only when the  
	 same is essential for any purpose, thus reducing carbon footprint  (saving Trees)  
	 substantially. Over 121.93 Cr digitally signed PDF based communications have  
	 been sent by email. Over 111.56 Cr SMS alerts were sent to taxpayer at important  
	 stages of the processing of ITR. Over 5.53 Cr Intimations were sent by Speed  
	 post since inception of CPC in 2009.

1.8.	 70 Customer Service Executives attend to over 4,000 calls daily in 3 languages;  
	 over 81 lakh calls have been attended so far. In addition to Toll Free services,  
	 from the month of Dec’14, Online Grievance Portal has been enabled in the  
	 e-filing website of the Department to register the grievance pertaining to CPC.  
	 Resolution to e-nivaran grievances were provided for 5.16 lakh grievances  
	 against 5.16 lakh received during FY 2020-21 (till 30th September 2020). 

1.9.	 Online Rectification requests received from taxpayers are processed within  
	 statutory time limits. Over 63.28 lakh requests have been processed out of 60.27  
	 Lakh requests filed (till Sept 2020). The rectification request from taxpayers have  
	 reduced substantially over the years starting with 4.65% (out of processed cases)  
	 rectifications requests in FY2011-12 to 0.48% (out of processed cases) rectification  
	 requests in FY2019-20, indicating the accuracy of the processing of ITRs.

1.10.	 CPC has stored over 27.38 Cr physical documents through a Record Management  
	 Service and has been awarded ISO 15489 certification, the first entity in Asia to  
	 achieve this. The physical documents can be accessed by the Department either as  
	 soft copy on the system or as hard copy.

1.11.	 CPC processes related to Quality Management System has been certified by  
	 ISO 9001-2015. Information Security Management System has been certified by  
	 ISO 27001-2013. The Record Management System has been certified by ISO  
	 15489-2016 and IT Services Management System at CPC is compliant to 
	 ISO 20000-1.

1.12.	 Taxpayer Services Facilitation

1.12.1.	 Dedicated Website: 24/7 Anytime/Anywhere Services to taxpayers

	 Taxpayers and their representatives are encouraged to verify the status of the  
	 ITR and other matters associated with the processing of the ITR on the De 
	 partment’s website on https://www.incometaxindiaefiling.gov.in which is avail 
	 able on the internet and can be logged in at any time on 24/7 mode without  
	 any dependency. The services of CPC can be availed by logging into account  
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	 which enables the taxpayers to give responses, verify the status of ITR, tax  
	 credit mismatch reports, raise grievances under e-Nivaran and other services.  
	 They can use the Help Menu to know about the Frequently Asked Questions  
	 about all the processes related to taxpayer services of Income Tax Department  
	 related to ITR processing.

1.12.2.	 e-filing:

	 The Chartered Accountants and professionals and taxpayers can call  
	 18001030025 for queries pertaining to e-filing of Income Tax Return or Forms,  
	 Pre-validation of bank account number, e-proceedings, compliance related  
	 matters and other value added services provided through e-filing Portal. 

	 Other numbers for e-filing are +91-80-46122000 or +91-80-26500026. In  
	 emergency circumstances email can be sent to efilingwebmanager@ 
	 incometax.gov.in.  Considering the number of users using the facility, the  
	 time for response can  vary. However, response is given within a reasonable  
	 ime which would be within 10 working days.

1.12.3.	 CPC Bengaluru:

	 Taxpayers and their representatives can call toll Free phone number  
	 18004252229 (BSNL Toll Free Number - India) or 18001034455 (Airtel Toll  
	 Free Number - India) for queries regarding ITR validation, ITR processing,  
	 defective returns, online Rectification, Refund issuance, legal heir, Intimation  
	 and other Income Tax Return Processing.  Other numbers for CPC are 
	 080-22546500 (Toll Number – India & abroad). In emergency circumstances  
	 email can be sent to cpcitr.grievance@incometax.gov.in. Considering the  
	 number of users using the facility, the time for response can vary. However,  
	 response would be given within a reasonable time.

	 CPC makes outbound calls using system based number 080-49397200 in  
	 certain circumstances to alert taxpayer/Chartered Accountants/Professionals  
	 and seek their attention related to taxpayer services. Further details related  
	 to Customer Service at CPC can be seen in Chapter 2.

1.12.4.	 Aayakar Sampark Kendra:

	 General Queries related to Income Tax are taken up by Aayakar Sampark  
	 Kendra (ASK) on toll Free number 1800 180 1961 (or) 1961.

1.12.5.	 TRACES, Ghaziabad (For TDS related queries):

	 For queries related to Form 16, Tax Credit (Form 26AS) and other queries related  
	 to TDS statement, Form 15CA processing Chartered Accountants Professionals  
	 or taxpayers may contact TDS Reconciliation Analysis and Correction  
	 Enabling System (TRACES) on toll Free number 1800 103 0344 (or) 
	 +91-120-4814600. The Chartered Accountant, Professionals and taxpayers  
	 can send their queries to contactus@tdscpc.gov.in.

1.12.6.	 TIN-NSDL (For PAN/TAN queries):

	 Telephone calls for queries related to PAN & TAN application for Issuance/ 
	 Update through NSDL can be made to +91-20-27218080 and email can be  
	 sent to tininfo@nsdl.co.in.
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2.1.	 Centralized Processing Center of Income Tax Department (CPC), has enabled  
	 customer service to address queries of the Tax payers and representatives of  
	 taxpayers by inbound tele-calling services, where executives are enabled to  
	 provide response to queries of the taxpayers.The Queries are basically on  
	 ITR status, Processing, Rectification, Refund, legal heir matters and intimation  
	 with respect to Income Tax returns that are processed at CPC.

	 Communication Channels enabled by CPC are as under:

2.1.2.	 In customer service we have different categories of service to address  
	 Taxpayers query,

	 a.	Inbound Call receipt service

	 b.	Outbound Calling service

		  •	 Demand follow up Calls

		  •	 Grievance related Calls

	 c.	ITBA Help desk for Assessing Officers for both inbound & outbound calls.

2.1.3.	 IVRS: Interactive Voice Response System 

	 Tax payer is required to dial CPC call centre on 18004252229/18001034455  
	 (BSNL Toll Free Number - India) 18001034455 (Airtel Toll Free Number - India)  

CHAPTER 2
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	 or 080-22546500 (Toll Number – India & abroad) for to reach customer 	  
	 service desk of CPC.

 2.1.4.	 Calls are first picked up by the Interactive Voice Response System (IVRS).

	 The caller is required to enter certain details in the IVRS, such as numeric  
	 part of PAN and DOB/DOI, if it is a Unique combination then taxpayer is  
	 required to validate through Assessment Year and if it is not a unique  
	 combination, then the taxpayer is required to validate through Registered  
	 Mobile number or Registered postal pin code (as registered in e-filing website).  
	 IVRS provides the statuses in relation to ITRV, Processing, Refund and Refund  
	 re-issue, Rectification and Intimation status to the caller. 

2.1.5.	 Caller needs to select option 9 to speak to an executive. Calls are distributed  
	 to the executives based on the language chosen by the taxpayer in the IVRs. 
	 The call lands at the executive based on the language proficiency. 

2.2.	 Inbound Calls from taxpayers to CPC:

2.2.1.	 The calls from taxpayers to the Call Center are received from across the coun 
	 try. These queries are basically on ITR-V status, Processing, Rectification, 
	 Refund, refund reissue, defective returns, response to notices/campaigns issued  
	 by CPC and intimation status of Income Tax returns that are processed at CPC.  
	 The Customer Service team also ensures that clear and timely service is 
	 provided with the help of tools & applications developed for the specific  
	 purpose by CPC.

2.2.2.	 Information provided by the executives on the call is recorded, the Quality  
	 Audits is performed on a daily basis on the calls recorded by the respective  
	 Team Leads. Customer service also has Customers satisfaction survey through  
	 which customer experience is analyzed and necessary changes implemented  
	 periodically. 

2.2.3.	 The queries are handled in 3 different languages - English, Hindi and Kannada. 

	 The most common queries are indicated in the table below:

CALL CATEGORY DESCRIPTION

ITR-V/EVC Any query pertaining to ITRV receipt status or e-verification.

Refund Re-Issue Any query/requests pertaining to refund re-issue.

Refund Any query pertaining to first time refund status.

Demand Any query pertaining to the Demand raised by CPC.

Intimation Any query pertaining to the communications (u/s.143 &154) sent by CPC.

Others Any General queries.

Online Rectification Any query related to e-filed rectification.

Manual Rectification Any query related to Manual rectification filed at CPC.

Transferred to AST Any query pertaining to the Returns which were transferred 
to AST for processing.

Campaign Any query pertaining to the campaigns sent from CPC.

Intimation Re-Send Any enquiry pertaining to the intimation resend requests placed from CS or 
from website.

Campaign Re-Send Any enquiry pertaining to the campaign resend requests placed from CS or 
from website.

Processing Any enquiry pertaining to the processing of the return.

Prima Facie Adjustments(PFA) Any enquiry pertaining to the prima facie (PFA) adjustments in the return.

Pre-Validation Any enquiry pertaining to the pre-validation of the bank account.
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2.3 	 Auto dialer:

	 Customer service also has a facility of triggering auto dialer calls to taxpayers  
	 to remind about outstanding demands and non-verification of ITR.

2.4.	 Outbound calls from CPC to Taxpayers: 

	 Customer service also has outbound call facility. The outbound calls are  
	 made by executives to taxpayers or tax consultants where taxpayers have  
	 raised the grievances, relating to the ITR status and refund reissue. These  
	 calls are also made for response to outstanding demands, defective returns  
	 and returns awaiting taxpayer response to prima facie adjustment proposals.  
	 Customer Service outbound team calls the Taxpayer and takes the follow- 
	 ups. The team also gives the updates based on the current status of the return.  
	 The Outbound calls are made from 080-4939 7200, using a system interface  
	 for dialing and all calls made through the system are recorded and audited  
	 (on sample basis) by the Department.

2.5.	 Demand follow up

	 Customer Service also has Demand follow up calls facility wherein outbound  
	 calls are made to taxpayers or tax consultants where demand has been raised,  
	 and taxpayer is eligible to pay the demand. We also make calls to AO  
	 regarding the arrear demand which is still pending for the approval or  
	 confirmation as disagreement reasons provided by taxpayers.

2.6.	 ITBA Help desk:

	 Customer Service also has ITBA Help desk facility to address queries of the  
	 AO. These queries are basically on the Refund issues, Demand, TDS, Transfer of  
	 Rectification rights and Manual order status of income Tax return that are  
	 processed at CPC. Customer service also ensures that clear and timely service is  
	 provided with the help of tools & applications developed for the specific purpose.

2.7.	 Frequently Asked Questions/Answers on Customer Service Helpdesks 

2.7.1.	 What is the number to contact the CPC call centre and e-filing call Centre?

	 Ans:	CPC toll Free number is 18004252229/18001034455 and 080 22546500  
			   (Toll Number- India & Abroad).

	 e-Filing toll Free number is 1800 103 0025

2.7.2.	 What are the working hours during which CPC call center can be contacted?

	 Ans:	The working hours for CPC call centre is from 8:00 A.M to 8:00 P.M  
			   (Monday to Friday) while the IVRS is available 24/7.

	 The working hours for the e-Filing call centre is from 8:00 A.M to 8:00 P.M  
	 (Monday to Saturday).

2.7.3. What is the first option available on the IVRS?

	 Ans: The first option available is to select the language preference.

2.7.4. The service is available in how many languages.

	 Ans: Service is available in these three languages - English, Hindi and Kannada.
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2.7.5. What are the options the taxpayer has to select in order to speak in any of  
	 the available languages?

	 Ans: The tax payer can select any one of the below option to speak in the  
	 particular language

		  • English - option 1

		  • Hindi – option 2

		  • Kannada – option 3

2.7.6. Which is the option available after language selection in the IVR?

	 Ans: The next option is to know the preprocessing and post processing 
	 status of the ITR.

2.7.7. What are the various status update that we can get for an ITR?

	 Ans: The tax payer can know the status of the below selection

		  •	 ITR Processing status - option 1

		  •	 Refund status - option 2

		  •	 Refund re-issue status - option 3

		  •	 Rectification status - option 4

		  •	 Intimation status – option 5

		  •	 Talk to an executive - option 9

2.7.8. What is the basic information required to know the processing status 
	 in the IVRS?

	 Ans: The PAN followed by DOB/DOI (DD-MM-YYYY) & Registered Mobile  
	 number or Postal PIN code as registered in e-filing is the basic requirement.

2.7.9. What is basic information required to know the refund status in IVR?

	 Ans: The PAN followed by DOB/DOI (DD-MM-YYYY) & Registered Mobile  
	 number or Postal PIN code as registered in e-filing is the basic requirement.

2.7.10. What is the basic information required to know the rectification status 
	 in IVR?

	 Ans: The PAN followed by DOB/DOI (DD-MM-YYYY) & Registered Mobile  
	 number or Postal PIN code as registered in e-filing is the basic requirement.

2.7.11. What is the basic information required to speak to an executive in IVRS?

	 Ans: The PAN followed by DOB/DOI (DD-MM-YYYY) & Registered Mobile  
	 number or Postal PIN code as registered in e-filing is the basic requirement.

2.7.12. Is there any option to go back to the previous menu or to speak to an executive  
	 after listening to the processing/refund/rectification status?

	 Ans: Yes, taxpayer can select option 1 to go back to previous menu or 9 to  
	 speak to an executive.
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2.7.13.	 Is there any option to check Multiple PANs and multiple AYs query without  
	 disconnecting the call in IVRS?

	 Ans: Yes, If taxpayer wants to check different PAN’s query, select option 3;  
	 and to check different AY’s query, select option 2 towards the end of the call.

2.7.14.	 How is the ticket created for a call if the solution is given and query 
	 is resolved?

	 Ans: The executive would create a L1 ticket on every call received and select 	 
	 status as resolved, if resolution is provided and no escalation is required. The  
	 tickets are raised separately for each different PAN. In case of a subsequent  
	 call from the same PAN, earlier tickets can be tracked through the TMS (Ticket  
	 Management System).

2.7.15.	If the solution is not provided at first point of contact, then what is the  
	 procedure to create a ticket?

	 Ans: The executive would then create a ticket and assign to L2 group. L2  
	 executives would investigate the case and update the solution. The L1 executive  
	 would inform the taxpayer to wait for the e-mail as once the issue gets  
	 resolved, CPC will send an appropriate communication (G15) by e-mail to the  
	 taxpayer’s registered e-mail ID.

2.7.16.	Is there any other group to which ticket can be assigned apart from 
	 L1 and L2?

	 Ans: Yes. The L2 executive can assign the ticket to the L3 group. These tickets  
	 are looked into by Tax Experts and if they are not able to provide a solution  
� then it is referred to Income Tax Department Officials. The L1 executive would  
	 inform the taxpayer to call back after 5 working days.

2.7.17.	What are the reasons for the tax payer to be unable to connect to the 
	 call center?

	 Ans: There might be technical issue because of which the tax payer may not  
	 be able to connect. There is also a chance that all the 90 channels are occupied  
	 because of which the 91st caller might not be able to connect, in which case  
	 caller will get a busy tone, and therefore the caller has to try again.

2.7.18. What are the different categories on which an executive can give information?

	 Ans: The executive can provide information on the below categories:

CALL CATEGORY DESCRIPTION

	 •	 ITR-V/EVC - Any query pertaining to ITR-V receipt status/EVC status

	 •	 Refund/Refund Re-Issue- Any query/requests pertaining to 
		  refund/re-issue.

	 •	 Demand/Rectification- Any query pertaining to outstanding demand and  
		  rectification status

	 •	 RO-adjustment- Any query pertaining to RO-adjustment.

	 •	 WTR Return-Any query pertaining to Wealth Tax Return.  
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For procedure related queries on the e-filing website, the CPC Call Centre will ask 
the taxpayer to contact e filing helpdesk and will thereafter internally transfer the 
call to the e-filing team. Other issues dealt by the call center are as under:

	 •	 Refund: Any query pertaining to first time refund status. 

	 •	 ITR-P: Any query pertaining to Returns filed manually and processed 
		  at CPC. 

	 •	 Demand: Any query pertaining to the Demand raised by CPC. 

	 •	 Intimation: Any query pertaining to the communications (u/s.143 & 154)  
		  sent by CPC.

	 •	 Others: Any General queries.

	 •	 Online Rectification: Any query related to e-filed rectification.

	 •	 Manual Rectification: Any query related to Manual rectification filed at CPC.

	 •	 Transferred to ITBA: Any query pertaining to the Returns which were  
		  transferred to ITBA for processing and also the cases where rectification  
		  rights have been transferred to ITBA.

	 •	 Campaign: Any query pertaining to the campaigns sent from CPC.

	 •	 Intimation Re-Send: Any enquiry pertaining to the intimation / campaign  
		  resend requests placed from Customer Service or from website.

2.7.19. What is the escalation procedure followed?

	 Ans: If the taxpayer is unhappy with the solution given at the L1 executive  
	 level, or if the taxpayer wants to speak to the next level, then the call will be  
	 escalated to Escalation help desk team or floor supervisor. If the taxpayer  
	 wants to escalate it still further, then the call is handled by Team Leader and  
	 that is the final level of escalation.

2.7.20. I have submitted my ITR-V well within 120 days; however, I still receive SMS  
	 & emails from CPC asking me to submit my ITR-V. Should I ignore this email  
	 or is there anything I need to do?

	 Ans: Please do not ignore such remindeRs.It only means that your ITR-V is  
	 either rejected or not received by CPC yet.

	 You can check the status of the your ITR-V submitted by logging on to your  
	 e-filing account. 

	 Alternatively, you can also call CPC Customer Service Toll Free number  
	 18004252229/18001034455 to check the status on IVRS.

	 If you find that your ITR-V is not received by CPC yet, please try EVC or  
	 submit the physical copy of ITR-V once again.

2.7.21. After the processing of my return is completed in CPC, how will I be notified?

	 Ans: After the processing of ITR is completed in CPC, taxpayers are intimated  
	 with the communications / letters (orders) in the form of:
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	 a.	Email,

	 b.	SMS (notification only) &

	 c.	Print (for emails which fail / bounce and orders which result in demand)

2.7.22	 I have not provided a valid email address and / or mobile number while filing  
	 my return, how will I rectify this?

	 Ans: CPC sends orders and various other communications to the email ID  
	 & mobile number provided in the ITR. If this happens to be invalid / incorrect  
	 or the email ID or mobile number doesn’t exist, then the email and/or SMS  
	 would fail. However, if the email ID and/or mobile number provided by the  
	 taxpayer is valid, but doesn’t belong to the taxpayer, then all emails & SMS  
	 would still go out to the same email ID & mobile number given in the ITR. In  
	 order to update the mobile no. or email ID, taxpayer will have to login to  
	 their e-filing account and make the necessary corrections, and then place a  
	 resend intimation request to get the orders to the updated email ID.

	 Alternatively, taxpayers can call CPC Customer Service Toll Free no.  
	 18004252229/18001034455 and request for a resend request.

2.7.23. What are the ways by which an ITR-V can be sent?

	 Ans: An ITR-V can be sent by ordinary post or speed post or it can be dropped  
	 in the drop box available in CPC.

2.7.24. What does the taxpayer need to do when ITR-V has been rejected?

	 Ans: The taxpayer needs to generate another print of ̀ the ITR-V, sign the same  
	 in original and send it to CPC within 120 days from the date of E-Filing.  
	 Alternatively, the taxpayer can also do the e-verification which is much faster.

2.7.25.	What AO needs to do if Processing is completed at CPC but details are not  
	 visible at AST/ITBA system?

	 Ans: AO needs to raise a ticket in ITBA Helpdesk system. ITBA team will  
	 examine the issue and resolve it. If any action is pending with CPC, ITBA  
	 ticket is shared with CPC for resolution. CPC will share the resolution only  
	 with ITBA Helpdesk team and not to the AO. ITBA team will analyze the  
	 response of CPC and will communicate the same to AO. 
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CHAPTER 3

GRIEVANCE 
HANDLING 
PROCESS

Centralized Processing Center of Income Tax Department (CPC), has a Grievance 
handling team to address queries of the taxpayers and Chartered Accountants raised 
on e-Nivaran and other modes. The queries are basically on ITR-V status, Processing, 
Rectification, Refund, legal heir, outstanding demand and intimation status of Income 
Tax returns that are processed at CPC.

In Grievance service we have different categories of service to address taxpayers 
query which are as under:

	 a. e-Nivaran grievance
	 b. CPGRAMS
	 c. ITBA 
	 d. Online Reputation Management (ORM) 
	 e. e-Mails to CPC.                                                    

3.1.	 e-Nivaran Grievance 

	 e-Nivaran facility was introduced by the Income Tax Department for taxpayers  
	 to raise their enquiries and complaints with respect to their Income Tax Return  
	 via e-filing Portal. All grievances raised by the taxpayers are routed to the  
	 respective teams by e-filing and ITBA teams for further action. At CPC, all  
	 the grievances shared with CPC are taken note of and assigned to the  
	 executives based on the grievance category and sub-category for proper  
	 resolution. Once the executive resolves the grievance, an internal quality check  
	 is performed and the result then moves for verification by Team Lead/ 
	 Supervisor and approval. Team Lead/ Supervisor will review the response  
	 and take further action by either approving or rejecting the grievance.

	 •	 All approved cases will later move to ITD Officer queue for approval. Once  
		  ITD Officer approves the response, an email gets triggered to the taxpayer  
		  with the resolution and also the resolution is duly updated in the e-filing  
		  portal under the section ‘My account’.
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	 •	 All Team Lead/Supervisor and ITD Officer rejected cases are sent back to  
		  the executive to re-analyze the cases and resolution is soug

3.2.	 CPGRAMS 

	 Income Tax Department provides multiple channels through which taxpayers  
	 can get in touch with the department. Under the public grievance mechanism,  
	 any citizen of India can raise their problems, grievances or pleas to the Central  
	 Government and State Government-Ministries and Departments. At CPC, we  
	 have a dedicated team which closely monitors all the CPGRAMS grievances  
	 and ensures timely and accurate disposal of such grievances.

	 All resolutions provided by the CPGRAMS team are reviewed by designated  
	 ITD Officer before disposing the grievances in the Public Grievances portal.

3.3.	 ITBA

	 ITBA was introduced by the Income Tax Department for all basic applications  
	 and work of the Officers.It has functionality for the AO to raise their enquiries  
	 and complaints with respect to processes of CPC by lodging tickets. All the  
	 ITBA tickets raised by the AO are routed to the respective teams. At CPC,  
	 we have built a special portal through which all the ITBA tickets are taken  
	 note of, accounted and assigned to the executives for the resolution. Once  
	 the executive resolves the tickets, an internal quality check is performed and  
	 the result moves for Team Lead/Supervisor to approve. Team Lead/ Supervisor  
	 then reviews the response and takes further action by either approving or  
	 rejecting the ticket.

3.4.	 Online Reputation Management

	 Online Reputation Management (ORM) was specifically introduced by the  
	 Income Tax Department to redress the grievances raised by the taxpayers  
	 in social media. All the ORM cases are directly monitored by the CBDT  
	 Income Tax Department. The complaints raised by the taxpayers are routed  
	 to the respective team. At CPC, we have built an ORM team where they assign  
	 the cases to the executives for proper resolution. The cases identified for  
	 first follow-up calls are taken care by the customer service team. Once the  
	 executive resolves the cases, an internal quality check is performed and the  
	 result moves for Team Lead/Supervisor to approve. Team Lead/ Supervisor  
	 reviews the response and takes further action either by approving or rejecting  
	 the ticket.

3.5.	 CPC-ITR grievance mail ID 

	 An email ID is used by CPC ITR for the purpose of handling any specific  
	 queries from the taxpayers or their representatives.

3.6.	 Frequently Asked Questions/Answers on Grievance Handling
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Sl.No Questions Answers

1
How can an e-filed return be 
verified/validated?

“The e-return can be verified/ validated through
1. Digital signature or
2. Sending the signed ITR-V to CPC through Ordinary 
post or speed post or
3. EVC (Electronic verification code) .”

2
Need clarification on verifi-
cation/ validation of e-filed 
return through EVC?

Do refer to the FAQ available at the e-filing portal un-
der Help tab -> e-verification. In case of any further 
clarification, please contact e-filing administrator, 
Contact details : Phone number :180042500025

3
How can I get a copy of the 
ITR-V?

Go to “My Account”-> “My e-filed Return/Forms” – Se-
lect Acknowledgement No. for the assessment year 
for which ITR-V is required- Download and take a print

4 Where to send the ITR-V?
“Centralized Processing Center (CPC),
Income Tax Department
Bangalore, Karnataka -560500.”

5
What is the time frame for 
submitting the signed hard 
copy of ITR V to CPC?

Please send the signed hard copy of ITR-V to CPC 
within 120 days of filing of return.

6
On what grounds ITR-V will 
be rejected at CPC?

It may be rejected due to poor quality, signature miss-
ing or Xerox copy of the ITR-V. In such cases, the tax-
payer should resend the signed hard copy of the valid 
ITR-V to CPC within 120 days of filing of the return

7
On receiving ITR-V Rejection 
communication from CPC, 
what needs to be done?

You need to resend the signed hard copy of valid ITR-V 
to CPC within 120 days of filing of return after correct-
ing the error.

8
I have got “ITR-V not re-
ceived” communication from 
CPC, what should I do?

Please send the signed hard copy of ITR-V to CPC 
within 120 days of filing of the e-return

9
On submitting the ITR-V, 
when will we receive the ac-
knowledgement from CPC?

If you have sent the ITR-V through ordinary post to 
CPC then wait for 10 days for acknowledgement from 
CPC or If you have sent the ITR-V through Speed post 
to CPC then wait for 7 days for acknowledgement 
from CPC

10
Can I submit the ITR-V to 
CPC after 120 days?

Yes, you can submit the ITR-V. Please read below an-
swer for further clarity.

11

Kindly let me know the im-
plication of submitting the 
ITR-V after 120 days of filing 
e-return?

"If you do not submit the ITR-V to CPC within the due 
date, the e-filed return will be treated as not filed.
Without a valid ITR-V your return cannot be taken up 
for processing and refund, if any, cannot be issued.
Even if the due date for submission of ITR-V has lapsed, 
in certain circumstances the Department can condone 
the delay in submission. Therefore, ITR-V should be 
submitted in all cases.

12

I have filed my return with 
digital signature/ EVC but 
not received acknowledge-
ment from CPC?

No acknowledgement will be sent from CPC for digi-
tal signature/ EVC. However, the ITR-V status can be 
checked by logging on to www.incometaxindiaefiling.
gov.in with your user ID and password and go to ‘My 
Account’-> My e-filed Return/Forms

3.6.1	 Answers to the commonly raised e-Nivaran queries on Verification of ITR 
	 by EVC/ITR V.
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3.6.2.	Answers to the commonly raised e-Nivaran queries under Processing of ITR

Sl.No Questions Answers

A. Defective Return related Questions

1
What is a defective 
return at CPC?

If the return contains certain defects due to which 
CPC is unable to process the return, then the same is 
termed as “Defective”. 

2 I have received a notice from 
CPC declaring my return as 
defective u/s 139(9), how do 
I file a Corrected return or 
respond to the notice?

You may login to e-filing portal and to go to e-File 
tab->Response to notice u/s 139(9).

3
Time provided to file the 
corrected return is over, can I 
still file a corrected return?

The corrected return cannot be uploaded after the 
time limit provided in the notice u/s.139(9). The only 
recourse for the taxpayer is to file another ITR (if time 
is available for the same).

4

Do I need to furnish  only 
corrected information or 
should  I file entire return 
with corrected details?

No, you cannot provide only the corrected 
information. You need to file corrected ITR with 
corrected details only. The taxpayer can login to 
e-filing website www.incometaxindiaefiling.gov.in 
with your user ID and password -> Go to =’e-file tab’ 
-> ‘Response to notice u/s 139(9)’ and upload the 
corrected ITR.

5

What is the process to send/ 
resend defective return 
notice to my new email ID?

Please change the email ID details by logging on to 
www.incometaxindiaefiling.gov.in with your user ID 
and password and go to “Profile e settings -> My 
Profile -> select contact details tab. After changing 
the email ID, CPC will resend the notice to taxpayers 
updated email ID.

6 How to change the details in 
PAN database?

Please contact any PAN facilitation center or contact 
NSDL customer care for any correction in PAN database

B, Transfer to A.O  - Related Queries

1 My Return shows transfer 
to Jurisdictional Assessing 
Officer for processing. How 
to know my Jurisdictional 
A.O details?

Log on to www.Incometaxindiaefiling.gov.in -> Quick 
links -> Know your AO.

2 I have received 
communication informing 
“Your return transferred to 
A.O” from CPC, what should 
I do?

The essence of this communication is that your return 
would be processed by your Jurisdictional AO and 
reason of transfer to AO is also mentioned in the 
communication. Please communicate via email with 
the AO for further assistance.

3 My query pertains to AY 
prior to 2008, what should 
I do?

Kindly communicate via email with your Assessing Officer 
for any query prior to AY 2008. To know your jurisdictional 
Assessing officer, please log on to  www.
ncometaxindiaefiling.gov.in -> Quick links -> Know your AO.

C. Tax mismatch Related Questions

1 How to view Form 26 AS?
Please visit www.incometaxindiaefiling.gov.in with 
your user ID and password and Go to ‘My Account’ -> 
View Form 26AS (Tax credit)

2
How to get a copy of Form 
26AS to check the tax credits?

Go to “My Account” -> “view my form - form 26AS” - 
Download

3
If the Tax credits are not 
appearing in Form 26 AS, 
what should I do?

Please contact deductor for TDS/ TCS credit and 
Bank for tax payments
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Sl.No Questions Answers

4

I have entered different tax 
credit amount in ITR return 
as compared to Form 26AS, 
how can I rectify the same?

Please file a revised return it’s not time barred, or 
else file an online rectification after receiving the 
intimation order and correcting the tax credit data.

5

I have entered wrong 
BSR code in ITR return as 
compared to Form. How can 
I rectify the same?

Please file a revised return if it’s not time barred, or 
else file an online rectification after receiving the 
intimation order and making necessary corrections.

6

I have entered wrong challan 
number in ITR return as 
compared to Form. How can 
I rectify the same?

Please file a revised return if it’s not time barred, or 
else file an online rectification after receiving the 
intimation order and making necessary corrections.

7

I have entered wrong 
challan date in ITR return as 
compared to Form. How can 
I rectify the same?

Please file a revised return if it’s not time barred, or 
else file an online rectification after receiving the 
intimation order and making necessary corrections.

8
I have not entered the details in 
the Schedule IT in the ITR return, 
how can I rectify the same?

Please file a revised return if it’s not time barred, or 
else file an online rectification after receiving the 
intimation order and making necessary corrections.

9

I have entered different AT/SAT 
amount claimed in Schedule 
IT and in Schedule Part B TTI. 
Hence, credit not given. How 
can I rectify the same?

Please file a revised return if it’s not time barred, or 
else file an online rectification after receiving the 
intimation order and making necessary corrections.

10
I have entered wrong TAN 
in schedule TDS, how can I 
rectify the same?

Please file a revised return if it’s not time barred, or 
else file an online rectification after receiving the 
intimation order and making necessary corrections.

D. Section 245 Notice  - Related Queries

1 
What is 245 Notice, what 
does it mean and what 
should I do?

This notice indicates that the return after processing has 
resulted in a refund and that CPC proposes to adjust 
this refund against outstanding demand(s) as indicated 
in the notice. Taxpayer is requested to respond to the 
notice by agreeing / disagreeing to the demand.

2

I do not agree to the 
proposed adjustment of 
refund against demand as 
per notice u/s 245 from CPC, 
what should I do?

Please communicate via email with your Jurisdictional 
AO for rectifying the demand(s).  Also, the reason 
for disagreement can be submitted through the 
e-filing website under “e-file tab” -> “Response to 
outstanding demand”

3

I agree to the proposed 
adjustment of refund against 
demand as per notice u/s 245 
from CPC, where should I submit 
my consent for adjustment?

The response can be submitted in the e-filing 
website under “e-file tab” -> “Response to 
outstanding demand”

E. Return Status/ Grievance Status

1
How to check my 
e-return status?

Please Go to “My Account”->“View e-filed returns/ 
forms” and select the relevant “Acknowledgement 
number” for which you need to know the status.

2
What is the status of my re-
vised return?

Please Go to “My Account” ->“ View e-filed returns/ 
forms” and select the relevant “Acknowledgement 
number” for which you need to know the status.

3
How to check the status of 
my grievance raised?

Please Go to “e-Nivaran” ->“Grievance Status” and 
select the appropriate request ID for which you need 
to know the status.
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3.6.3.	Answers to the commonly raised e-Nivaran queries on Refund issuance 

3.6.4.	Answers to the commonly raised e-Nivaran queries on Rectification 
	 u/s. 154 of the Act.

Sl.No Questions Solutions

1
How do I know about my 
refund status?

Please Go ‘My Account’ → ‘View e-Filed 
Returns/Forms ‘ → ‘e-Filed Returns/Forms’ and 
check the status by clicking the link provided 
for Acknowledgement number.

2

As per the intimation 
order, the processing has 
resulted in a refund but 
the Net refund payable 
is Nil/ Reduced, why?

This is due to refund getting adjusted against 
the outstanding demand, the details of which 
are available in the order. If you need a copy 
of the Order u/s 143/ 154, please request 
via resend request through e-filing portal 
prior to AY 2016 (‘My Account -> ‘Request 
for intimation u/s 143 (1)/ 154) else contact- 
CPC - Customer service (18004252229). You 
can download a copy of the intimation order 
of AY 2017 onwards by logging on to www.
incometaxindiaefiling.gov.in. Then Go to My 
Account > View e-filed returns/forms> click on 
acknowledgment number link to download the 
intimation order.

3

As per the intimation 
order, the processing 
has resulted in refund 
which has already been 
adjusted or paid towards 
the outstanding demand, 
which is not the correct 
demand as per my 
records. How to get the 
adjusted refund?

If the demand pertains to demand raised by 
the AO, please communicate accordingly via 
email with the Jurisdictional Assessing Officer. 
After due verification by the AO, AO will issue 
the adjusted refund amount for the Assessment 
year for which the demand is rectified.  

4

In the intimation order 
there is a refund issued 
by CPC but I have not 
received the refund?

Refund will be sent by Refund Banker, SBI, 
Mumbai, the status of which can be checked at 
www.tin-nsdl.in. For further details, please call 
the SBI call center No.18004259760.

5

I have received a refund 
failure communication 
from CPC, what needs to 
be done?

Please send a refund reissue request curing the 
failure reason under “My Account”-> “Service 
Request’’ -> “Refund reissue request”.

Sl.No Questions Solutions

1
I want to file a rectification, 
how to apply for rectification?

Go to “ e-File” -> “Rectification “

2
Please let me know the 
detailed procedure to file 
a rectification?

Go to “Help tab” -> “Question related to revised return 
and rectification”

3
How do I know my 
rectification status?

Go to “My Account” -> “View e-Filed Return/Forms”
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3.6.5.	Answers to the commonly raised e-Nivaran queries on Communications  
	 issued to taxpayers

3.6.6.	Answers to the commonly raised e-Nivaran queries on Demand and 
	 its resolution

Sl.No Questions Solutions

1
How do I know about my 
refund status?

Please Go ‘My Account’ → ‘View e-Filed Returns/
Forms ‘ → ‘e-Filed Returns/Forms’ and check 
the status by clicking the link provided for 
Acknowledgement number.

2

As per the intimation 
order, the processing has 
resulted in a refund but the 
Net refund payable is Nil/ 
Reduced, why?

This is due to refund getting adjusted against the 
outstanding demand, the details of which are available 
in the order. If you need a copy of the Order u/s 143/ 
154, please request via resend request through e-filing 
portal prior to AY 2016 (‘My Account -> ‘Request 
for intimation u/s 143 (1)/ 154) else contact- CPC - 
Customer service (18004252229). You can download 
a copy of the intimation order of AY 2017 onwards by 
logging on to www.incometaxindiaefiling.gov.in. Then 
Go to My Account > View e-filed returns/forms> click 
on acknowledgment number link to download the 
intimation order.

3

As per the intimation order, 
the processing has resulted 
in refund which has already 
been adjusted or paid 
towards the outstanding 
demand, which is not the 
correct demand as per my 
records. How to get the 
adjusted refund?

If the demand pertains to demand raised by the AO, 
please communicate accordingly via email with the 
Jurisdictional Assessing Officer. After due verification 
by the AO, AO will issue the adjusted refund amount 
for the Assessment year for which the demand is 
rectified.  

4
In the intimation order there 
is a refund issued by CPC but 
I have not received the refund?

Refund will be sent by Refund Banker, SBI, Mumbai, 
the status of which can be checked at www.tin-nsdl.
in. For further details, please call the SBI call center 
No.18004259760.

5
I have received a refund 
failure communication from 
CPC, what needs to be done?

Please send a refund reissue request curing the failure 
reason under “My Account”-> “Service Request’’ -> 
“Refund reissue request”.

Sl.No Questions Solutions

1
How to confirm the demand 
through     e-filing Portal?

The response can be submitted in the e-filing 
website under” e-file tab” -> “Response to 
outstanding tax demand”. There are three options
1)Demand is correct
2)Demand is partially correct
3)Disagree with demand.
Select ‘ Demand is correct’ and click on submit button.

2
How to disagree with 
the demand through 
e-filing Portal?

The response can be submitted in the e-filing 
website under” e-file tab” -> “Response to 
outstanding tax demand”. There are three options
1)Demand is correct
2)Demand is partially correct
3)Disagree with demand.
Select  ‘Disagree with demand’ and provide the 
required details.
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Sl.No Questions Solutions

3
How to partially confirm 
the demand?

The response can be submitted in the e-filing website 
under” e-file tab” -> “Response to outstanding tax 
demand”. There are three options
1)Demand is correct
2)Demand is partially correct
3)Disagree with demand.
Select ‘Demand is partially correct ‘and provide the 
required details. 

4

I have wrongly confirmed 
the demand in e-filing portal 
instead of disagreeing. How 
do I correct it ?

If the demand confirmed pertains to the demand 
raised by Assessing officer: Please communicate 
via email with your Jurisdictional Assessing officer 
to make necessary change to the demand position. 
To know the details of your Jurisdictional Assessing 
Officer, please visit  www.incometaxefiling.gov.in-> 
Quick links  -> Know your AO.
If the demand confirmed pertains to the demand 
raised by CPC : 
Please file an online rectification request with CPC. 
For filing the rectification request, please visit www.
incometaxindiaefiling.gov.in ->Go to “e-file” -> “Rectification”.

5
How to rectify the demand 
raised by CPC?

To rectify the demand raised by CPC, please file an online 
rectification request with CPC. For filing the rectification 
request, please visit www.incometaxindiaefiling.gov.in -> Go 
to “e-file” -> “Rectification”.

6

I have paid the demand 
through minor head 400 
(Tax on regular assessment), 
but still the demand is open, 
please clarify?

Kindly check whether the demand payment details are 
appearing in Form 26AS. If the payment details are not 
available in form 26AS, please contact the bank where 
you have made the payment.
If the demand payments are appearing in Form 26AS  
but still demand is shown open with CPC, please file a 
grievance with CPC through e-filing website, path to 
file the grievance is as follows:
Go to e-Nivaran tab -> Submit Grievance -> CPC -> 
select the appropriate AY and category as Demand.
You can check form 26AS, by visiting www.
incometaxindiaefiling.gov.in and  click on  “View Form 
26AS (tax credit)”.

7

At CPC, my refund has 
been adjusted against the 
outstanding demand. Please 
clarify?

Refund determined at CPC will be adjusted against 
the outstanding demand(s) payable, if any.  Before 
adjustment, Notice u/s 245 will be issued to the 
assessee informing about the open demand(s) and to 
take appropriate action in case of objection. 30 days 
time will be given to the assessee for responding to 
this notice. If no action is taken by the assessee, refund 
will be adjusted against the outstanding demand(s).   
If you disagree with the adjustment of refund against 
the demand(s) raised by Assessing officer, you need 
to communicate via email with your Assessing officer 
for clarifications/ changes. To know the details of your 
Jurisdictional Assessing Officer, please visit  www.
incometaxefiling.gov.in- > Quick links -> Know your AO.
If you disagree with the adjustment of refund against 
the demand(s)  raised by CPC, you can apply for online 
rectification with  CPC. For filing the rectification request, 
please log on to www.incometaxindiaefiling.gov.in ->Go to “ 
e-File” -> “Rectification’’.
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Sl.No Questions Solutions

8

Refund got adjusted against 
the outstanding demand but 
interest on demand is shown 
as pending, please clarify?

Interest u/s 220(2) is liable to be computed till the 
date of payment/refund adjustment. Therefore, 
interest u/s 220(2) can be ascertained only after 
payments/ refund adjustment.  Interest pending needs 
to be paid by the assessee.

If you disagree with the interest demand uploaded by 
Assessing officer, you need to communicate via email 
with your Assessing officer for clarifications/ changes. 
To know the details of your Jurisdictional Assessing 
Officer, please visit  www.incometaxefiling.gov.in- > 
Go to -> Quick links -> Know your AO.

If you disagree with the interest demand uploaded by 
CPC, you can apply for online rectification with CPC. 
For filing the rectification request, please log on to 
www.incometaxindiaefiling.gov.in ->Go to 
“ e-File” -> “Rectification’’.

9

Demand has been adjusted 
against the refund. But I have 
already paid the demand. 
How to get the refund?

Kindly check whether the demand payment details 
are appearing in Form 26AS. If the payment details 
are not available in form 26AS, contact the bank 
where you have made the payment.

You can check form 26AS, by visiting 
ww.incometaxindiaefiling.gov.in and click on 
“View Form 26AS (tax credit)”

If you disagree with the adjustment of refund against 
the Demand raised by the Assessing officer, you 
need to communicate via email with your Assessing 
officer for clarifications/ changes. To know the details 
of your Jurisdictional Assessing Officer, please visit 
www.incometaxefiling.gov.in- > Go to -> Quick links -> 
Know your AO.

If you disagree with the adjustment of refund against 
the Demand raised by CPC, you can apply for online 
rectification with CPC. For filing the rectification 
request, please log on to www.incometaxindiaefiling.
gov.in ->Go to “e-File” -> “Rectification’’

10 How to rectify challan detail?

You need to communicate via email with the 
Assessing officer for any challan details correction. 
To know the details of your Jurisdictional Assessing 
Officer, visit www.incometaxefiling.gov.in- > Go to -> 
Quick links -> Know your AO.

Assessing officer can change the PAN details/ AY/ 
Minor code and Major code only.

11

My query is related to 
outstanding demand 
pertaining to  AY prior to AY 
2008?

Kindly communicate via email with your Assessing 
officer for any query prior to AY 2008. To know your 
jurisdictional Assessing officer, please log on to www.
incometaxindiaefiling.gov.in and go to -> Quick links 
-> Know your AO.



CPC HANDBOOK NOV 202026

3.6.7.	 General queries:

	 In addition to the above commonly raised e-Nivaran queries, some of the  
	 taxpayers pose the following questions:

Sl.No Questions Solutions

1

How to know the Status of 
condonation request made 
in e-filing with respect to 
delayed verification of ITR by 
EVC or delayed submission of 
physical ITR-V to CPC?

The condonation of delay in submission of ITR-V or 
EVC is taken up at CPC in batches at defined interval. 
Post condonation by appropriate authority, the 
ITR is taken for processing and the taxpayer would 
be informed about the condonation only after the 
processing of the ITR is completed for which the 
condonation of EVC or ITR-V is done.

2

In spite of responding to 
the defective return in 
e-proceedings, the status of 
processing does not change 
for a long time 
till invalidation?

The response to defective return is examined by 
appropriate authorities and if the response is to be 
rejected, the same is intimated to the taxpayer by a 
communication without delay. Considering that the 
time for filing of revised return would be over by the 
time defects are identified, the ITR is kept open for 
the taxpayer to file a corrected ITR till the time for 
processing u/s.143(1) is available in order to provide an 
efficacious remedy to taxpayer.

3 How to file revised return? Please refer to Para 3.6.2.(e).2 above.

4
How to change the income/
gross receipts details in ITR 
after filing one ITR?

The changes to income/gross receipts are to be 
carried out by filing of revised ITR.

5
What is remedy if return is 
filed in wrong form type or 
for a wrong AY?

Taxpayer can refer to Rule 12 of the Income Tax 
Rules 1962 to know the appropriate Form Type to be 
chosen for filing of ITR. If the ITR Form Type selected 
is incorrect, then the taxpayer can file revised return 
using the appropriate form type.
If the ITR is filed for a wrong Assessment Year, then 
the taxpayer needs to communicate via email with the 
AO/PRO and take recourse using other provisions of 
the Act like section 264 of the Act.

How to update the contact 
details for the PAN in 
e-filing profile?

The taxpayer can update the contact details in the 
e-filing website after logging into the profile (My 
Account). There are help documents available in the 
website for reference and same is available in Para 4.4. 
in Chapter 4.

6
How to update the contact 
details for the PAN in 
e-filing profile?

The taxpayer can update the contact details in the 
e-filing website after logging into the profile (My 
Account). There are help documents available in the 
website for reference and same is available in Para 4.4. 
in Chapter 4.

7
How to upload XML file 
on e-filing?

Taxpayer can take the help of documents provided in 
this regard on the e-filing website itself.

8
Questions related to ESOP 
shares and how to offer 
for taxation?

The taxpayers are requested to refer to the Income Tax 
Act and Rules related to the taxation of Employee’s 
Stock Options Scheme available in the Income Tax 
India website.

9
What is recourse if some 
Unknown person (other than 
taxpayer) has filed a return?

The taxpayer can lodge a complaint with e-filing 
Web Manager on the e-filing website (email id: 
efilingwebmanager@incometax.gov.in). Taxpayer 
can also revise the ITR. The password and other 
information for e-filing needs to be very secure to 
avoid such instances.
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Sl.No Questions Solutions

10
I am receiving communication 
which does not belongs to 
me from CPC?

The communications from CPC are sent to the email ID 
provided in the ITR or the profile of the taxpayer. There 
are instances where a taxpayer has provided incorrect 
email ID leading to this problem. The taxpayer can 
change the email ID, if the same is used for multiple 
taxpayers as a consultant or otherwise.

11
I am receiving reminders to 
file the return even if I have 
already filed the return?

The reminder needs to be verified to ascertain the 
purpose for which the same is sent, in many cases, 
the reminder is sent for confirmation of transaction 
on the e-filing website and same needs to be adhered 
to, even if the ITR is already filed. These reminders 
are for due compliance related verification by the 
Department. Also, if more than one ITR is filed and all 
of them are not verified, reminders is sent out for such 
un-verified ITR.

12
Allocation of same PAN 
for two persons, what 
is the recourse?

In cases where same PAN is allocated to different 
persons, the matter needs to be taken up with NSDL, 
by contacting +91-20-27218080 or by sending an email 
can be sent to tininfo@nsdl.co.in.



CPC HANDBOOK NOV 202028

CHAPTER 4

E-VERIFICATION OF 
RETURNS AND ITR-V 
HANDLING PROCESS

This process involves verifying an action electronically using Electronic Verification 
Code (EVC) or Aadhaar OTP or Digital Signature Certificate. Verification is mandatory 
to accept the items for further processing. 81% of taxpayer use EVC (in FY2020-21)  
and EVC will replace submission of paper ITR-V, going forward. ITRs are also signed 
by using DSC in all ITRs where Audit u/s. 44AB is mandatory and also taxpayers who 
have DSC can use the same to e-verify the ITR. In case, the taxpayer for any reason 
is not able to e-verify the ITR, there is option to file a physical ITR acknowledgment 
known as ITR-V, which needs to be printed on A4 size paper, duly signed by 
appropriate person and sent to CPC by post.

4.1.	 Electronic Verification Code:

The e-Verification can be used for the following items in e-Filing portal. 

	 •	 Income Tax Returns and Other Forms 

	 •	 e-Proceeding

	 •	 Refund Re-Issue

4.1.2.	 The listed items can be verified using Electronic Verification Code or Aadhaar  
	 OTP or DSC. Electronic verification code can be generated using the  
	 following options. 

	 •	 Login to e-filing through Net Banking 

	 •	 Pre-validated Bank Account 

	 •	 Pre-validated Demat Account Details 

	 •	 EVC through Bank ATM

	 •	 Aadhaar OTP
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4.2.1.	 Login to e-filing through Net Banking

	 Option of Login to e-filing portal is also available through net banking platform  
	 of various banks in India. Taxpayer having accounts with those banks (with  
	 their PAN attached with the bank account and the PAN is registered in e-filing  
	 portal) can login to e-filing portal through their Net banking (Please verify  
	 the link to e-filing option in net banking platform with the respective banks).  
	 After login to e-filing portal through net banking, Taxpayer can submit any  
	 of the listed items and it will be automatically e-verified, (EVC will be generated  
	 and attached to the item automatically). Currently this option is available  
	 (Sep2020) for specific banks:

4.2.2.	 Pre-validate Bank Account 

4.2.2.1.	Taxpayer can generate an EVC using Pre-validated bank account details and  
	 the EVC can be used for e-Verification. Taxpayer must have linked their bank  
	 account with e-filing account. Option to link the same is available under  
	 Profile Settings ⇒ Pre-validate Bank Account after login to e-filing portal.  
	 Currently this option is available for specific banks (Sep 2020) mentioned below.

Allahabad Bank IndusInd Bank Ltd
Andhra Bank Jammu & Kashmir Bank
Axis Bank Ltd Karnataka Bank

Bank of Baroda Kotak Mahindra Bank
Bank of India Oriental Bank of Commerce

Bank of Maharashtra Punjab National Bank
Canara Bank Punjab and Sind Bank

Central Bank of India South Indian Bank
City Union Bank Ltd State Bank of India
Corporation Bank Syndicate Bank
DCB Bank Limited The Federal Bank Limited

Dena Bank The Karur Vysya Bank Ltd
Equitas Small Finance Bank Ltd UCO Bank

HDFC Bank Union Bank of India
ICICI Bank United Bank of India
IDBI Bank Vijaya Bank

Indian Bank Yes Bank Ltd
Indian Overseas Bank

Allahabad Bank Jana Small Finance Bank Limited State Bank of India

Andhra Bank HDFC Bank Syndicate Bank

Arihant Bank ICICI Bank
The Cosmos Co Operative 

Bank Limited

Bank of Baroda IDBI Bank
The Kurmanchal Nagar Sahkari 

Bank Limited

Canara Bank Indian Bank UCO Bank

Central Bank of India Indian Overseas Bank Union Bank of India

City Union Bank Karur Vysya Bank United Bank of India

Federal Bank Kotak Mahindra Bank Union Bank of India

HDFC Bank Oriental Bank of Commerce United Bank of India

ICICI Bank Punjab National Bank Vijaya Bank

IDBI Bank Saraswat Bank Yes Bank Ltd

IDFC First Bank Limited South Indian Bank
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	 •	 Only validated bank account in e-filing should be used by the respective  
		  Taxpayer in the Income Tax Return (under bank account details for refund  
		  claim) and Refund Re-Issue service request in e-filing portal.

	 •	 Bank account details provided by Taxpayer already in the Income Tax  
		  Return filed in the recent assessment years and validated by centralized  
		  processing center will also be associated with the respective PAN holder  
		  account in e-filing 

	 •	 In case Taxpayer logs in to e-filing through net banking login, then bank  
		  account details provided by bank will be added under Pre-validated bank  
		  account details in e-filing account upon confirmation by the user if the  
		  account details are not present in Pre-validated bank account list)

	 •	 Taxpayer can add/remove bank accounts and can have multiple validated  
		  bank accounts. In case the validation fails with the bank while adding,  
		  then such account will be removed from e-filing after 7 days. The list of  
		  Removed or Validation failed bank accounts can be viewed by clicking the  
		  link ‘View Failed/removed bank accounts’.

	 •	 EVC can be enabled for the validated bank account by Validating the mobile  
		  number (Mandatory) and email ID (optional) with the bank. Taxpayer can  
		  use the ‘Enable EVC’ button for the same by selecting any one of the  
		  validated bank account from the list. EVC can be enabled for only one  
		  bank account at any point of time. In case user is trying to enable EVC  
		  for another validated account, then EVC option will be removed from the  
		  existing account. 

		  Note:‘Enable EVC’ button is Applicable only to the Individual taxpayers.Other  
		  categories of taxpayers cannot use their Pre-validate bank account for  
		  generating EVC to e-Verify their Income Tax Returns and Forms.

	 •	 EVC Generation will be enabled only for the bank accounts with status  
		  “Validated and EVC Enabled”.

4.2.2.2.	 Below are the Steps to Pre-validate a bank account: 

Step 1 Logon to the ‘e-filing’ Portal www.incometaxindiaefiling.gov.in

Step 2 Select Profile Settings ⇒ Pre-validate your Bank Account

Step 3
Pre-validate form will be displayed in case no account exists. (Click on Add in case of 
new account or Select one of the existing Validated bank account in case validated 
accounts are available)

Step 4
Provide ‘Bank Account Number’, ‘Account Type’, ‘IFSC’, ‘Mobile Number’, ‘e-mail id’ 
and Click on ‘Pre-validate’. (email ID is optional if provided it will be validated with 
the bank)

Step 5 Status of the request will be sent to the e-mail id registered with the e-filing account.

4.2.3.	 Pre-validate Demat Account Details

	 Taxpayer can generate an EVC using Pre-validated DEMAT account details  
	 and the EVC can be used for e-Verifcation. Taxpayer must have linked their  
	 DEMAT account with e-filing account. Option to link the same is available  
	 under Profile Settings ⇒ Pre-validate DEMAT Account after login to e-filing  
	 portal. National Securities Depository Limited (NSDL) and Central Depository  
	 Services (India) Ltd (CDSL) provided the option to Pre-validate the Demat account.
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4.2.4. 	 EVC through Bank ATM

4.2.4.1.	Taxpayer can generate an EVC through ATM and the EVC can be used to  
	 verify the listed items. “PIN FOR INCOME TAX FILING” option can be used  
	 in the ATM to generate the EVC. Taxpayer must have linked their PAN with  
	 the respective bank account and the PAN should be registered with e-filing  
	 for the same. Upon using the option, Taxpayer will get the EVC on the  
	 registered mobile number (Primary mobile number registered with specific  
	 Bank mentioned below). 

Axis Bank Ltd IDBI Bank

Canara Bank Kotak Mahindra Bank

Central Bank of India State Bank of India

ICICI Bank

4.2.4.2.	EVCgenerated using this option is valid for 72 Hours Taxpayer can also  
	 generate EVC using Netbanking Login or Pre-validate Bank Account or Pre- 
	 validate DEMAT account under My Account ⇒ Generate EVC option after  
	 login to e-filing portal and it is valid for 72 Hours from the time of generation  
	 of the code.

4.2.5.	 Aadhaar OTP 

	 To generate an EVC through Aadhaar is done in two stages. 

4.2.5.1.	Firstly, the taxpayer has to link PAN with Aadhaar through the e-filing portal.  
	 The taxpayer’s PAN credentials such as Name, Date of Birth and Gender will  
	 be matched with the Aadhaar credentials. On matching, the PAN will be  
	 linked to Aadhaar. 

4.2.5.2.	Secondly, taxpayer has to opt for Aadhaar EVC. A One Time Password (OTP)  
	 will be generated by the Aadhaar authorities and sent to the Aadhaar  
	 registered mobile of the taxpayer. Using this OTP, the taxpayer would be able  
	 to verify the uploaded return. 

4.2.5.3.	Perform the following steps to generate EVC through Aadhaar OTP: 

Step 1 Logon to ‘e-filing’ Portal www.incometaxindiaefiling.gov.in

Step 2
Go to the ‘My Account’ menu located at upper-left side of the page ⇒ Click 
‘e-Verify Return’

Step 3
Click ‘e-Verify’ link ⇒ Select option ‘I would like to generate Aadhaar OTP to e-Verify 
my return’

Step 4 Enter the 6 digits OTP received on the mobile Number

4.2.6.	 ITRs signed used Digital Signature Certificate (DSC)

4.2.6.1.	Digital Signature Certificate (DSC) is the electronic format of physical or  
	 paper certificate like a driving License, passport and so on. Certificates serve  
	 as proof of identity of an individual or organisation for a certain purpose on  
	 online / computer. DSC can be presented electronically to prove taxpayer’s  
	 identity, to access information or services on the internet or to sign certain  
	 documents manually.
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4.2.6.2.Perform the following steps to register the DSC to generate a signature  
	 file in e-filing: 

Step 1 Logon to ‘e-filing’ Portal www.incometaxindiaefiling.gov.in

Step 2
Go to the ‘Profile Setting’ menu located at the upper-right side of the page ⇒ Click 
‘Register Digital Signature Certificate’ ⇒ Click ‘Click here to download the DSC Utility

Step 3
Extract the downloaded DSC Utility ⇒ Open the Executable Jar File (DSC Utility) ⇒ 
Read the instructions carefully.

Step 4
In the DSC Management Utility, go to ‘Register/Reset Password using DSC’ tab ⇒ 
Enter ‘Enter e-Filing User ID*’, ‘Enter PAN of the DSC*’ ⇒ Select the type of ‘Digital 
Signature Certificate’ (DSC)

Step 5

     DSC using .pfx file: 
•	 Select the Type of DSC .pfx file
•	 Browse and attach the Keystore file (.pfx File)
•	 Enter the password for your private key
•	 Click ‘Generate Signature file’
     DSC using USB token: 
•	 Select the Type of DSC (.pfx file or USB token) USB Token
•	 Select USB Token Certificate ⇒ Click ‘Generate Signature File’.

4.3.1.	 ITR-V Handling Process at CPC

	 4.3.1.1.	 In case, taxpayer is not opting for EVC mode of verification of the ITR,  
				    the ITR-V issued to the taxpayer by e-filing system after successful  
				    upload of an ITR is required to be sent to CPC, Bangalore-560500  
				    for validation. In FY2020-21, 81% of taxpayers opted for EVC of the  
				    ITR, thereby reducing carbon footprint and helping the environment  
				    and speedy processing of the same.

	 4.3.1.2.	CPC has a dedicated Post Office with Postal Index Number (PIN)  
				    560500 in Electronic City, Bangalore. The ITR-Vs sent by taxpayers  
				    to CPC are received by the Post office at this location. The post bags  
				    containing the ITR-Vs are delivered by Post Office in two modes, one  
				    mode for ordinary post and another mode for Speed Post. The I 
				    TR-V submitted with a speed post tracking number on the envelope  
				    is taken for acknowledgement process of receipt of speed post. For  
				    receipt through speed post, tracking number of the same is captured  
				    and reconciled with Post Office at CPC. 

	 4.3.1.3.	The envelopes are opened and ITR-V is taken for manual verification.  
				    In the manual verification process, the ITR-V is checked for presence  
				    of signature as a manuscript, readability of document, clarity of  
				    barcode and print quality of the ITR-V. The ITR-V which pass the  
				    manual verification is taken for scanning. 

	 4.3.1.4.	The scanned copy of the ITR-V is checked for quality of image and if  
				    found acceptable, the date of receipt of ITR-V is printed on the ITR-V  
				    along with serial number and image is uploaded to Primary Data  
				    Center of ITD. A communication is sent to taxpayer indicating the  
				    acceptance of ITR-V (if ITR V received within 12 days). If the ITR-V is  
				    received after 120 days, the taxpayer has to file for condonation of  
				    delay in submitting ITR-V to CPC on the e-filing portal.

	 4.3.1.5.	To facilitate taxpayers using courier services, a Drop Box is provided  
				    at the premises of CPC, where the Couriers can drop ITR-V containing  
				    envelopes and taxpayers also can walk in to drop the ITR V. The drop  



CPC HANDBOOK NOV 2020 33

				    box articles are handed over by designated ITD official to receipt team  
				    supervisor and receipts are noted at high level in a register maintained  
				    by security personnel at reception. These ITR-V also follow the same  
				    process as mentioned above.

	 4.3.1.6.	CPC sends reminders to taxpayers who have not validated the ITR,  
				    either by EVC or by submission of ITR-V at frequency of 15 days, 45  
				    days, 75 day and 105 days by SMS. An email reminder is sent to  
				    taxpayer at frequency of 30 days, 60 days, 90 days and 110 days from  
				    the date of upload of ITR.

4.4.	 Condonation of delay in filing ITR-V/EVC

	 4.4.1.	 You can provide the reason for delay in submission of ITR-V or  
				    e-Verification. In addition, you will be given an option to e-verify the  
				    return after 120 days by giving reasons for delay.

Step 1 Logon to ‘e-filing’ Portal www.incometaxindiaefiling.gov.in

Step 2
Go to the ‘My Account’ menu located at upper-left side of the page ⇒ Click ‘Service 
Request’ ⇒ Select the ‘Request Type’ as ‘New Request’ and Select the ‘Request 
Category’ as ‘Condonation Request’ ⇒ Click ‘Submit’ 

Step 3 Choose the suitable option located under ‘Response’ column ⇒ Click Submit 

Step 4 To View the status of submitted form

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in

Step 2
Go to the ‘My Account’ menu located at upper-left side of the page ⇒ Click ‘Service 
Request’ ⇒ Select the ‘Request Type’ as ‘View Request’ and Select the ‘Request 
Category’ as ‘Condonation Request’

Step 3 Click ‘Submit 

 
4.5. FAQs of EVC and Receipt & Validation of ITRV Process

	 4.5.1.		 What is electronic verification process for ITR uploaded on e-filing?

	 Ans.		 Taxpayer can validate the ITR by using electronic verification code.  
				    The process of verifying an item uploaded on the e-filing website  
				    electronically using Electronic Verification Code (EVC) or Aadhaar  
				    OTP or Digital Signature Certificate. Verification is mandatory to  
				    accept the items for further processing. The e-Verification is required  
				    can be used for the following items in e-filing portal:

	 •	 Income Tax Returns and Other Forms 
	 •	 e-Proceeding
	 •	 Refund Re-Issue

	 Electronic verification code can be generated using the following options:
	 •	 Login to e-filing through Net Banking 
	 •	 Pre-validated Bank Account 
	 •	 Pre-validated Demat Account Details 
	 •	 EVC through Bank ATM

	 Alternatively, Digital Signature Certificate can also be used to verify the ITR.

	 To generate an EVC through Aadhaar is done in two stages. 
	 •	 Firstly, the taxpayer has to link PAN with Aadhaar through the 
		  e-filing portal. 
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		  The taxpayer’s PAN credentials such as Name, Date of Birth and Gender will  
		  be matched with the Aadhaar credentials. On matching, the PAN will be  
		  linked to Aadhaar. 

	 •	 Secondly, taxpayer has to opt for Aadhaar EVC. A One Time Password (OTP)  
		  will be generated by the Aadhaar authorities and sent to the Aadhaar  
		  registered mobile of the taxpayer. Using this OTP, the taxpayer would be  
		  able to verify the uploaded return. 

		  Digital Signature Certificate (DSC):

	 •	 DSC is the electronic format of physical or paper certificate like a driving  
		  License, passport and so on. Certificates serve as proof of identity of an  
		  individual or organization for a certain purpose on online / computer. DSC  
		  can be presented electronically to prove taxpayer’s identity, to access  
		  information or services on the internet or to sign certain documents manually.

4.5.2.	 What are the points to be noted by the Taxpayer while sending an ITRV to CPC?

	 Ans. ITR-V is required to be submitted to CPC, by the Taxpayer who upload  
	 e-return without digital signature and E-verification. The Taxpayer needs to  
	 generate a printed copy of the ITRV, sign the ITRV and make sure the document  
	 is of good and readable quality in A4 size paper before sending to CPC. The  
	 original signed copy has to be sent in the address CPC, Bangalore 560500.  
	 Except the signature, no other details to be written on the printed ITRV. 

	 •	 The ITRV’s should not be stapled or folded. 
	 •	 Acknowledgement for DSC and EVC need not be sent to CPC.

4.5.3.	 What is the time frame for sending the ITRV?

	 Ans. The ITRV should reach to CPC within 120 days from the date of e-filing.

4.5.4.	 What are the consequences of not filing ITR-V within 120 days?

	 Ans. The returns which have not been verified with-in the 120 days’ time allowed  
	 are deemed to be never filed as per the rules. However, as a taxpayer friendly  
	 measure, the ITR-V submitted after 120 days will be taken up for condonation  
	 of delay based on the request of taxpayer or voluntarily, only if there is sufficient  
	 time available for processing of ITR. The interest on refund will be allowed after  
	 reduction of the delay in filing the ITR V i.e. no interest will be paid from 1st April  
	 of the AY till the date of submission of the ITR V and its acceptance as valid ITR V.

4.5.5.	 When will the Taxpayer be informed on the receipt of ITRV?

	 Ans. Once the ITRV is received and validated in CPC, the Taxpayer would be  
	 informed on the receipt of the same by ways of e-mail and SMS. Status is also  
	 available in the e-filing “My Account” section.

4.5.6.	 When the ITR-V has been submitted well within 120 days and however, the  
	 Taxpayer still receives SMS & emails from ITD-CPC asking to submit the ITR-V,  
	 should these mails be ignored or is there anything the Taxpayer needs to do?

	 Ans. Please do not ignore such remindeRs.It only means that the ITR-V is either  
	 rejected or not received by CPC yet. Hence the Taxpayer will have to submit the  
	 copy of ITR-V once again. In this scenario, the e-filing status shows “not  
	 received”/” not verified”.
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4.5.7.	 The Taxpayer has been receiving multiple emails & SMS pertaining to non- 
	 receipt of ITR-V. Why does the Taxpayer receive multiple reminders?

	 Ans. On regular intervals, CPC sends reminders in the form of email & SMS to  
	 those Taxpayers who have uploaded the return, but have not verified the return  
	 either through EVC or through a valid physical copy to CPC within 120 days of  
	 e-filing. CPC sends up to 5 reminders to the Taxpayers to submit the valid physical  
	 copy of ITR-V.

If Taxpayer sends a valid ITR-V physical copy to CPC and the same is accepted, CPC will 
cease sending any further reminders.

4.5.8.	 Are any other documents required to be sent along with an ITRV?

	 Ans. The Taxpayer needs to send only the signed ITRV to CPC. There is no need  
	 to send any annexures or documents along with the ITRV.

4.5.9.	 What are the ways by which an ITRV can be sent?

	 Ans. An ITRV can be sent by ordinary post or speed post or it can be dropped  
	 in the drop box available in CPC.

4.5.10.	What are the reasons for rejection of an ITRV?

	 Ans.	The reasons for rejection of an ITRV are below:
			   •	 Poor Quality (Image or Print not visible & poor paper quality)
			   •	 No Signature or Signature missing
			   •	 Invalid ITD watermark
			   •	 Photocopy of ITR-V (Printing of the screen shot or scan copy)
			   •	 No signature in Original or Invalid signature (Not signed in provided  
				    space for signature)

4.5.11.	 Would the Taxpayer be informed if the ITRV has been rejected?

	 Ans. Yes, the Taxpayer would be informed by e-mail and SMS when the ITRV  
	 is rejected. The status of rejection would also be updated in the e-filing “My  
	 Account” section.

4.5.12.	What does the Taxpayer need to do when his ITRV has been rejected?

	 Ans. The Taxpayer needs to generate another print of `the ITRV, sign the same  
	 in original and send it back to CPC within 120 days from the date of e-filing or  
	 can also do the e-verification.

4.5.13.	Which e-mail ID and mobile no. would be notified for information of 
	 ITRV status?

	 Ans. The Taxpayer would be notified by the e-mail id and mobile number provided  
	 during the time of e- filing the returns or in the profile, whichever is the latest.

Reminder to taxpayer
Period after which 
reminder is sent

Reminder Mode

First 30 days after e-filing email
Second 45 days after e-filing SMS alert
Third 60 days after e-filing email

Fourth 90 days after e-filing email
Final 110 days after e-filing email
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Do Don’ts

Please use Ink Jet /Laser printer to print the 
ITR-V Form. 

Use of Dot Matrix printer should 
be avoided.

The ITR-V Form should be printed only 
in black ink. 

Do not use any other ink option 
to print ITR-V.

Ensure that print out is clear Not a light print/faded copy.

The only permissible watermark is that of “Income 
tax Department” which is printed automatically 
on each ITR V.

Please do not print any water marks 
on ITR-V

The document that is mailed to CPC should be 
signed in Original.

Photocopy/Xerox of signatures will not 
be accepted.

Bar Code area  and numbers below barcode 
should be clearly visible.

The signatures or any handwritten text 
should not be written on Bar code.

Only A4 size white paper should be used.
Any other size of paper will not be 
accepted.  Perforated paper or any other 
size paper should be avoided.

Back page of ITR V should be blank
Avoid typing anything on the reverse side 
of the paper.

Keep Acknowledgement number clear
Do not use stapler on ITR-V 
Acknowledgement.

 In case, you are submitting Original and Revised 
Income Tax Returns,  Use two separate papers 
for printing ITR-Vs separately.

Do not print Original and Revised ITR 
back to back.

The ITR-V form is required to be sent to Post 
Bag No.1, Electronic City Post Office, Bengaluru, 
Karnataka-560500, by Ordinary or Speed Post.

Please do not submit any annexures, 
covering letter, pre stamped envelopes, 
along with ITR-V.

ITR V sent by Speed Post can be tracked 
on India Post

Taxpayer should choose one of the options i.e. 
either Digital signature or EVC or paper ITR V.

Taxpayer has to go through the FAQ’s related 
to EVC on e-filing website, before proceeding 
for EVC

ITR-Vs that do not conform to the above specifications may get rejected and 
processing of ITR gets delayed.
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CHAPTER 5

INWARDING OF 
INFORMATION 
FROM TRACES

5.1.	 There are different payments made in any Financial year with respect to  
	 the income earned for the respective year by the taxpayers as per the timelines  
	 stipulated in the Act. These are

	 •	 TDS (Tax Deducted at Source) 

	 •	 TCS (Tax Collected at Source)

	 •	 Advance Tax

	 •	 Self-Assessment Tax

	 •	 Regular Assessment Tax etc.

	 The tax payments such as Advance tax, Self-assessment tax or tax on regular  
	 assessment are directly shared with CPC by OLTAS. Taxpayers are required  
	 to ensure that correct Major Head and minor heads are entered while making  
	 the payment.

5.2.	 The tax payments on account of TDS/TCS is remitted to OLTAS, however  
	 the information about this is shared by TRACES only after the relevant TDS  
	 form is filed and the details of PAN, amount paid, TDS deducted, section  
	 under which it is deducted, etc., is processed. TRACES shares the information  
	 with CPC directly from 1/4/2018. Prior to this date, the information was shared  
	 via RCCs and NCC by ITD TDS system.

5.3. 	 The above payments are made using different mode of payments through  
	 various agencies and same is verified, collated and sent to CPC-FAS through  
	 interface from TDS-CPC / OLTAS for the purpose of computation of final tax  
	 as enumerated and claimed in the return of income (ITR).
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5.4.	 Flow Chart for Receipts / Challan in-warding to CPC FAS from TRACES 
	 and OLTAS.

5.5.	 During processing of ITR, if there is a mismatch between Tax payments  
	 claimed in ITR and credits available in CPC-FAS, record will be held in tax  
	 credit mismatch queue. All these mismatch cases are moved to separate  
	 place holder queue for reconciliation with respective systems i.e. TDS-CPC/OLTAS. 

5.6.1.	 Below checks will be done for reconciliation / confirmation: - 

	 •	 Whether inwarding is pending from TRACES.

	 •	 Whether receipts / challans files are errored out while inwarding from 	
		  TRACES / OLTAS to ETL  

	 •	 staging. 

	 •	 Whether receipts / challans files are inwarded to FAS Staging.

	 •	 Whether receipts / challans files are errored out while posting to FAS Staging.

5.6.2.	 Mismatch details will be shared to TRACES in regular intervals for confirmation  
	 on credit inwarding and re-matching of mismatch records will happen every  
	 3 days which is defined in the system until confirmation is received from  
	 TRACES/OLTAS. Once confirmation / feed is received, record will go for  
	 re-matching post inwarding of pending receipts / challans and record will 
	 get processed.

5.7.	 Flow Chart of the Reconciliation Process:
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5.8.	 Step by Step Process explanation:

	 Step 1:  Inwarding of OLTAS challans

			   •	 Tax payments in the form of Advance tax (AT) (minor head-100), 
				    Self-Assessment  tax (SAT) (minor head-300) and tax on regular  
				    assessment (400 payment) (minor head -400) are shared by OLTAS  
				    and are inwarded in a consoLidated file format for a single date on daily  
				    basis. In FY 2019-20, majority payments of AY 2020-21 are received,  
				    along with payments for SAT and 400 payment towards outstanding demands.

	 Step 2:	 Advance tax and Self-Assessment tax

			   •	 AT and SAT payments are posted to CPC FAS and awaiting claim by  
				    taxpayer in ITR. 

	 Step 3:	 Application of payment under minor code 400

			   •	 400 payments are inwarded and applied against outstanding demands  
				    on daily basis as and when shared by OLTAS. There are business rules to  
				    determine whether to apply the 400 payment received at CPC FAS.  
				    Some important rules are:

			   •	 400 challan is applied against demand if the demand and section 220  
				    interest on the same is equal to or less than challan (plus or minus Rs. 
				    100/-). If more than the demand + Interest, the challan is kept unapplied.

			   •	 400 challan raised by CPC during RO adjustment by CPC, is applied  
				    directly against the demand.

			   •	 E-pay based payment of 400 is applied towards the DIN without  
				    applicability of above rule (a).

			   •	 Payment towards appeal fee is also applied to demand, as the minor  
				    code for the same is not passed on by OLTAS and Banks to CPC FAS. etc.

	 Step 4:	 Minor code 200/400 under TDS Challan

			   •	 OLTAS payments of Minor 200 and 400 towards TDS/TCS are not  
				    considered at CPCFAS for application. These codes are inwarded.

	 Step 5:	 Inwarding of TDS/TCS receipts

			   •	 TDS/TCS receipts are received from TRACES as a daily file. All the  
				    receipts in the file are inwarded to FAS and credited against the relevant PAN.

	 Step 6:	 Inwarding and handling of corrections to OLTAS challan

			   •	 Corrections to OLTAS received on daily basis in a file format is also  
				    considered on a daily basis and changes are effected based on the status  
				    of challan that is undergoing change. Some of the key checks are:

			   •	 If challan is in unapplied state, correction is immediately effected.

			   •	 If challan is in applied state, as there is impact of the overall processed  
				    result for that AY, an alert is triggered in system to take up suo moto  
				    rectification, with other consequential changes/ rectifications, etc.
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	 Step 7:	 Inwarding and handling of corrections to TDS/TCS challan

			   •	 Corrections to TDS/TCS receipts with respect to AY, amount paid, TDS  
				    amount, PAN change are taken based on the correction entry received  
				    from TRACES. The changes are effected immediately if such receipt is in  
				    unmatched status and if it is matched or applied status, then a suo moto  
				    rectification trigger is alerted.

	 Step 8: Matching of claim in ITR with tax payments during processing of ITR

			   •	 During the matching of the claims in ITR at the time of processing of ITR,  
				    the claim against a TAN is taken at aggregate level and applied against  
				    multiple line items in CPC FAS till the claim in ITR is satisfied, 

			   •	 any excess credit available in TAN is not considered and kept un matched  
				    for claim in future yeaRs.

			   •	 If there is shortfall in the amount available in CPC FAS to match the  
				    claim in ITR, details of PAN, TAN, Claimed Amount, Matched Amount,  
				    AY is shared with TRACES for confirmation of TDS shared with CPC FAS.  
				    If additional TDS is available at TRACES and not in CPC FAS, such TDS  
				    is shared with CPC and ITR will be kept pending for inwarding and giving  
				    credit to such TDS and TDS is completely allowed after inwarding the  
				    same. CPC ITR waits for reasonable time for inwarding the fresh credit.

			   •	 In case TRACES confirms that there is no additional TDS to match the  
				    claim in ITR, then the ITR is processed giving credit to available TDS is  
				    CPC FAS.

	 Step 9:	 Tax Credit Mismatch Report for taxpayer

			   •	 In cases where there is OLTAS and/or TDS/TCS mismatch, a TAN/ 
				    Challan wise details are shared with taxpayer, along with the intimation  
				    with a view to explain reason for disallowance of claim for tax payments  
				    and also included the steps for rectification of the same.

	 Step 10:	Handling of TDS/TCS/OLTAS receipts received in CPC FAS after  
				    completion of processing of ITR.

			   •	 In cases where TDS/TCS or OLTAS challan is received after completion  
				    of processing of ITR either u/s.143 or 154, suo moto rectification taken  
				    up if the claim in ITR is correct. 

	 Step 11:	 Amount paid information as per TRACES with respect to TDS/TCS used  
				    in CPC.

			   •	 The amount paid information shared by TRACES is used for application  
				    of Adjustments u/s. 143(1)(a)(f) for AY 2017-18, and for application of  
				    Rule 37BA from AY2018-19 onwards wherein TDS is restricted to receipts  
				    offered in the ITR (if TDS claimed is not commensurate with receipts  
				    offered to tax in the ITR). 

			   •	 A notice u/s. 139(9) or 143 is issued before such adjustments are made  
				    to the ITR. 

			   •	 Any change to amount paid is also considered for suo moto rectification.
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5.9.	 The Form 26AS can be viewed on the TRACES system: 

5.9.1.	 The following details have been provided in 26AS statement: 

	 •	 Advance tax, Self-Assessment Tax and Regular Assessment Tax paid by self

	 •	 Tax paid through Tax Deducted at Source (TDS) or TCS on behalf of users  
		  own presence 

	 •	 Refund issued by the Department to self

	 •	 Information received from various agencies on high value transaction carried  
		  by self.

5.9.2.	 This statement is presented yearly, which reflects the transaction of the  
	 concerned year. 

5.9.3.	 Perform the following steps to view or download the form: 

Step 1 Logon to the ‘e-filing’ Portal www.incometaxindiaefiling.gov.in

Step 2
Go to the ‘My Account’ menu located at upper-left side of the page ⇒ Click 
‘View Form 26 AS (Tax Credit)’ , User is redirected to TDS-CPC Portal

Step 3
View the disclaimer ⇒ Click ‘Confirm’ ⇒ Agree the acceptance of usage ⇒ 
Click ‘Proceed’

Step 4 Click ‘View Tax Credit (Form 26AS)’

Step 5 Select the ‘Assessment Year’ and ‘View type’ (HTML, Text or PDF)

Step 6 Click ‘View / Download’

5.10.	 Tax Credit Mismatch Report

5.10.1.	 Users can view the details of non-matched amount of TDS claimed in the Income  
	 Tax Return. Also, as per online Tax statement (Form 26AS) TDS detail has 
	 been reflected. 

5.10.2.	 Perform the following steps to view the statement. 

Step 1 Logon to ‘e-filing’ Portal www.incometaxindiaefiling.gov.in

Step 2
Go to the ‘My Account’ menu located at upper-left side of the page ⇒ Click 
‘Tax Credit Mismatch’

Step 3 Select ‘Assessment Year*’ from the drop down list ⇒ Click ‘Submit’.

5.10.3.	 The Taxpayers need to verify the Tax Credit mismatch report before filing the  
	 ITR or rectification.

5.11.	 FAQs on Inwarding of tax payment challans at CPC FAS

5.11.1.	 What is time difference between receipt date for OLTAS challan and  
	 inwarding at CPC FAS?

Ans.	 OLTAS shares a daily file containing information of challans paid with CPC,  
	 the time difference is usually 3 days from date of payment.

5.11.2.	 Is the Form 26AS available to CPC ITR?

Ans.	 No, CPC ITR uses the information shared by TRACES system with respect to  
	 TDS/TCS and other information like amount paid, section under which TDS/TCS  
	 is made.
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5.11.3.	 What is the frequency of sharing of corrections by TRACES system?

Ans.	 Details of corrections to a receipt is shared on daily basis. Daily files contain the  
	 correction entries to the receipts as well as fresh entries.

5.11.4.	 Is there any suspense entry created if there is invalid PAN mentioned in challan?

Ans.	 Yes, As the challan is inwarded to FAS at PAN level, if the PAN is incorrect, the  
	 challan is inwarded. Any correction entry to PAN will be inwarded as and when  
	 the same is received from OLTAS. In such cases, suo moto rectification alert is  
	 also triggered.

5.11.5.	 What is the frequency of initiating suo moto rectification at CPC with respect of  
	 correction of OLTAS or TDS/TCS receipts?

Ans.	 System trigger is automated and alerts from the system are checked on all  
	 working days by the CPC Team and suo moto rectification is initiated. In cases  
	 where ITR processing is yet to complete, such correction is done by re-processing  
	 the ITR/rectification.

5.11.6.	 What information is provided in the tax mismatch report shared with taxpayer?

Ans.	 Detailed process steps for rectification is provided in the report. In cases of TDS/ 
	 TCS mismatch: 

	 •	 TAN wise claim made, mismatch amount is provided, 

	 •	 whether TAN is valid or invalid (due to data entry errors by taxpayer), 

	 In case of OLTAS mismatch:

	 •	 Details of challan as claimed in ITR is provided to highlight that such challan  
		  is not available at CPC FAS, taxpayer is prompted to check the AY, date of  
		  payment, amount claimed in ITR. 

5.11.7.	 Whether AO can seek transfer of rectification rights in tax credit mismatch  
	 cases to give effect to Circular No. 8/2015?

Ans.	 AO can seek transfer of rectification rights, if the taxpayer approached the AO  
	 with TDS certificates and indemnity bond. Such requests are handled  
	 automatically by the system in scheduled manner. If any rectification is in progress,  
	 the transfer is done after completion of the same. Taxpayer is intimated about  
	 the transfer of rectification rights to AO and is prevented from filing  
	 rectification at CPC as along as rectification rights are with AO.

5.11.8.	 Whether CPC can revert the rectification rights available with AO, for the  
	 purpose of any suo moto rectification?

Ans.	 Yes, CPC can revert back the rectification rights which are with AO, by raising  
	 a request which is required to be approved by the AO in the ITBA portal. Only  
	 after approval, the rectification rights are reverted back to CPC.

5.11.9.	 Is there a difference between the TDS mismatch report available in e-filing  
	 website for taxpayer and CPC FAS?

Ans.	 Yes, there can be a difference due to changes to challan information from  
	 OLTAS and TRACES from time to time. Credit to claim in ITR is allowed by  
	 CPC FAS based on information available therein without any regard to Form  
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	 26AS or information in e-filing website. Though such occurrences are minimal,  
	 still there can be differences and in such cases CPC FAS entries are final. 

5.11.10.	 Is the mismatch report available to AO?

Ans.	 Intimation for all tax credit mismatch contains this report as a separate  
	 annexure and same can be referred by the AO in Processed Data Transfer  
	 that is shared via ITBA. 

5.11.11.	 Whether the intimation u/s 143(1) is shared with the AO?

Ans:	 AO can access the intimation from AY 2018-19 onwards. For other AYs, it will  
	 be generated and shared by email.

5.11.12.	 Does CPC effect any PAN/TAN/AY corrections on the challans?

Ans:	 No. Only AO is enabled to correct challans in ITBA system.

5.11.13.	 While making Tax payments, taxpayer has wrongly mentioned AY/ minor  
	 head/major head/ different PAN in Challan?

Ans.	 Taxpayer is requested to communicate via email with the jurisdictional  
	 assessing officer regarding correction of challan w.r.t these details. Post  
	 correction, taxpayer is requested to file an online rectification and claim this  
	 corrected challan, so that credit for the same can be allowed by CPC.
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CHAPTER 6

INWARDING OF 
INFORMATION 
FROM E-FILING

Electronic returns and statutory Forms are filed by taxpayers on e-filing website. 
These forms and e-returns are transmitted to CPC by e-filing. The detailed information 
of the ITR will be shared separately by e-filing in the form of tables, wherein the 
data structure is agreed between CPC and e-filing, as there will be changes to ITR 
form types for every assessment year, and sometimes within the year also. The data 
structure for the statutory and non-statutory form is also received at CPC based on 
the changes in the forms, if any.

The website provides facility to view all the help material published on the portal 
under the link: https://www.incometaxindiaefiling.gov.in/main/brocheureAndVideos 
as on 15/10/2020.

6.1.	 The following e-filing Brochures are provided in the website for the benefit  
	 of users.

e-filing Brochures

S.No. Title eBook Brochures

1 e-Verification of ITR 
View (4.94MB) Download (1.91MB)

Last Updated on: 27/03/2019 Last Updated on: 05/12/2018 

2 Reset e-Filing Password 
View (4.76MB) Download (2.05MB)

Last Updated on: 27/03/2019 Last Updated on: 05/12/2018

3 e-Proceedings
View (2.34MB) Download (2.08MB)

Last Updated on: 27/03/2019 Last Updated on: 05/12/2018

4
Rectification of Order/

Intimation
View (1.78MB) Download (1.12MB)

Last Updated on: 27/03/2019 Last Updated on: 20/12/2018

5 File Revised Return 
View (1.81MB) Download (1.17MB)

Last Updated on: 27/03/2019 Last Updated on: 14/03/2019

6 e-Filing Vault 
View (1.59MB) Download (985KB)

Last Updated on: 27/03/2019 Last Updated on: 29/01/2019

7
View Tax Credit 

Statement (Form 26AS)
View (1.49MB) Download (652KB)

Last Updated on: 27/03/2019 Last Updated on: 05/03/2019

8
Response to 

Outstanding Demand
View (1.84MB) Download (1.2MB)

Last Updated on: 27/03/2019 Last Updated on: 05/03/2019
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6.2.	 The list of ITR forms available in the e-filing portal as on 15/10/2020 are 
	 as under:

6.3. 	 List of Statutory and Other Forms provided in the e-filing portal as on  
	 15/10/2020 are provided in Annexure 1 to this handbook.

6.4.	 Forms related to Equalization Levy.

6.5.	 Forms related to Income Declaration Scheme, 2016.

Income Tax Returns

S.No. ITR Description Online Offline

1 ITR 1 
For Individuals having Income from Salaries, 
one house property, other sources (Interest etc.) 
and having total income upto Rs.50 lakh 

Yes Yes

2 ITR 2 
For Individuals and HUFs not carrying out 
business or profession under any proprietorship

No Yes

3 ITR 3 
For individuals and HUFs having income 
from a proprietary business or profession

No Yes

4 ITR 4 
For presumptive income from 
Business & Profession

Yes Yes

5 ITR 5 
For persons other than,- (i) individual, (ii) HUF, 
(iii) company and (iv) person filing Form ITR-7

No Yes

6 ITR 6 
For Companies other than companies claiming 
exemption under section 11

No Yes

7 ITR 7 
For persons including companies required to 
furnish return under sections 139 (4A) or 139 (4B) 
or 139 (4C) or 139 (4D) or 139 (4E) or 139 (4F) 

No Yes

Equalization Levy

S.No. Form Description Applicability Online Offline

1 Form 1
Statement of Specified 
Services - Equalisation 
levy Rules, 2016

Individual, HUF, Company, 
AOP/BOI/Trust/Firm/ 
AJP/LA

YES YES

2 Form 3
Appeal to the Commissioner 
of Income-tax (Appeals) - 
Equalisation levy Rules, 2016

Individual, HUF, Company, 
AOP/BOI/Trust/Firm/ 
AJP/LA

YES NO

IDS - Income Declaration Scheme, 2016

S.No. Form Description Applicability Online Offline

1 Form 1_IDS*

Form of Declaration under section 
183 of the Finance Act, 2016, in 
respect of the Income Declaration 
Scheme, 2016 

Individual, HUF, 
Company, AOP/
BOI/Trust/Firm/
AJP/LA

YES YES

2 Form 2_IDS

Acknowledgement Of Declaration 
Under Section 183 Of The Finance 
Act, 2016 In Respect Of The 
Income Declaration Scheme, 2016

Commissioner of 
Income 
Tax Department

YES NO

3 Form 3_IDS

Intimation Of Payment Under 
Sub-Section (1) Of Section 187 Of 
The Finance Act, 2016 In Respect 
Of The Income Declaration 
Scheme, 2016 

Individual, HUF, 
Company,AOP/
BOI/Trust/Firm/
AJP/LA

YES NO

4 Form 4_IDS

Certificate Of Declaration Under 
Section 183 Of The Finance Act, 
2016 In Respect Of The Income 
Declaration Scheme, 2016 

Commissioner 
of Income Tax 
Department

YES NO
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6.6.	 Forms related to Pradhan Mantri Garib Kalyan Yojana.

6.7.	 Forms related to Black Money.

* The due date is expired 

6.8.	 Forms related to The Direct Tax Vivad Se Vishwas, 2020

PMGKY -Pradhan Mantri Garib Kalyan Yojana

S.No. Form Description Applicability Online Offline

1
Form 1 _ 
PMGKY*

Form of Declaration under section 
199C of the Finance Act, 2016, 
In Respect Of the Taxation and 
Investment Regime for Pradhan 
Mantri Garib Kalyan Yojana 
Rules, 2016 

Individual, HUF, 
Company, AOP/
BOI/Trust/Firm/
AJP/LA

YES NO

2
Form 2 _ 
PMGKY

Certificate of Declaration under 
section 199C of the Finance Act, 
2016, In Respect of the Taxation 
and Investment Regime for 
Pradhan Mantri Garib Kalyan 
Yojana Rules, 2016

Commissioner 
of Income Tax 
Department

YES NO

3
Form V _ 
(PMGK)

Form for reporting under Pradhan 
Mantri Garib Kalyan Deposit 
Scheme, 2016

Individual, HUF, 
Company, AOP/
BOI/Trust/
Firm/AJP/LA, 
Tax Deductor & 
Collector

NO YES

PMGKY -Pradhan Mantri Garib Kalyan Yojana

S.No. Form Description Applicability Online Offline

1
Form 1 _ 
DTVSV 

Form for filing declaration

Individual, HUF, 
Company,AOP/
BOI/Trust/Firm/
AJP/LA

YES NO

2
Form 2 _ 
DTVSV

UNDERTAKING UNDER SUB-
SECTION (5) OF SECTION 4 
OF THE DIRECT TAX VIVAD SE 
VISHWAS ACT, 2020 (3 of 2020) 
THE DIRECT TAX VIVAD SE 
VISHWAS RULES, 2020 

Individual, HUF, 
Company,AOP/
BOI/Trust/Firm/
AJP/LA

YES NO

3
Form 3 _ 
DTVSV

FORM FOR CERTIFICATE UNDER 
SUB-SECTION (1) OF SECTION 5 
OF THE DIRECT TAX VIVAD SE 
VISHWAS ACT, 2020 (3 of 2020) 
THE DIRECT TAX VIVAD SE 
VISHWAS RULES, 2020 

Commissioner 
of Income Tax 
Department

YES NO

PMGKY - Pradhan Mantri Garib Kalyan Yojana

S.No. Form Description Applicability Online Offline

1 Form 6*

Form of declaration of 
undisclosed asset located 
outside India under section 59 
of the Black Money (Undisclosed 
Foreign Income and Assets) and 
Imposition of Tax Act, 2015

Individual, HUF, 
Company, AOP/
BOI/Trust/Firm/
AJP/LA

NO YES
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6.9.	 The e-return information is shared in two phases:

	 •	 Metadata: This data is the information shared in ITR-V, and is sent by e-filing  
		  on daily basis for ITRs received. This information is used to validate ITR-V  
		  when physical paper ITR-V is received. 60% of taxpayers use EVC mode and  
		  40% send ITR-V in paper form.

	 •	 TB Data: This data is the completed information of data provided by taxpayer  
		  in the ITR, and is used for computation and accounting of the ITR.

6.10.	 Apart from e-returns, e-filing also shares the following information to CPC:

	 •	 Rectification applications filed by taxpayers.

	 •	 Responses to Defective returns from taxpayers, provided by them in  
		  e-proceedings module.

	 •	 Responses to Notice u/s. 143(1)(a) (Prima Facie Adjustment), provided by the  
		  taxpayer in e-proceedings module.

	 •	 Responses to Outstanding demand, either in response to Intimation u/s. 
		  245 or voluntarily.

	 •	 e-Nivaran grievances filed on the e-filing website.

	 •	 Refund reissue requests.

	 •	 Forms filed by taxpayers that are used for processing of ITR.

6.11.	 The below website link provides the help documents and FAQS with respect to  
	 taxpayer services provided by the Department using CPC. There is facility to  
	 view the help documents in Hindi using the following link:

	 http://www.incometaxindiaefiling.gov.in/help/index_hindi.html

6.12.	 Help documents can be accessed in English using the following link:

	 http://www.incometaxindiaefiling.gov.in/help/?lang=eng

S.No. Form Description Applicability Online Offline

4
Form 4 _ 
DTVSV

INTIMATION OF PAYMENT 
UNDER SUB-SECTION (2) OF 
SECTION 5OF THE DIRECT TAX 
VIVAD SE VISHWAS ACT, 2020 (3 
of 2020) THE DIRECT TAX VIVAD 
SE VISHWAS RULES, 2020 

Individual, HUF, 
Company, AOP/
BOI/Trust/Firm/
AJP/LA

YES NO

5
Form 5 _ 
DTVSV

ORDER FOR FULL AND FINAL 
SETTLEMENT OF TAX ARREAR 
UNDER SECTION 5 (2) READ 
WITH SECTION 6 OF THE DIRECT 
TAX VIVAD SE VISHWAS ACT, 
2020 (3 of 2020) THE DIRECT 
TAX VIVAD SE VISHWAS 
RULES, 2020

Commissioner 
of Income Tax 
Department

YES NO
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6.13.	 Step by Step Process explanation:

6.13.1.	 ITRs Related Process Steps:

Step 1:	 Inwarding of metadata of ITR uploaded and frequency

	 •	 e-filing shares the key information about the filing of ITR in the e-filing  
		  which are essential for validation of ITR-V. The information in the metadata  
		  is same data provided in the ITR-V.

	 •	 Information of Metadata is inwarded to CPC daily.

	 •	 EVC information for ITR/revised ITR that is validated is inwarded by CPC  
		  on daily basis.

	 •	 Digital Signature Code verified ITR information is also inwarded 
		  on daily basis.

Step 2:	Detailed information of ITR and frequency

	 •	 The detailed information of the ITR is also inwarded simultaneously from  
		  e-filing in the table format. 

	 •	 Appropriate checks are made by CPC when a new form type is introduced  
		  to check if all the fields are mapped properly and data transmission is full  
		  and error Free.

	 •	 Information of TB Tables is shared on daily basis and for each form type  
		  the transmission is separate and in parallel.

Step 3: Revised ITR and frequency

	 •	 If a revised ITR is filed, such ITR is also inwarded to CPC from e-filing on  
		  daily basis.

	 •	 Date of filing of original return is considered for treatment of revised ITR.  
		  If the revised return is required to be considered, then:

	 •	 If the original ITR is not yet taken for processing, the corresponding original  
		  ITR is marked as closed.  

	 •	 If the original ITR is taken for processing and is in progress, such ITR is  
		  removed from the processing queue and revised ITR is taken for processing  
		  and consideration is given to date of filing of original ITR.

	 •	 If the original ITR is already processed and intimation is issued, then the  
		  revised ITR is taken for processing by reversing the tax credit information  
		  used in computation for the original ITR.

	 •	 If the refund that is arising out of processing of original ITR is in progress,  
		  revised ITR is considered for processing only after such refund is either  
		  paid or unpaid.

Step 4:	Defective Return and corrected return

	 •	 If the ITR is found to be defective by CPC during processing of the same,  
		  taxpayer is allowed to file a corrected ITR. Such corrected ITR are inwarded  
		  daily at CPC.

	 •	 The corrected ITR will replace the defective ITR which is in the queue and  
		  takes the date of filing of original ITR.

	 •	 The corrected ITR goes through all the processes that are applied for ITR.

	 •	 In case a revised ITR is filed on top of corrected ITR, the corrected ITR 
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		  is closed and revised ITR is taken for processing.

	 •	 If the corrected ITR is also found to be defective, same is communicated 
		  to taxpayer u/s. 139(9).

	 •	 Taxpayers may choose to respond to notice u/s.139(9) by providing text 	
		  response in e-proceeding module, instead of filing corrected return. In such  
		  cases, CPC evaluates the response and appropriate action is taken either  
		  accepting the response and processing the ITR or rejecting the response  
		  and intimating the taxpayer about such rejection and further opportunity  
		  is given to file corrected/revised ITR, as may be applicable.

6.13.2.	 On successful filing of the ITR, the same will be processed with the details  
	 provided. If there are any discrepancies or mistakes in the ITR, then the re 
	 turn will be treated as Defective. The taxpayer will then be issued a Defective  
	 Return notice u/s 139(9).

Note:	 The taxpayer must revise the return addressing the defects within the time 
	 line as mentioned in the notice u/s 139(9).

6.13.3.	 Perform the following steps to submit response to notice issued u/s 139(9): 

Step 1 Logon to ‘e-filing’ Portal www.incometaxindiaefiling.gov.in 

Step 2
Go to the ‘e-File’ menu located at upper-left side of the page ⇒ Click 
‘e-File in response to Notice u/s 139(9)’

Step 3
Details such as ITR, A.Y, e-filing Acknowledgement No., CPC Reference 
Number, Notice Date, Status and Response are displayed. Click the 
‘Submit’ hyperlink in the Response column.

Step 4

All the identified defects from the filed ITR is displayed to the taxpayers.
Choose YES/NO from the ‘Do you agree with defect?’ column.
• On Choosing YES, Upload the correct XML and Click the Submit button.
• On Choosing NO, Enter your remarks under column ‘Assessee Re-
marks’ and Click the Submit button.

Note
For AY 2019-20, Please download the latest ITR utility for AY 2019-20 and  
generate the XML by choosing ‘Filed in response to notice u/s’ as ‘139(9)’ in  
the ITR utility.

Step 5
To view the submitted response, click ‘View’ hyperlink under Response 
column to know the details of response submitted.

 

6.13.4. Statutory and Non-Statutory Forms other than ITRs

	 Step 1:	Inwarding of statutory and non-statutory forms

	 	 	 •	 CPC inwards the Forms that are used in the course of processing of ITR, 
				    as per the provisions of the Act.

			   •	 Inwarding is done on daily basis.

			   •	 Any changes to forms and information in the form by revision of forms 
				    is also inwarded from e-filing.

	 	 	 •	 The process has undergone changes over the years and each AY 
				    is  considered based on the provisions of the Act for such AY. Some forms 
		   		  are date oriented and there can be other conditions.

			   •	 E-filing shares the forms only after the same is validated by the taxpayer in  
				    certain cases like Audit reports, etc.
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6.14. Tax Professional Services

6.14.1.	 Tax professional (Charted Accountant) can file audit report / other forms  
	 for assessee. Assessee must opt for Tax professional services for the same by  
	 using ‘My Account ⇒ My CA/ERI’ option post login to e-Filing portal. All the  
	 filing by tax professional must be with the valid DSC. Option to file the forms  
	 is available in e-Filing portal under e-File menu post-login. The following are  
	 the list of Forms that can be filed by Charted Accountant (CA) and must  
	 be verified (View and approve / reject) by assessee. 6.13. Step by Step 
	 Process explanation:

Form Name Description

Form 3AC
Audit report under section 33AB(2) - Amount deposited by Tea or 
coffee or rubber development Account

Form 3AD
Audit Report under section 33ABA(2) - Amount deposited by assessee 
engaged in prospecting, extraction or production of petroleum or 
natural gas

Form 3AE
Audit report under section 35D(4)/35E(6) of the Income-tax Act, 1961 - 
Amortisation of Preliminary Expenses 35D(4) / Deduction for expenditure 
on prospecting for certain minerals

Form 3CA-3CD
Audit report under section 44AB of the Income-tax Act,1961 in a case 
where the accounts of the business or profession of a person have been 
audited under any other law

Form 3CB-3CD
Audit report under section 44AB of the Income-tax Act,1961, in the case of 
a person referred to in clause (b) of sub-rule (1) of rule 6G

Form 3CE
Audit Report under sub-section (2) of section 44DA of the Income-tax Act, 
1961 - Royalty income in case of Non-Resident

Form 3CEA
Report of an accountant to be furnished by an assessee under sub-section 
(3) of section 50B of the Income-tax Act, 1961 relating to computation of 
capital gains in case of slump sale - Capital Gain in case of Slump Sale

Form 3CEB
Report from an accountant to be furnished under section 92E relating 
to international transaction(s)

Form 3CEJ
Report from an accountant to be furnished for purposes of section 9A 
relating to arm’s length price in respect of the remuneration paid by 
an eligible investment fund to the fund manager

Form 3CLA
Report from an accountant to be furnished under sub-section (2AB) 
of section 35 of the Act relating to in-house scientific research and 
development facility

Form 6B Audit report under section 142(2A) of the Income-tax Act, 1961

Form 10B
Audit report under section 12A(b) of the Income-tax Act, 1961, in the case 
of charitable or religious trusts or institutions

Form 10BB

Audit report under section 10(23C) of the Income-tax Act, 1961, in the case 
of any fund or trust or institution or any university or other educational 
institution or any hospital or other medical institution referred 
to in sub-clause (iv) or sub-clause (v) or sub-clause (vi) or sub-clause 
(via) of section 10(23C).

Form 10CCB
Audit report under sections 80-I(7)/80-IA(7)/80-IB - Any undertaking 
claiming deduction u/s 80-I(7)/80-IA(7)/80-IB

Form 10CCBBA
Audit report under section 80-IB(14) - Any undertaking claiming deduction 
u/s 80-IB(14)

Form 10CCBC
Audit report under section 80-IA(11B) - Any undertaking claiming 
deduction u/s 80-IA(11B)

Form 10CCBD
Audit report under section 80-IB(11C) - Any undertaking claiming 
deduction u/s 80-IA(11C)

Form 10CCC
Certificate under sub-rule (3) of rule 18BBE of the Income-tax Rules, 1962 - 
For entities doing highway project in which housing is integral part 
80-IA(6)
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Form 10CCF
Report under section 80LA(3) of the Income-tax Act, 1961 - For off shore 
banking units and international financial service center

Form 10DA
Report under section 80JJAA of the Income-tax Act, 1961 - Deduction 
claimed by company for New Workmen engaged

Form 15CB Certificate of an accountant as per rule 37BB

Form 29B
Report under Section 115JB of the Income-tax Act, 1961 for computing the 
book profits of the company

Form 29C
Report under section 115JC of the Income-tax Act, 1961 for computing 
Adjusted Total Income and Alternate Minimum Tax of the person other than 
a company

Form 49C Annual Statement under section 285 of the Income-tax Act,1961

Form 56F
Report under section 10A of the Income-tax Act, 1961 - Every person 
claiming deduction u/s 10A (STP / EHTP / FTZ / SEZ)

Form 66
Audit Report under clause (ii) of section 115VW of the Income-tax Act, 1961 
- Audit Report of Tonnage Tax company i.e., Shipping companies

	 Once filed by CA, the form is available under assessee worklist (Worklist ⇒ FYA  
	 option post login to e-Filing portal by assessee). Assessee can verify the  
	 correctness of the form and approve/reject the form. CA can also check the status  
	 (Approved/Rejected/Pending Approval) of the form under ‘My Re quest  
	 List’6.14.2. Form 62, Form 63, Form 63A, Form 64, Form 64A, Form 64E and Form  
	 64D shall be filed by assessee and will come to CA’s worklist for verification  
	 (approve/reject). CA can act on these forms under the ‘Worklist’ option. 

6.15.	 Filing of Audit Reports and Forms

6.15.1.	 There are two methods for filing the various reports and forms, Offline and  
	 online method. Forms can be filed offline using the option ‘Upload Form’  
	 under ‘e-File’ menu. Whereas, other forms such as Form 3AC, Form 3AD  
	 and so on can be filed online using the option ‘Prepare and Submit Online  
	 Form (Other than ITR)’ under ‘e-File’ menu.

6.15.2.	 Upon submission of audit reports and form by CA is over, it will go to  
	 Assessee worklist for approval or rejection. If CA wants to review the pending  
	 forms for approval, the same can be reviewed from ‘My request List’ menu,  
	 where the lists of forms that are pending for approval from the assessee are  
	 listed. There are some Statutory Forms such as Form 62, Form 63, Form 63A,  
	 Form 64, Form 64A, Form 64E, Form 64D that needs to be initiated by 
	 Assessee and reviewed by CA. On finding the forms in place, CA will verify the forms.

6.16.  Online Rectification

Step 1: Inwarding of rectifications filed by taxpayers

	 •	 All rectification filed by taxpayers are inwarded to CPC on daily basis.

	 •	 In case rectification is filed under code 18 (Tax Credit Mismatch correction  
		  only), the relevant information is inwarded and ITR is processed by  
		  amending the claims information with the new information provided by  
		  taxpayer in rectification.

	 •	 In case rectification is filed under code 19 (Only reprocess the return), the ITR 
		  is re-processed based on the existing information in ITR and claims in FAS.

	 •	 In case rectification is filed under code 20 (Return data Correction  
		  (XML)), the information is shared by e-filing at table level. Rectified ITR  
		  uploaded by the taxpayer is considered for processing.

	 •	 Rectification applications for changing the ‘Status’ or ‘Sub Status’ or  
		  ‘Exemption status’ or ‘234C’ of taxpayer are considered by inwarding the  
		  relevant information provided by the taxpayer.
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6.16.2.	 The return filed by the taxpayer will be processed by Income Tax Department  
	 (ITD) and intimation will be sent to the assessee under section 143(1) based  
	 on details disclosed by the taxpayer and rules deployed at the processing  
	 center by ITD. In case if the taxpayer wants to seek rectification of a mistake in  
	 an order or intimation which is apparent from the record, then the taxpayer  
	 can seek ‘Rectification under Section 154’

6.16.3.	 Perform the following steps to file the Rectification request.

Step 1 Logon to ‘e-filing’ Portal www.incometaxindiaefiling.gov.in 

Step 2
Go to the ‘e-File’ menu located at upper-left side of the 
page ⇒ Click ‘Rectification’ 

Step 3
Choose the options of ‘Order/Intimation to be rectified’ and ‘Assessment 
Year’ from the drop down list. Click ‘Continue’ 

Step 4

Select any one of the following options of ‘Request Type’ 
from drop down list. 
· Tax credit mismatch correction only - On selecting this option,    
following check boxes will be displayed. 
     • TDS on Salary Details
     • TDS on Other than Salary Details
     • TDS on transfer of Immovable property/Rent
     • TCS Details
     • IT Details
You may select the check box for which data needs to be corrected.
You can add a maximum of 10 entries for each of the selections. No 
upload of an Income Tax Return is required.
Note: This option is available only for ITR 1 for AY 2019-20. For 
remaining ITRs for AY 2019-20 this option is not available, so the 
assessee should use Return Data Correction (XML) option for rectifying 
tax credit mismatch. 

Return data Correction (XML) - Select the following 
Reason for Rectification by clicking the button made available. 
(maximum of 4 reasons)
Schedules being changed
     • Donation and Capital gain details (if applicable)
     • Upload XML, and 
     • Digital Signature Certificate (DSC) (if available and applicable) 
Note: 
     • When the user is uploading XML, the Gross Total Income and      
        Deductions amount should be the same as in the processed return.
     • For AY 2018-19 the assessee should select ‘Filing Type’ as  
        ‘Rectification’ in the ITR utility and upload the XML

• Only reprocess the return – On selecting this option, user needs to just  
submit the rectification request.
Note: User can verify the Form 26AS details under My Account ⇒ View 
Form 26AS and Tax Credit Mismatch under My Account ⇒ Tax Credit 
Mismatch

• Correcting Status (Only for ITR-5 & 7) (Till AY 2018-19) - On selecting 
this option, the user should select the status applicable from the 
displayed drop down, answer the additional questions asked and upload 
the necessary attachments to submit the request.
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• Correcting Exemption Section Details (only for ITR-7) (Till AY 2018-19) 
– On Selecting this option, the user must fill in all the applicable fields 
and upload the necessary attachments to submit the request.

• Additional information for 234C - On Selecting this option, the user 
must fill in all the applicable fields to submit the request.

Step 5
Click Submit to complete the rectification request. A Success message 
will be displayed and a mail confirming the submission of rectification 
request will be sent to the user’s registered mail id. 

Step 6 To View the submitted Rectification Request, Click here to know more 

Note

• Taxpayer can withdraw rectification within end of the day of 
request, To withdraw rectification request, Click hyperlink ‘Click here 
to withdraw’
• Submission of Rectification allowed for both paper filed and e-Filed 
Returns and for rectification rights transferred to AO.

6.16.4. Manage your Profile facility for taxpayers

	 Taxpayer can edit the details such as Address and Contact details. For updating  
	 the contact details, OTP authentication is required. However, user can view the  
	 PAN details, Aadhaar details and jurisdiction. 

6.16.5. Edit Profile Information

	 Perform the following steps to edit the information associated with your account: 

Step 1

Logon to the 'e-filing' Portal www.incometaxindiaefiling.gov.in

• Taxpayer can withdraw rectification within end of the day of 
request, To withdraw rectification request, Click hyperlink ‘Click here 
to withdraw’

Step 2

Go to the 'Profile Setting' menu located at the upper-right side of the 
page⇒ Click 'My Profile' ⇒ Click 'Edit' button located at right side of the 
page ⇒ Enter the details ⇒ Click 'Save' ⇒ Verify the edited details and 
Click 'Continue' 

Step 3

After updating Contact details,

• A 'Mobile OTP' will be sent to the registered mobile number 
(Primary Contact)

• A 'Email OTP' will be sent to the registered email ID (Primary Contact)

Step 4 Enter 'Mobile OTP' and 'Email OTP' ⇒ Click 'Confirm'

6.16.6.	Change the Password

	 Perform the following steps to change the password in e-filing:

Step 1

Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in

• Taxpayer can withdraw rectification within end of the day of 
request, To withdraw rectification request, Click hyperlink ‘Click here 
to withdraw’

Step 2
Go to the 'Profile Setting' menu located at the upper-right side of the 
page ⇒ Click 'Change Password'

After updating Contact details,

Step 3
Enter 'Current Password' (Existing password) ⇒ Enter 'New Password' ⇒ 
Confirm the 'New Password' ⇒ Click 'Submit'



CPC HANDBOOK NOV 202054

6.16.7.  Registration of DSC

	 During upload of a return, user can sign the return digitally or online by using  
	 their Digital Signature Certificate (DSC).

	 If you do not have your DSC file to register at e-filing portal, firstly, obtain the  
	 DSC file. 

6.16.7.1. Perform the following steps to register the DSC to generate a signature file  
	 in e-filing:

Step 1

Logon to the 'e-filing' Portal www.incometaxindiaefiling.gov.in

• Taxpayer can withdraw rectification within end of the day of 
request, To withdraw rectification request, Click hyperlink ‘Click here 
to withdraw’

Step 2
Go to the 'Profile Setting' menu located at the upper-right side of the 
page ⇒ Click 'Register Digital Signature Certificate' ⇒ 'Click here to 
download the DSC Utility'

Step 3
After updating Contact details,

Extract the downloaded DSC Utility ⇒ Open the Executable Jar File 
(DSC Utility) ⇒ Read the instructions carefully.

Step 4

• A 'Email OTP' will be sent to the registered email ID (Primary Contact)

In the DSC Management Utility, go to 'Register/Reset Password using 
DSC' tab ⇒ Enter 'Enter e-filing User ID*', 'Enter PAN of the DSC*' ⇒ 
Select the type of 'Digital Signature Certificate' (DSC)

Step 5

DSC using .pfx file:1. Select the Type of DSC .pfx file2. Browse and attach 
the Keystore file (.pfx File)3. Enter the password for your private key4. 
Click 'Generate Signature file'DSC using USB token:1. Select the Type of 
DSC (.pfx file or USB token) USB Token2. Select USB Token Certificate 
⇒ Click 'Generate Signature File' ⇒ Browse and attach the signature file 
using the browse option ⇒ Click 'Submit' 

Step 6
Browse and attach the signature file using the browse option 
⇒ Click 'Submit'

6.17.8.	Change Secret Question(s) and Answer(s)

	 Perform the following steps to change the Secret Question(s) or Answer(s):

Step 1

Logon to the 'e-filing' Portal www.incometaxindiaefiling.gov.in

• Taxpayer can withdraw rectification within end of the day of 
request, To withdraw rectification request, Click hyperlink ‘Click here 
to withdraw’

Step 2
Go to the 'Profile Setting' menu located at the upper-right side of the 
page ⇒ Click 'Change Secret Question(s) / Answer(s)'

After updating Contact details,

Step 3
Select 'Primary Secret Question' ⇒ Enter 'Primary Secret answer' ⇒ 
Select 'Secondary Secret Question' ⇒ Enter 'Secondary Secret Answer'

Step 4 Click 'Submit'
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6.17.9.	 e-proceedings

Step 1:	 Inwarding of responses provided by taxpayers in e-proceedings 
	 module of e-filing

	 •	 The details of notice u/s.143(1), categorized based on each case is shared  
		  with e-filing for elicitation of response in a pre-determined manner. It is  
		  shared by CPC and hosted under e-proceedings module for taxpayers 
		  to respond.

	 •	 The responses from taxpayers to notice u/s.143(1) is provided in  
		  e-proceedings module in e-filing and it is inwarded by CPC on a daily basis.

6.17.9.1.	e-Proceedings is an electronic platform for conducting proceedings in  
	 an end-to-end manner. It was introduced by the Income tax department  
	 to bring about transparency and efficiency in the income tax related  
	 proceedings.All the notices/intimations/letters from the department are  
	 made available under e-Proceedings where the assessee would be able to  
	 view and submit the response along with the attachments by uploading the  
	 same on the e-filing portal.

6.17.9.2.	The Assessee who receives the notices/intimations/letters from the  
	 Department can respond to the e-Proceedings on their own in the e-filing  
	 portal by following few simple steps.

	 Or

	 The Assessee can assign an authorized representative in the e-filing portal  
	 to respond to the notices/intimations on their behalf. 

6.17.9.3. steps to view and respond to an e-proceeding by self

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

Step 2
Post login, click on the 'e-Proceeding' menu and click 
'e-Proceedings' link.

Step 3
Details of Proceedings related to Self, such as PAN, Assessment year, 
Proceeding Name, Proceeding Status, Proceeding Limitation Date, 
Proceeding Closure Date and Action.

Step 4
Click on the 'Proceeding Name' hyperlink of the appropriate proceeding 
to view notice details.

Step 5
Additional details such as Notice/Communication reference ID, Notice 
u/s, Description, Issued On, Document Id, Served On, Response Due date 
and Response are displayed.

Step 6
To view the details of the notice, click on the 'Notice/Communication 
reference ID' link and to submit your response against that particular 
notice, click on the 'Submit' link under the 'Response' column.

Step 7

Upon clicking on submit, a new page is opened where the Proceeding 
Name, Document Reference Id and Notice Section are pre-filled. 
Select the 'Response Type' from the dropdown (Partial Response/Full 
Response). Enter the 'Response/Remarks' in text box not exceeding 
4000 characteRs.Select the 'Attachment Description' from the 
dropdown and attach the supporting scanned documents in PDF/Excel/
CSV format, Read and tick on the declaration and click 'Continue' to 
proceed further.
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Note:

• Maximum of 10 attachments can be submitted in a single response 
submission and any number of submissions can be made in response 
to a single notice/intimation/order. Maximum size for each attachment 
should not exceed 10 MB. • If number of document exceeds ten in 
number, kindly prefer multiple submission in response to the notice by 
choosing the response type as "Partial Response". In case of multiple 
partial response is made, while submitting the last of the partial 
response, the response type be chosen as "Full response" so as to 
indicate that you have nothing further more to submit in response to the 
notice. • The File name of the attachment should not contain any special 
characters other than – (hyphen) or _ (underscore). • In case, the notice 
is related to Sec 142(1) [Calling of return]/148/153A/153C, upon click of 
submit, the assessee shall be re-directed to 'e-File->Income Tax Return' 
page, where he/she can upload the Income Tax Return. 

Step 8
The Submission can be e-Verified using Electronic Verification Code 
(EVC) / Aadhaar OTP / Digital Signature Certificate (DSC) if applicable.

Step 9
A success message will be displayed confirming the 
submission of response.

6.17.10.	 steps to sign an authorized representative for responding to an  
	 e-proceeding.

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

Step 2
Post login, click on the 'e-Proceeding' menu and click 
'e-Proceedings' link.

Step 3
A new page will appear showing the details of the notices (if available) 
such as PAN, Assessment year, Proceeding Name, Proceeding Status, 
Proceeding Limitation Date, Proceeding Closure Date and Action.

Step 4
Click on 'Add/View Authorized Representative [AR]' hyperlink available 
under the Action column.

Step 5

Select the 'Authorized Representative Type' from the dropdown. 
An Authorized representative can be a
Chartered Accountant | Related Person | Employee | Officer of a 
Scheduled Bank | Any Legal Practitioner | Person who has passed 
Recognized Accountancy Examination | Person with prescribed 
Education qualification | Income-tax Practitioner or others qualified 
practitioner as per section 288

Step 6

If the representative is a Chartered Accountant, then enter the 
'Membership Number' and for other representative types enter the 
'PAN'. All the other fields such as Name, Mobile and e-mail will be auto 
populated (masked). Click the 'Add Authorized Representative' button. 
A dialogue box with registered mobile number and email ID will be 
displayed to the user. Click 'Confirm' button to receive the OTP in the 
registered mobile number and email ID. 

Step 7
• A six digit OTP will be sent to your registered mobile number and 
registered email ID. • Enter the six digit OTP --> Click 'Validate' to 
complete the request submission. 

Step 8 A Success message will be displayed confirming the request submission.

Note:
After submitting, an alert message will be sent to the Authorized 
Representative's e-mail ID and mobile number intimating that a request 
has been raised. 



CPC HANDBOOK NOV 2020 57

6.17.11. steps for the authorized representative to accept or reject the request.

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

Step 2 Go to 'Worklist' tab --> Click 'For Your Action' hyperlink.

Step 3 Click 'e-Proceeding Worklist'.

Step 4
Click on the 'Accept/Reject' hyperlink available under the 
Action column.

Step 5

To Accept the request:Click on 'Accept' and Attach the PDF copy of 
notarized Power of Attorney (POA) received from the assessee, Read 
and click on the declaration on accepting the request and click on 
Accept button. e-Verifying the acceptance through EVC or 
DSC is mandatory. 

Step 6 To Reject the request:Click on the 'Reject' and Enter the 'Remarks'. 

Note
The Authorized Representative should either accept or reject the 
request within 7 days from the date of raising the request.

6.17.12. 	steps for the authorized representative to view and respond 
	 to an e-proceeding

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

Step 2 Post login, click on the 'e-Proceeding' menu and click 'e-Proceedings' link.

Step 3

Details of Proceedings related to Other PAN/TAN such as PAN/TAN, 
Name of the Assessee, Assessment Year/Financial Year, Proceeding 
Name, Proceeding Status, Proceeding limitation date and Authorized 
Representative status are displayed to the user.

Step 4
Click on the 'Proceeding Name' hyperlink of the appropriate proceeding 
to view notice details.

Step 5
Additional details such as Notice/Communication reference ID, Notice 
u/s, Description, Issued On, Document Id, Served On, Response Due date 
and Response are displayed. 

Step 6
To view the details of the notice, click on the 'Notice/Communication 
reference ID' link and to submit your response against that particular 
notice, click on the 'Submit' link under the 'Response' column. 

Step 7

Upon clicking on submit, a new page is opened where the Proceeding 
Name, Document Reference Id and Notice Section are pre-filled. 
Select the 'Response Type' from the dropdown (Partial Response/Full 
Response). Enter the 'Response/Remarks' in text box not exceeding 
4000 characteRs.Select the 'Attachment Description' from the dropdown 
and attach the supporting scanned documents in PDF/Excel/CSV format, 
Read and tick on the declaration and click 'Continue' to proceed further.

Note:

• Maximum of 10 attachments can be submitted in a single response 
submission and any number of submissions can be made in response to a 
single notice/intimation/order. Maximum size for each attachment should not 
exceed 10 MB.• If number of document exceeds ten in number, kindly prefer 
multiple submission in response to the notice by choosing the response type 
as "Partial Response". In case of multiple partial response is made, while 
submitting the last of the partial response, the response type be chosen 
as "Full response" so as to indicate that you have nothing further more to 
submit in response to the notice. • The File name of the attachment should 
not contain any special characters other than – (hyphen) or _ (underscore). • 
In case, the notice is related to Sec 142(1) [Calling of return]/148/153A/153C, 
upon click of submit, the assessee shall be re-directed to 'e-File->Income Tax 
Return' page, where he/she can upload the Income Tax Return. 
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Step 8
The Submission can be e-Verified using Electronic Verification Code 
(EVC) / Aadhaar OTP / Digital Signature Certificate (DSC) if applicable.

Step 9
A success message will be displayed confirming the 
submission of response.

6.17.13.	 Steps to view the response submitted by self and authorized representative  
	 to an e-proceeding.

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

Step 2 Post login, click on the 'e-Proceeding' menu and click 'e-Proceedings' link.

Step 3
Details of Proceedings related to self and details of proceedings related 
to other PAN/TAN will be displayed separately.

Step 4
Click on the 'Proceeding Name' hyperlink of the appropriate proceeding 
to view notice details.

Step 5
Click on the 'View' link under the 'Response' column to view the details 
of the response submitted. 

6.17.14. 	Arrear Demand Responses

Step 1:	 Response from taxpayer to outstanding demand displayed on e-filing portal

	 •	 The response from taxpayers to outstanding demand on the e-filing  
		  portal is inwarded by CPC on daily basis and information is updated in  
		  the CPC FAS accordingly.

	 •	 This response is used for making any Refund Order adjustment at CPC  
		  either for CPC processed ITRs u/s. 143(1) or 154 or ITBA initiated cases  
		  u/s. 143(1), 143(3), 144, 154 (giving effect), etc., and manual orders  
		  uploaded by the AO.

	 •	 In all cases where taxpayer disagrees to a demand, such response  
		  is updated in the AO Portal and in cases where intimation u/s.245 is  
		  issued to taxpayer and such disagreed response is in response to such  
		  notice, a communication is sent to jurisdictional AO to confirm the demand.

	 •	 As refund is held up for process u/s. 245, AO is required to respond to  
		  such disagreement within 30 days from the date of communication by  
		  email. If no response is received from AO, the refund is released with  
		  adjustment of the demand for such AY.

	 •	 A reminder is also issued by CPC to AO, seeking a response to cases  
		  awaiting completion of section 245 process.

	 •	 A call is also made to AO seeking response to refund cases awaiting  
		  completion of section 245 process in cases where substantial refund or  
		  demand is involved and all such calls are recorded.

6.17.14.1.	The taxpayer can submit the response online to the outstanding demand  
	 by either choosing to Agree or Disagree with the demand.
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6.17.14.2.	 Perform the following steps for Responding to the Outstanding Demand. 

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

Step 2
Go to the 'e-File' menu located at upper-left side of the page ⇒ Click 
'Response to Outstanding Demand' 

Step 3
Click the hyperlink Submit located under Response column (To respond 
for the Outstanding Demand) 

Step 4

Choose any one of the listed responses  • Demand is correct 
• Demand is partially correct • Disagree with the Demand
• Demand is not correct but agree for adjustment 

• On choosing 'Demand is correct', click on 'Submit' button to 'Confirm' 
and complete the response submission process.

Note:

•  If you confirm 'Demand is correct' then you cannot disagree with the 
demand again.

•   If any refund is due, the refund will be adjusted against the 
outstanding demand.

•  The taxpayer can pay the demand by clicking the link under 
'Pay Tax' option.

•  On choosing 'Demand is partially correct', Enter the 'Amount which 
is correct' and the 'Amount which is incorrect' will be auto filled. 
Select the appropriate reason(s) from the list and fill all the applicable 
fields, upload the necessary supporting documents and 'Submit' the 
response. 

•  On choosing 'Disagree with demand', Select the appropriate reason(s) 
from the list and fill all the applicable fields, upload the necessary 
supporting documents and 'Submit' the response. 

•  On choosing 'Demand is not correct but agree for adjustment', Select 
the appropriate reason(s) from the list and fill all the applicable 
fields, upload the necessary supporting documents and 'Submit' the 
response. 

    Click Here for the list of reasons and the additional details required on 
selecting each reasons. 

Step 5
    A success message along with Transaction ID is displayed on 

successful submission of the response. 

Note

•  To View the submitted response go to ‘e-File’ ⇒ ‘Response to 
Outstanding Demand’ and click on the ‘View’ link under the ‘Response’ 
column and in the new page click on the ‘Transaction Id’ hyperlink.

•   For the demand which is shown to be uploaded by AO, then the 
rectification right is with Assessing Officer and for the demand 
against which there is no 'Submit' response available is already 
confirmed by the Assessing Officer. Kindly contact your jurisdictional 
Assessing Officer for clarification. 
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6.17.15.	ITDREIN

6.17.15.1.	 Income Tax Department Reporting Entity Identification Number (ITDREIN)  
		  is the Unique ID issued by ITD, which will be communicated by ITD after  
		  the registration of the reporting entity with ITD. The ITDREIN is a 16-char 
		  acter identification number in the format XXXXXXXXXX.YZNNN where 

ITDREIN component Description

XXXXXXXXXX PAN or TAN of the reporting entity 

Y Code of Form Code

Z Code of Reporting Entity Category for the Form Code

NNN Code of sequence number.

6.17.15.2. The following table provides the services available for ITDREIN Users.

Sl. No. Services

1 Upload and View Form 15CC

2 Upload and View Form V

6.17.16. Generate ITDREIN to upload Form 15CC and Form V

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

Step 2
Go to the 'My Account' located at upper-left side of the page ⇒ Click 
'Manage ITDREIN' 

Step 3
Click 'Generate New ITDREIN' ⇒ Select the 'Form Type*' and 'Re-
porting Entity Category*' from the drop down list ⇒ Click 
'Generate ITDREIN'

Step 4
After successful generation of ITDREIN, user receives a confirmation 
e-mail on their registered Email ID. In addition, SMS will be sent to 
their registered Mobile number. 

Note: 

With effect from April 9, 2018, registration and statement upload fa-
cilities for Form 61, Form 61A and Form 61B have been moved to the 
reporting portal under Project Insight. Kindly go to 'My Account' ⇒ 
'Reporting Portal'

6.17.17. REQUESTS TO RESEND ORDERS/INTIMATIONS

	 After the Income Tax Return is processed by CPC, taxpayer receives an Inti 
	 mation at their registered email ID. If the taxpayers request to resend the  
	 Intimation, perform the following steps. 

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

Step 2

Go to the 'My Account' menu located at upper-left side of the page 
⇒ Click 'Service Request' ⇒ Select the 'Request Type' as 'New Re-
quest' and Select the 'Request Category' as 
'Intimation u/s 143(1)154/16(1)/35' ⇒ Click 'Submit' 

Step 3

Enter the following details: 

• Return Type

• Assessment Year

• Category (Intimation u/s 143(1))
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Step 4 Click 'Submit' 

Step 5 To View the status of submitted form.

Note:
From AY 2017-18 onwards, the Intimation PDFs can be downloaded 
from My Account --> View e-Filed Returns/Forms. 

6.17.18.	Request for Refund Reissue

	 Refund shall be issued to the Pre-validated bank account only. In case of  
	 refund failure, taxpayer can raise the service request in e-filing portal upon  
	 receiving communication from CPC. 

6.17.18.1.	 Perform the following steps to raise Refund Re-issue Request:

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

Step 2 Click on 'My Account' menu and click 'Service Request' link. 

Step 3
Select the 'Request Type' as 'New Request' and Select the 'Request 
Category' as 'Refund Reissue'. Click 'Submit'.

Step 4
Details such as PAN, Return Type, Assessment Year (A.Y), Acknowl-
edgement No, Communication Reference Number, Reason for Re-
fund Failure and Response are displayed. 

Step 5
Click 'Submit' hyperlink located under 'Response' column. All the 
Pre-validated bank accounts with status validated/validated and EVC 
enabled will be displayed. 

Step 6

Select the bank account to which the tax refund is to be credit-
ed and click 'Continue'. Details such as Bank Account Number, 
IFSC, Bank Name and Account Type are displayed for the taxpay-
er to cross verify the same. Note : If the taxpayer does not have 
any Pre-validated bank accounts, then the taxpayer is directed to 
Pre-validate bank account Screen. In this screen the tax payer should 
enter all relevant details of the bank account where he intends re-
ceive refund and click on 'Pre-validate' button to proceed with the 
request submission. After this Account is Pre-validated by the con-
cerned bank, the bank account will be automatically considered for 
refund re-issue. This account will now be displayed under Pre-vali-
dated bank accounts in the e-filing portal.In case the Pre-validation 
of account fails, then the same will be communicated to the taxpayer 
by CPC. The taxpayer is required to resubmit the request for refund 
re-issue/Pre-validation of bank account. 

Step 7

Click 'OK' in popup if the details are correct and the options for 
e-Verification appears in the dialogue box. Choose the appropriate 
mode of e-Verification, Generate and enter Electronic Verification 
Code (EVC)/Aadhaar OTP as applicable to proceed with the request 
submission.

Note
If Digital Signature Certificate (DSC) is registered in the profile, gen-
erate the signature file by downloading the 'DSC Management Utility' 
and upload the same to proceed with the submission.

Step 8
A success message will be displayed confirming the Refund Re-issue 
request submission.

Step 9
To View the status of submitted Refund Re-issue, 
Click here to know more 
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6.17.19.	Certificate of Appreciation

	 From AY 2016-17, ITD has started issuing certificate of appreciation for eligible  
	 taxpayers who have cleared their entire liability, have no outstanding tax  
	 liabilities and had filed their returns electronically in the prescribed time. 

6.17.19.1.	 Perform the following steps to view the certificate of appreciation 

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

PAN or TAN of the reporting entity 

Step 2
Go to the 'My Account' menu located at upper-left side of the 
page -> Click 'Certificate of Appreciation' 

Step 3

If taxpayer wants to request to resend the certificate of appreciation, 
perform the following steps. 

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

Step 2

Go to the 'My Account' menu located at upper-left side of the 
page ⇒ Click 'Service Request' ⇒ Select the 'Request Type' 
as 'New Request' and Select the 'Request Category' 
as 'Certificate of Appreciation' ⇒ Click 'Submit' 

Step 3
Select Assessment Year from the dropdown list ⇒ Click 
Submit

6.17.20.		 Service Request- Change ITR Form Particulars

		  After upload of the ITR, if any change occurs in taxpayers Bank Account,  
		  Address, Mobile number and e-mail id, then taxpayer can update these  
		  changes through ‘Change ITR Form Particulars’. Any update can be made  
		  only prior to processing of the return.

6.17.20.1.	 Perform the following steps to change the particulars in the submitted 
		  ITR Form:

Step 1 Logon to the 'e-filing' Portal www.incometaxindiaefiling.gov.in

Step 2

Go to the 'My Account' menu located at upper-left side of the page ⇒ 
Click 'Service Request' ⇒ Select the 'Request Type' as 'New Request' and 
Select the 'Request Category' as 'Change ITR Form Particulars' ⇒ Click 
'Submit' 

Step 3
Enter 'Acknowledgement number' of ITR and provide the necessary 
details ⇒ Click 'Submit' 

Step 4

To View the status of submitted form, Click here to know more 

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

Step 2

Go to the 'My Account' menu located at upper-left side of the 
page ⇒ Click 'Service Request' ⇒ Select the 'Request Type' as 
'View Request' and Select the 'Request Category' as 'Change 
ITR Form Particulars' 

Step 3 Click 'Submit' 

Step 4 Click the 'Transaction ID’

6.17.21.	Permanent Account Number (PAN) is a ten-digit alphanumeric number, issued  
	 in the form of a laminated card, by the Income Tax Department, to any  
	 “person” who applies for it or to whom the department allots the number  
	 without an application.
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6.17.22.		 Aadhaar is a 12-digit unique identity number that can be obtained by residents  
		  of India, based on their biometric and demographic data. It is issued by the  
		  Unique Identification Authority of India (UIDAI).

6.17.22.1.	 Linking Aadhaar with PAN is Mandatory for filing the Income Tax Returns.  
		  On Linking the Aadhaar with PAN, the Taxpayers can also generate Aadhaar  
		  OTP to e-Verify their Income Tax Returns and Forms. e-filing portal  
		  facilitates the taxpayers to link their Aadhaar with PAN by following the  
		  below steps.

6.17.23.		 e-Proceeding - Plan for Paperless Proceeding

6.17.23.1.	 e-Proceedings is an electronic platform for conducting proceedings in an  
		  end-to-end manner. It is introduced by the Income tax department, to  
		  bring about transparency and efficiency in the income tax related  
		  proceedings.All the notices/intimations/letters from the department are  
		  made available under e-Proceedings where the assesse would be able to  
		  view and submit the response along with attachments by uploading the  
		  same on e-Filing portal.

6.17.23.2.	 Who can respond to an e-Proceeding?

		  The Assessee who received the notices/intimations/letters from the  
		  department can respond to the e-Proceeding on their own in the e-Filing  
		  portal by following few simple steps.
		  Or
		  The Assessee can assign an authorized representative in the e-Filing portal  
		  to respond to the notices/intimations on their behalf. 

6.17.23.3.	 Steps to view and respond to an e-Proceeding by self.

Step 1 Logon to 'e-Filing' Portal www.incometaxindiaefiling.gov.in 

Step 2 Post login, click on the 'e-Proceeding' menu and click 'e-Proceedings' link.

Step 3
Details of Proceedings related to Self, such as PAN, Assessment year, 
Proceeding Name, Proceeding Status, Proceeding Limitation Date, 
Proceeding Closure Date and Action.

Step 4
Click on the 'Proceeding Name' hyperlink of the appropriate proceeding 
to view notice details.

Step 5
Additional details such as Notice/Communication reference ID, Notice 
u/s, Description, Issued On, Document Id, Served On, Response Due date 
and Response are displayed.

Step 6
To view the details of the notice, click on the 'Notice/Communication 
reference ID' link and to submit your response against that particular 
notice, click on the 'Submit' link under the 'Response' column.

Step 7

Upon clicking on submit, a new page is opened where the Proceeding 
Name, Document Reference Id and Notice Section are pre-filled. Select the 
'Response Type' from the dropdown (Partial Response/Full Response). 
Enter the 'Response/Remarks' in text box not exceeding 4000 characteRs.
Select the 'Attachment Description' from the dropdown and attach the 
supporting scanned documents in PDF/Excel/CSV format, Read and tick 
on the declaration and click 'Continue' to proceed further.
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Note:

• Maximum of 10 attachments can be submitted in a single response 
submission and any number of submissions can be made in response to a 
single notice/intimation/order. Maximum size for each attachment should 
not exceed 10 MB. • If number of document exceeds ten in number, kindly 
prefer multiple submission in response to the notice by choosing the 
response type as "Partial Response". In case of multiple partial response 
is made, while submitting the last of the partial response, the response 
type be chosen as "Full response" so as to indicate that you have nothing 
further more to submit in response to the notice. • The File name of 
the attachment should not contain any special characters other than – 
(hyphen) or _ (underscore).

• In case, the notice is related to Sec 142(1) [Calling of return]/148/153A/153C, 
upon click of submit, the assesse shall be re-directed to ‘e-File->Income 
Tax Return’ page, where he/she can upload the Income Tax Return.

Step 8
The Submission can be e-Verified using Electronic Verification Code 
(EVC) / Aadhaar OTP / Digital Signature Certificate (DSC) if applicable.

Step 9
A success message will be displayed confirming the 
submission of response.

6.17.23.4.	Steps to Assign an Authorized Representative for responding 
		  to an e-Proceeding.

Step 1 Logon to 'e-Filing' Portal www.incometaxindiaefiling.gov.in 

Step 2
Post login, click on the 'e-Proceeding' menu and click 
'e-Proceedings' link.

Step 3
A new page will appear showing the details of the notices (if available) 
such as PAN, Assessment year, Proceeding Name, Proceeding Status, 
Proceeding Limitation Date, Proceeding Closure Date and Action.

Step 4
Click on 'Add/View Authorized Representative [AR]' hyperlink available 
under the Action column.

Step 5

Select the 'Authorized Representative Type' from the dropdown. 
An Authorized representative can be a
• Chartered Accountant
• Related Person
• Employee
• Officer of a Scheduled Bank
• Any Legal Practitioner
• Person who has passed Recognized Accountancy Examination
• Person with prescribed Education qualification
• Income-tax Practitioner or others qualified practitioner 
as per section 288

Step 6

If the representative is a Chartered Accountant, then enter the 'Membership 
Number' and for other representative types enter the 'PAN'. All the other 
fields such as Name, Mobile and e-mail will be auto populated (masked). 
Click the 'Add Authorized Representative' button. A dialogue box with 
registered mobile number and email ID will be displayed to the user. Click 
'Confirm' button to receive the OTP in the registered mobile number 
and email ID. 

Step 7

• A six digit OTP will be sent to your registered mobile number and 
registered email ID.
• Enter the six digit OTP --> Click 'Validate' to complete the 
request submission. 
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Step 8 A Success message will be displayed confirming the request submission.

Note:
After submitting, an alert message will be sent to the Authorized 
Representative's e-mail ID and mobile number intimating that a request 
has been raised. 

 
6.17.23.5.  Steps for the Authorized Representative to Accept or Reject the request.

Step 1 Logon to 'e-Filing' Portal www.incometaxindiaefiling.gov.in 
Step 2 Go to 'Worklist' tab --> Click 'For Your Action' hyperlink.
Step 3 Click 'e-Proceeding Worklist'.

Step 4
Click on the 'Accept/Reject' hyperlink available under 
the Action column.

Step 5

To Accept the request:
Click on ‘Accept’ and Attach the PDF copy of notarized Power of 
Attorney (POA) received from the assessee, Read and click on the 
declaration on accepting the request and click on Accept button. 
e-Verifying the acceptance through EVC or DSC is mandatory. 

Step 6 To Reject the request:
 Click on the ‘Reject’ and Enter the ‘Remarks’.

Note
The Authorized Representative should either accept or reject the 
request within 7 days from the date of raising the request.

6.17.23.6. 	Steps for the Authorized Representative to view and respond 
		  to an e-Proceeding

Step 1 Logon to 'e-Filing' Portal www.incometaxindiaefiling.gov.in 

Step 2
Post login, click on the 'e-Proceeding' menu and click 
'e-Proceedings' link.

Step 3

Details of Proceedings related to Other PAN/TAN such as PAN/TAN, 
Name of the Assessee, Assessment Year/Financial Year, Proceeding 
Name, Proceeding Status, Proceeding limitation date and Authorized 
Representative status are displayed to the user.

Step 4
Click on the 'Proceeding Name' hyperlink of the appropriate proceeding 
to view notice details.

Step 5
Additional details such as Notice/Communication reference ID, Notice 
u/s, Description, Issued On, Document Id, Served On, Response Due date 
and Response are displayed. 

Step 6
To view the details of the notice, click on the 'Notice/Communication 
reference ID' link and to submit your response against that particular 
notice, click on the 'Submit' link under the 'Response' column. 
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Step 7

Upon clicking on submit, a new page is opened where the Proceeding 
Name, Document Reference Id and Notice Section are pre-filled. Select 
the 'Response Type' from the dropdown (Partial Response/Full Response). 
Enter the 'Response/Remarks' in text box not exceeding 4000 characteRs.
Select the 'Attachment Description' from the dropdown and attach the 
supporting scanned documents in PDF/Excel/CSV format, Read and tick on 
the declaration and click 'Continue' to proceed further.

Note:
 

• Maximum of 10 attachments can be submitted in a single response 
submission and any number of submissions can be made in response 
to a single notice/intimation/order. Maximum size for each attachment 
should not exceed 10 MB.
• If number of document exceeds ten in number, kindly prefer multiple 
submission in response to the notice by choosing the response type as 
"Partial Response". In case of multiple partial response is made, while 
submitting the last of the partial response, the response type be chosen 
as "Full response" so as to indicate that you have nothing further more 
to submit in response to the notice.
• The File name of the attachment should not contain any special 
characters other than – (hyphen) or _ (underscore).
• In case, the notice is related to Sec 142(1) [Calling of 
return]/148/153A/153C, upon click of submit, the assesse shall be re-
directed to ‘e-File->Income Tax Return’ page, where he/she can upload 
the Income Tax Return.

Step 8
The Submission can be e-Verified using Electronic Verification Code 
(EVC) / Aadhaar OTP / Digital Signature Certificate (DSC) if applicable.

Step 9
A success message will be displayed confirming the 
submission of response.

6.17.23.7.	 Steps to view the response submitted by self and Authorized  
		  Representative to an e-Proceeding.

Step 1 Logon to 'e-Filing' Portal www.incometaxindiaefiling.gov.in 

Step 2
Post login, click on the 'e-Proceeding' menu and click 
'e-Proceedings' link.

Step 3
Details of Proceedings related to self and details of proceedings related 
to other PAN/TAN will be displayed separately.

Step 4
Click on the 'Proceeding Name' hyperlink of the appropriate proceeding 
to view notice details.

Step 5
Click on the 'View' link under the 'Response' column to view the details 
of the response submitted. 

6.17.23.8.  Best Practices for Scanning the Supporting Documents .

	 Scan Settings
	 •	 Set the Scan Clarity to at least 300 DPI.
	 •	 Choose the format of saving the document as PDF and name the  
		  document appropriately. 
	 •	 Scan the document in Black and White only. 
	 •	 Please ensure that the document is not password protected. 
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	 Scanning Source Documents
	 •	 Scan only the original document
	 •	 Ensure that the document size is A4 or letter size only.
	 •	 If there are multiple pages, kindly scan all the pages into a single file and  
		  ensure that the final size of the PDF does not exceed more than 10 MB.

	 To avoid poor quality
	 •	 Please ensure the original Document that is being scanned is clear and 
		  not faded.
	 •	 If the documents are handwritten, please ensure that it is clear and legible 
	 •	 Please ensure documents are Free from ink bleeding or smudging. 

6.18.	 FAQs of Inwarding of Information from e-filing

6.18.1.	 What types forms will be in warded from e-filing to CPC?

Ans:	 E- returns and statutory forms will be in warded from e-filing to CPC 
	 on daily basis.

6.18.2.	Is any other form(s) inwarded from e-filing to CPC?

Ans:	 Apart from e-returns and statutory forms, e-filing forwards the following  
	 forms to CPC:

	 a)	Rectification applications filed by taxpayers.

	 b)	Responses to Defective returns from taxpayers, provided by them 
		  in e-proceedings module.

	 c)	Responses to Notice u/s. 143(1)(a) (Prima Facie Adjustment), provided 
		  by them in e-proceedings module.

	 d)	Responses to Outstanding demand, either in response to Intimation  
		  u/s.245 or voluntarily.

	 e)	e-Nivaran grievances filed on the e-filing website.

	 f)	 Refund reissue requests.

	 g)	Forms filed by taxpayers that are used to processing of ITR.

	 h)	Changes to profile like mobile no., email ID, etc.

6.18.3.	What is the in-warding procedure for Original and revised return from 
	 e-filing to CPC? 

Ans:	 If a revised ITR is filed, such ITR is also in warded to CPC from e-filing 
	 on daily basis.

	 a)	 If the original ITR is not yet taken for processing, the corresponding original  
		  ITR is marked as closed, however the date of filing is considered for  
		  treatment of revised ITR.

	 b)	If the original ITR is taken for processing and is in progress, such ITR is  
		  removed from the processing queue and revised ITR is taken for processing  
		  and consideration is given to date of filing of original ITR.

	 c)	 If the original ITR is already processed and intimation is issued, then the  
		  revised ITR is taken for processing by reversing the tax credit information  
		  used in computation for the original ITR.

	 d)	If the refund that is arising out of processing of original ITR is in progress,  
		  revised ITR is considered for processing only after such refund is either  
		  paid or unpaid.
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CHAPTER 7

PROCESSING 
OF RETURNS

7.1.	 Returns e-filed by the tax payers through e-filing website will be stored in the  
	 e-filing database.  All returns which are successfully e-verified will be directly  
	 taken up for processing at CPC. If the taxpayers opt to send the ITR-V for  
	 verification of ITR, the verification is complete only after such ITR-V is received  
	 and validated at CPC. The validated returns are loaded to CPC database once  
	 TB table details are inwarded from e-filing database. Post validation of ITR, if  
	 such ITR is required to be transferred to AO due to CASS or any other reason,  
	 the ITR is transferred to AO for initiation in ITBA. A communication is sent  
	 to taxpayer in such cases informing about the transfer of ITR to Jurisdictional  
	 AO. ITRs remaining with CPC after checking for transfer to AO are taken for  
	 processing at CPC. There is change to system and in next version of handbook,  
	 the process adopted in IEC 2.0 will be provided.

7.2.	 Flow chart of the Processing of ITR at CPC for CPC Processed ITRs:
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7.3. 	 The Processing of ITR involves the following processes (as automated run)  
	 that are listed below (explanation of each process is provided after the list): 

1 Ready for processing (after verification of ITR)

2 Initiation for processing

3 Defective return check and process

4 Aggregate tax liability calculation by application of Income Tax Act/Rules

5 Tax credit matching process

6 AST consumption marking for OLTAS challans

7 Prima Facie Adjustment u/s.143(1) (AY2017-18 onwards)

8 Matching failed cases reconciliation with TRACES

9 Demand/Refund approval process (statutory requirement)

10 Refund Cases check for demands outstanding yet to be inwarded to CPC

11 Tax on Regular Assessment –Minor Code 400 challan - consumption 

12 Processing completed-ready for accounting

13 Accounting process completed 

14 Fraudulent TAN/PAN process

15 Corrected Return u/s.139(9) Process

16 Transfer of ITR to AO

17 Unprocessed and closed ITRs (in case of multiple ITR for an AY)

18 Abandon in progress, Completed  for reprocessing of ITR

19 Abort and close of ITR for loading of revised ITR or reprocessing of ITR

7.4.	 Step by Step Process explanation:

	 Step 1:	Loading of ITRs for processing:

	 1.	 ITRs that are ready for processing are loaded upon authorization using 
		  a load management screen. 
	 2.	There is facility to hold the ITRs at particular stage of processing, that 
		  is required during the initial testing of ITRs.This facility is used to manage  
		  the quality control checks and other risk related checks. Similar feature 
		  is provided in IEC 2.0.

	 Step 2:	Initiation for processing
	
	 1.	 ITRs after loading undergo validation checks on the information in the ITR,  
		  in automated manner using business rules.
	 2.	Data input error cases do not continue further processing, these cases are  
		  examined and fixed by the further movement. Ex. Data input error: No. of  
		  characters in a field exceeding a given no., special character in the data 
		  in the field along with number or alphabets due to incorrect utility used 
		  by taxpayer.



CPC HANDBOOK NOV 202070

	 Step 3:	 Defective return check and process

	 1.	 All ITRs successful at the validation check point are taken for check 
		  on defects in the ITR within the scope of Section 139(9). Business rules are  
		  framed in this regard at Form Type level and Assessment Year wise and  
		  all ITRs are checked at this stage. ITRs passing this stage are taken for next  
		  level of processing. ITRs with defects are halted from moving to next stage  
		  at this stage for curing of defect by taxpayers.

	 2.	Notice is issued u/s.139(9) to taxpayer by an email, informing the defect  
		  noticed in the ITR along with a probable resolution for curing the defect.  
		  The taxpayer can choose to either file a corrected ITR or give a written  
		  response on the defect on the e-filing portal.

		  I.	 If corrected ITR is filed, it will be again taken for processing as fresh ITR  
			   after terminating the processing of the defective ITR. Corrected ITR will  
			   replace the defective ITR.

		  II.	 If a written response is provided, the response is examined by the ITD  
			   Officers and based on direction of Officers, the response of the taxpayer  
			   is either rejected or accepted. If the response is accepted ITR will 
			   be moved for further processing. If response is rejected, the taxpayer 
			   is intimated about the rejection with reason for rejection and further  
			   time is provided for correcting the defect.  

		  III.	 15 days’ time is given for curing defect as per section 139(9) of the Act,  
			   by an email and written communication. If no response or corrected  
			   ITR is received within the said time a reminder is issued to taxpayer to   
			   cure the defect giving another 15 days’ time by an email. If still there 
			   is no response, a second reminder is issued giving another 15 days’  
			   time by an email (Note. Only if there is sufficient time to process the  
			   ITR, if time is insufficient the reminders are restricted and timeline is  
			   changed appropriately).

		  IV.	 If no response is received from taxpayer, the ITR is invalidated and  
			   a communication to this effect is sent to taxpayer by an email as well as  
			   printed communication by speed post.  

	 Step 4: Aggregate tax liability calculation process

		  1.	 All ITRs passing through defective rules check as mentioned above, are  
			   taken for tax computation process where the income is recomputed by  
			   application of the business rules, losses claimed, MAT Credit, deductions  
			   claims are verified based on the recomputed income. The Total Income  
			   is determined by the system and tax computation on total income 
			   is completed. 

		  2.	 This is controlled by automated jobs and do not require 
			   manual intervention.

	 Step 5: Tax credit matching process

		  1.	 The claim of tax credit by way of TDS, TCS and OLTAS payments made 
			   in the ITR are verified with information received from the OLTAS and  
			   TRACES systems that are available in CPC FAS.

		  2.	 The ITRs where the claim in ITR for OLTAS challans matches fully with  
			   the information from OLTAS system are moved for further processing.
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		  3.	 The ITRs where the claim in ITR for TDS/TCS credit matches fully with  
			   the information from TRACES system as available in CPC FAS are moved  
			   for further processing.

		  4.	 If there is any mismatch of tax credit, the ITR is moved to an exception  
			   queue for verification with respective systems. 

		  5.	 This is controlled by automated jobs and do not require 
			   manual intervention.

	 Step 6: AST/ITBA consumption marking for OLTAS challans

		  1.	 The Challan consumed by CPC for processing of ITR that are matched  
			   are marked in a common table between ITBA/AST and CPC 
			   as ‘consumed’ by marking a flag in this regard. This is to block using of  
			   challan for any other processing in ITBA/AST in case any paper return  
			   is also filed. 

		  2.	 This is controlled by automated jobs and do not require 
			   manual intervention.

	 Step 7:	 	 Prima Facie Adjustment u/s.143(1) (AY2017-18 onwards) 
	 	 	 	 	 (Adjustments u/s. 143(1)(a)(i) to (vi) for AY17-18 & 143(1)(a)(i)  
	 	 	 	 	 to (v) for AY 18-19, 19-20)

		  1.	 After determination of tax liability and interest, the following  
			   comparisons with the information in ITR vis a vis information in Form  
			   3CD/CE, etc., Form 26AS, are made for AY2017-18:

			   i.	 Arithmetical errors if any noticed in schedule within the ITR.

			   ii.	 Inconsistent information within the ITR (from one schedule to 
				    another schedule).

			   iii.	Information in Schedule CFL where date of filing of ITR for brought  
				    forward loss is claimed is verified with actual date of filing with  
				    information in CPC or ITBA (wherever ITR is filed for that period)

			   iv.	Information of claim for deductions as per Part C of Chapter VIA are  
				    compared between respective schedule and summary of deductions.

			   v.	  Information provided in Form 3CD/CE, etc., to verify if expenditure  
				    disallowed as per Audit is also disallowed in ITR, if not, adjustment  
				    will be proposed taking higher of two values.

			   vi.	Information of gross receipts/income in Form 26AS is compared with  
				    income/gross receipts offered in ITR for taxation.

		  2.	 For AY 2018-19 onwards, the provisions of section 143(1)(a)(i) to (v) 
			   will apply.

		  3.	 If any variance is noticed, a notice u/s. 143(1) is issued to taxpayer giving  
			   details of variance and also publishing the same in e-proceedings  
			   module of e-filing, giving an option to taxpayer to revise the ITR or  
			   provide response.

			   I.	 If revised ITR is filed, same is taken for processing as if a fresh ITR.

			   II.	If response is provided, same is examined and either accepted 
				    or rejected.
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				    a)	 If accepted, ITR is processed without proposed adjustment.

				    b)	If rejected, a notice of rejection is sent to taxpayer to file revised  
					     ITR giving an additional time frame of 30 days’. 

		  4.	 If no response or revised ITR is received with given time ITR is processed  
			   by making proposed additions.

	 Step 8: Matching failed cases reconciliation with TRACES and OLTAS

		  1.	 During the matching process if there is a mismatch between Tax  
			   payments claimed in Income Tax Return and credits available in the  
			   CPC FAS (as explained in Step 5), records are held in exception queue.  
			   The mismatch would be as follows:

			   a)	The Tax credit claimed in ITR is greater than the collections available  
				    in CPC FAS Accounting system

		  2.	 Below internal checks are done for reconciliation / confirmation of 
			   the mismatch: - 

			   a)	Whether inwarding is pending from CPC-TDS. 

			   b)	Whether any receipts / challans files are errored out while inwarding  
				    from CPC TDS / OLTAS to ETL staging.

			   c)	Whether receipts / challans files are inwarded to CPC FAS Staging.

			   d)	Whether receipts / challans files are errored out while posting 
			   to CPC FAS Staging.

		  3.	 If the claim of TDS/TCS is against an invalid TAN, ITR is taken for 
			   further processing.

		  4.	 Mismatch details at a PAN level is shared to CPC-TDS on daily basis  
			   for confirmation about the availability of additional credit for the PAN/ 
			   TAN AY in TRACES. If credits are available, same is re-pushed and  
			   re-matching of mismatch records is initiated every 3 days. Once  
			   confirmation and additional receipts feed is received, record will go for  
			   re-matching post inwarding of pending receipts / challans and full  
			   credit is allowed and ITR is further processed. 

		  5.	 In case, such additional credits are not available in TRACES, the ITR is  
			   processed with mismatch. After completion of processing, details of  
			   mismatch are shared as an annexure along with intimation, to help  
			   taxpayer know the exact reason for mismatch and use the information  
			   for rectification.

		  6.	 In case of OLTAS challan mismatch, internal check is done to verify 
			   if there are any errors in inwarding. If there are errors, same is cleared  
			   and matching is completed. If no error in inwarding is found, ITR 
			   is processed with mismatch. A mismatch report giving details of  
			   mismatch is provided as an annexure to the intimation.

	 Step 9: Demand/Refund approval process

		  1.	 Post processing of ITR and completion of aforesaid steps, all ITR are  
			   checked post processing check, to examine the business rule application  
			   and for moving the cases for refund/demand approval as per the  
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			   instructions in this regard. Cases which meet the criteria for approval  
			   are moved to exception queue for the purpose of approval by 
			   competent authority. 

		  2.	 All cases in this exception are verified, categorised and examined 
			   to verify the claim in ITR leading to refund over a threshold and approval  
			   for the same.

		  3.	 This process is used to expedite approval of processed ITR by ITD 
			   as it is done bulk and sample basis.

		  4.	 Based on the variance data analysis, respective Form-type wise  
			   approvals are provided by the ITD officer for completion of processing  
			   of ITR if no issues in business rule application is found.

		  5.	 If during the examination of processed output, any issue with  
			   computation is found, such records are excluded from the approval  
			   process and a change to business rule to correct the computation is  
			   initiated. The excluded ITRs will be kept in abeyance till the deployment  
			   of modified business rule. Post deployment of modified business rule,  
			   ITR is reprocessed with such rule and if processed output is meeting  
			   the requirements, the ITR will be approved for completion.

		  6.	 This process helps in taking action on the records having inconsistency  
			   in the computation or in the compliance of the Income Tax Act in  
			   consultation with ITD Officers.

		  7.	 Post ITD Officers’ approval, a CSV file is created and Officer will upload  
			   the same in the system. In some cases, the cases are taken in print and  
			   signature is obtained from Officer and kept for record purpose with ITD.

		  8.	 Once ITD Systems team receives hard copy and soft copy(MOM) of  
			   FTA file containing approved list of ITR, they will move the records from  
			   status 46 for accounting.

		  9.	 The following is chart showing the action that is taken by ITD Officers 
			   at CPC with respect cases in the approval queue.

	 Step 10:	 Refund Cases check for demands outstanding yet to be inwarded  
					     to CPC

		  1.	 If the ITR results in refund after computation, a check is made to find  
			   out if all demands (if any) for the PAN are inwarded at CPC FAS and are  
			   available for adjustment after the Section 245 process. At this stage, if  
			   any demand is pending inwarding, ITR is kept on hold to inward the  
			   demand into CPC FAS and such ITR is released as soon as demand is inwarded. 

		  2.	 This is controlled by automated jobs and do not require 
			   manual intervention.

	 Step 11: Tax on Regular Assessment –Minor Code 400 challan - consumption 

		  1.	 If there is tax payment under minor code 400, that is consumed for  
			   processing at CPC, and taxpayer subsequently claims a refund out of  
			   such payment under minor code 400, the record is taken for approval  
			   by ITD officer. This process is usually applicable for revised ITRs 
			   and rectifications.
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		  2.	 Based on case to case basis, ITD officer will either allow the refund to  
			   issue from such payment or reject the consideration of such payment  
			   for refund computation. Post approval the ITR is taken for further processing.

	 Step 12: Processing completed-ready for accounting

		  1.	 ITR processing by way of computation completed will be ready for  
			   accounting. Before accounting the ITR, quality checks are performed 
			   to ensure that processing is complete and accurate. Also risk related  
			   checks are handled at this stage, wherein all refund cases above a  
			   threshold await a risk confirmation from Project Insight. Only refunds  
			   approved by Project Insight above this threshold are released for  
			   accounting and completion. 

		  2.	 All ITRs are loaded to processing to stop at this stage for quality check  
			   and risk mitigation. And cases passing the quality and risk aspects are  
			   taken for accounting and completion.

		  3. List of ITRs that can be accounted are released using a user interface 
			   on a daily basis and even multiple times in a day.

	 Step 13: Accounting Process Completed

		  1.	 ITRs released after computation for accounting are accounted in CPC  
			   FAS. The tax, interest and income are accounted in respective heads, the  
			   tax credits are consumed towards tax liability which may result 
			   as NDNR, Demand or refund. Different processes are involved after  
			   accounting of ITR is completed and same is explained below:

		  2.	 Refund Cases: Once accounting is completed for refund cases, refund  
			   outward is run by sharing refund advice to refund banker through  
			   OLTAS after verification of bank account no. with NPCI, or using the  
			   prevalidation done at the e-filing end. 

			   a)		 From 1/3/2019 all refunds are required to be issued only by ECS mode  
					     of transfer to taxpayer.

			   b)		 Refund will be sent to refund banker and post this intimation  
					     u/s.143(1) is sent to taxpayer.

			   c)		 TDS on refund interest if any in case on NRI is deducted at this stage  
					     and remitted to ITD via refund banker. TDS certificate is issued 
					     to taxpayer after filing of quarterly returns in TRACES by email.

			   d)		 Interest u/s. 244A is calculated at this stage taking into consideration  
					     delay attributable to taxpayers (if any).

			   e)		 Intimation u/s. 245 is issued wherever there are demands and refund  
					     is kept on hold. However, if refund is less than Rs.5,000/- or  
					     outstanding demand is less than Rs.5000/- this process in skipped  
					     to minimise taxpayer grievances as per the risk management policy  
					     defined by the Board.  The taxpayer is required to confirm the  
					     demand or disagree with demand on e-filing portal. 

				    •	If taxpayer agrees to the outstanding, as and when any refund is  
					     available, RO adjustment is completed at the time of accounting  
					     itself and adjustment information is provided in the Intimation  
					     u/s.143(1) or 154 as the case may be.
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				    •	If taxpayer disagrees with the demand, a communication is sent  
					     to AO by email by CPC, seeking AO’s intervention. AO can examine  
					     the reason for disagreement and either agree with taxpayer by  
					     passing appropriate order to rectify the demand or disagree with  
					     reason provided by the taxpayer. 

				    •	Wherever AO disagrees with the reason provided taxpayer and  
					     demand is confirmed as correct and collectible, same is considered  
					     by CPC and refund is adjusted.

				    •	Frequent reminders are issued to AO within 30 days from date of  
					     disagreement to impress up AO to verify the demand.

				    •	If the taxpayer doesn’t respond within 30 days of receipt of  
					     intimation u/s 245, it is deemed that the taxpayer has no objection  
					     for adjustment of refund against the outstanding demands.

		  3.	 NDNR cases: Once accounting is completed as NDNR, intimation 
			   u/s. 143(1) is sent to taxpayer by email.

		  4.	 Demand Cases:-If processing results in demand, demand is shared 
			   in the AO portal and added to Demand repository for follow-up and  
			   application of tax paid on regular assessment as and when paid.

			   a)		 Intimation is sent in printed mode for demand cases by speed post.

			   b)		 E-pay tab is provided in pre-filled challan issued along with  
					     intimation to help taxpayer pay the demand by electronic mode.

		  5.	 Post to the accounting process completed, the data which has been  
			   processed in CPC needs to be shared with AST/ITBA, through data  
			   base tables framed. And the process is said to be “PDT” (Processed  
			   Data Transfer).

	 Step 14: Transfer of ITR to ITBA/AST 

		  1.	 ITRs in certain scenarios are transferred to AST/ITBA for processing.  
			   Currently cases where Relief u/s.90/91 is claimed and cases selected  
			   for CASS are transferred to ITBA.

		  2.	 A communication along with AO details is sent to taxpayer intimating  
			   the taxpayer about transfer of ITR to AO.

	 Step 15: Unprocessed and closed ITR

		  1.	 In case multiple ITRs are filed by a PAN for an AY, then latest ITR  
			   (depending upon time limit for filing of ITR) is taken for processing by  
			   terminating processing of earlier ITR as unprocessed and closed.

		  2.	 No communication is sent to taxpayer as taxpayer has revised the 
			   ITR voluntarily.

	 Step 16:	 Invalidation of ITR due to taxpayer not curing the defects 
	 	 	 	 	 notified u/s.139(9)

		  1.	 As explained in Step 3 in detail, if there is no response to notice/reminders  
			   of Section 139(9) process, the ITR is invalidated. 

		  2.	Communication will be sent to taxpayer, intimating that the given ITR 
			   is invalidated by email as well as written communication. 
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	 Step 17:	 Abort and close of ITR for loading of revised ITR or 
					     reprocessing of ITR.

		  1.	 In certain circumstances the ITR is processing is aborted and closed 
			   to facilitate proper application of business rules. This is done to give  
			   effect to new/modified business rule, patch updation shared by e-filing etc.,

7.5.	 FAQs on Processing of ITR

7.5.1.	 Queries related to ITR Filing at e-filing stage.

7.5.1.1.	 Deduction(s) u/c VI-A is not allowing? 

Ans.	 Deduction u/c VI-A may not be allowed may be because there is no Income being  
	 offered in the Return. Please fill the details of all Income and then proceed to fill  
	 deduction(s) u/c VI-A. The same shall be allowed up to the maximum 
	 eligible amount(s). 

7.5.1.2.	 Unable to fill the details in Schedule FA or Schedule FA is greyed out 
	 in ITR? 

Ans.	 Select the appropriate option from the drop down in sheet Part B -TI-TTI at serial  
	 number 19, select as “Yes” to proceed further. (Check the applicability). 

7.5.1.3.	 Unable to claim benefits U/S 80 TTA/TTB not enabled in Chapter VI A? 

Ans.	 The deduction u/s 80 TTA and 80 TTB will be applicable as per the DOB/ 
	 Residential status entered in the Personal Information sheet. This deduction  
	 shall be allowed only if the income has been offered in “Interest from  
	 Savings Bank” or/and “Interest from Deposits (Bank/Post Office/Co- 
	 Operative Society) in Schedule OS in Return. 

	 For more information refer to instructions for limits on Amount of Deductions  
	 as per ‘Income Tax Act’. 

7.5.1.4.	 Taxpayer is Unable to claim benefits U/S 80 CCD (2)? 

Ans.	 To claim the benefits u/s 80 CCD (2), kindly select the appropriate option  
	 in the utility under ‘PART (A) General Information/Personal Info tab >  
	 Select ‘Nature of employment’ in ITR1 & ITR4 and in Schedule Salary in  
	 ITR2 & ITR3 to proceed further.  The deduction under this section shall  
	 be limited to 10% of “Net salary - Value of perquisites as per Section 17(2)” 

7.5.1.5.	 Unable to upload XML file generated by using Excel software, error is  
	 reflecting as ‘Invalid XML Please generate XML again using the latest utility’? 

Ans.	 Invalid XML error may arise due to the following reasons,  

	 1.	 The taxpayer might have altered or edited the XML file generated from the ITR  
		  utility before uploading the same to the Portal.  

	 2. 	 The taxpayer might have generated the XML file from the older version of 
		  ITR utility.  

	 3. 	 In the case Excel utility, the PC used for generating the XML in which the .Net 
		  3.5 frame work might have not installed or not enabled.  

	 To install the .Net 3.5 Framework please visit the link provided 
	 (https://www.microsoft.com/en-in/download/details.aspx?id=21)  
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	 To enable .Net Framework  Go to Control Panel ⇒ Programs ⇒ Programs and  
	 Features ⇒ Turn Windows features on or off ⇒ Select the .NET Framework 3.5  
	 (includes .NET 2.0 and 3.0) check box, select OK and Restart the System and the  
	 generate the XML afresh.  

	 The XML file uploaded to the portal must be generated from the latest version of  
	 ITR utility available in the e-filing Portal. 

7.5.1.6. 	 Unable to claim the whole donation amount claimed in ‘Donation in cash’  
	 in 80G section? 

Ans.	 Deduction u/s 80G shall auto-populate from Schedule 80G provided in the  
	 utilities To  claim the same user needs to fill Schedule 80G. Moreover the  
	 limit  for  Donations in Cash is Rs.2000/- (Two thousand Rupees only),  
	 so if the amount in Donation in Cash exceeds Rs.2,000 the same is not  
	 eligible for deduction. If you have paid donations in other modes kindly  
	 enter the details in appropriate cells for claiming eligible amount of donation  
	 in returns of income for A.Y 2019-20. 

7.5.1.7.	 Invalid Aadhaar OTP while entering to e-verify the income tax return? 

Ans.	 You are requested to retry after sometime by generating the fresh Aadhaar OTP  
	 and proceed further. Or Kindly contact the UIDAI Helpdesk at 1947 for Aadhaar  
	 OTP related issues. Alternatively, you may e-Verify the income tax return through  
	 options given below:  Login to e-filing through Net Banking/EVC through pre- 
	 Validating Bank Account/EVC through pre-Validating Demat Account/EVC  
	 through Bank ATM.

	 For more information, kindly go through the HELP option provided in e-filing  
	 website www.incometaxindiaefiling.gov.in. Help> Taxpayer > e-Verification >  
	 e-Verification options. 

7.5.1.8.	 Unable to open the EXCEL utility and buttons are not working? 

Ans.	 Download the required form from e-filing www.incometaxindiaefiling.gov.in Main  
	 Screen > Downloads >Offline Utilities > Click on Income Tax return Forms >  
	 Download the required form > extract the downloaded ITR in a folder > open the  
	 excel utility > enable protected view and macros button found on the top ribbon  
	 bar. Note: Follow the given steps to enable the macros:  

	 For MS-Office 2003 Go to Tools > Macros > Security >Select Low or Medium, save  
	 the excel-utility and re-open it.  

	 For MS-Office 2007 Go to Excel Options > Trust Centre > Trust Centre Settings >  
	 Macro Settings > Enable all macros and Go to Excel Options > Trust Centre > Trust  
	 Centre Settings > ActiveX Settings > enable all controls without restriction and  
	 without prompting Save the excel-utility and re-open it.  

	 For MS-Office 2010 and 2013 When you open the Excel Utility, the yellow Message  
	 Bar appears with a shield icon and the Enable Content button. Click on the Enable  
	 Content to enable the macros. 

7.5.1.9.	 Unable to Link Aadhaar with PAN due to profile mismatch and unable to  
	 file the income tax return? 

Ans.	 The mentioning of the valid 12 digit Aadhaar number/ 28 digit Enrolment  
	 ID [for those who are yet to get Aadhaar but enrolled] in the ITR form is made  
	 mandatory for filing of returns.  If you have obtained AADHAAR then kindly  
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	 enter the 12digit AADHAAR number in the ITR.  If you have not obtained  
	 AADHAAR then kindly enter the 28 digit Enrolment ID in the ITR. 

7.5.1.10.	 I have made the tax payments successfully and still the pending tax is  
	 	 showing in Tax Paid Verification sheet? 

Ans.	 You are requested to enter the e-Pay tax payment details (BSR Code, Challan  
	 Details etc) manually while filing the income tax return in ‘Tax Details’  
	 sheet under ‘Sch IT - Details of Advance tax and self-assessment tax  
	 payments’ and proceed further. 

7.5.1.11.	 Unable to Generate XML ITR through Java software error states “Please 	
	 enter the Date of Filing”? 

Ans. 	 Date of Filing need to be entered in CFL Schedule of ITR for successful generation  
	 of XML  

7.5.1.12.	 In schedule TR filed Taxpayer Identification Number is not matching with 	
	 taxpayer identification Number entered in schedule FSI? 

Ans.	 Kindly download latest ITR software and proceed further 

7.5.1.13.	 In Schedule S in Field 3 drop down value of: Sec 10(13A) - Allowance to  
	 meet expenditure incurred on house rent” is more than (50% of drop  
	 down value of “Basic Salary and Dearness Allowance) or House Rent  
	 Allowance” in the Sl. No 1a of all employees of Sch. S or in Sch. S in Field  
	 3 dropdown value of “Sec 10(10AA) Earned leave encashment” is more  
	 than dropdown value of “Leave Encashment” in the Sl. No. 1a of all  
	 employers of Sch. 

Ans.	 Deduction for House Rent Allowance u/s 10(13A) at Point-3 can be claimed  
	 only if the same is offered as Salary Income in “Salary as per Section 17(1)”in  
	 “House Rent Allowance”. Similarly any Salary exemption claimed u/s 10  
	 should be offered in schedule salary (Salary as per 17(1), Salary as per 17(2)  
	 and salary as per 17(3), whichever applicable). 

7.5.1.14.	 Getting error “Amount should be numeric, no negative, no decimal, up to  
	 14 digits” in Schedule Tool 112A/115AD(1)(iii) proviso? 

Ans.	 The amount needs to be entered manually up to two decimal Values. 

7.5.1.15.	 Please fill the amount field at point B or and Point D, if not applicable,  
	 enter zeros in Schedule AL? 

Ans.	 If Yes is selected in Point A of AL Schedule than the all the details in Point  
	 A needs to be mentioned. Point B, C, D has to be filled accordingly. If No 
	 is secluded in Point A of AL Schedule than also value has to be mentioned  
	 in Point B, C, D. 

7.5.1.16.	 Unable to Select 115H? 

Ans.	 Question related to selection of 115H would be enabled only if the Residential  
	 status is selected as “Resident” and Status selected as “Individual”.

7.5.2. FAQs on Processing of ITR at CPC

7.5.2.1. What is the manner in which revised return is considered at CPC?

Ans.	 If both ITRs are before the due date for filing, Revised return is taken based on the  
	 latest acknowledgement number of ITR (since it’s the latest return) and will be  
	 processed. Please take note of the due dates as applicable.
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7.5.2.2.	 Which return will be processed if revised return and Rectification are  
	 filed on the same date?

Ans.	 Revised return will be processed if the time for processing the same is available.  
	 Rectification application will be accordingly rejected.

7.5.2.3.	 When ITR is transferred to AST/ITBA for initiation from ITBA for  
	 processing, what is the time required for transfer?

Ans.	 The transfer of ITR from CPC is done by entering details in a table, that is read  
	 by ITBA. As soon as ITBA reads the data, CPC gets an acknowledgement. ITBA  
	 will then enable the ITR for processing in ITBA. The entire process should 
	 be completed in 2 working days.

7.5.2.4.	 If the taxpayer is issued notice u/s. 139(9), is any information shared 
	 with AO?

Ans.	 No, only taxpayer is shared with the information. The taxpayer is required 
	 to respond to notice by way of correctedITR, in such cases, the corrected  
	 ITR is used for processing. The corrected ITR cannot be transferred 
	 to ITBA if there is no requirement to transfer the ITR to ITBA. Only the  
	 original/revised defective ITRis transferred to AO. 

7.5.2.5.	 What needs to be done if Processing completed at CPC but details are  
	 not visible at AST/ITBA system?

Ans.	 AO needs to raise the issue to ITBA and communicate the same to CPC.

7.5.2.6.	 Under what circumstances return will not be processed at CPC?

Ans.	 CPC is authorized to process all ITRs filed u/s. 139(1) and 139(4) of the Act under  
	 section 143(1). If the ITR is to be processed u/s. 143(3) or 144, then AO has to  
	 initiate processing from ITBA.

	 The ITR filed in response notice u/s 142(1), 153A, 153C, 148 of the Act are also  
	 required to initiated by the AO in ITBA for processing at CPC.

7.5.2.7.	 In TDS restricted due to application of Rule 37BA cases, if prior year  
	 TDS is claimed in current FY (income is not offered in this year), what 
	 is the remedy?

Ans.	 In case any return captured as defective rule code as per rule 37BA, CPC will  
	 provide an opportunity to the taxpayer to file the corrected return. If  
	 taxpayer files corrected return without correcting the defect and again it  
	 is captured under same reason, CPC will process the return by restriction of  
	 TDS Credit. For the application of rule 37BA in cases where income is  
	 offered in prior year but TDS is claimed in another subsequent year, the  
	 taxpayer may approach the JAO via email, who can examine the claim of  
	 taxpayer and consider the same in rectification. Rectification rights will be  
	 transferred to AO based on JAO’s request on theITBA system.

7.5.2.8. Why is the claim for TDS in Schedule TDS 2 for other PAN disallowed?

Ans.	 In the ITR form, taxpayer has the option to claim the TDS credit as ‘Name of others’  
	 in schedule TDS 2, by mentioning the PAN of such another person in which TDS  
	 credit is deducted as per the Form 26AS of such taxpayer. If the details are filled  
	 correctly the claim for TDS is allowed. However, if the schedule is filled incorrectly,  
	 then the TDS credit in respect of “others” is specifically disallowed. Taxpayer can  
	 seek rectification in such cases with proper details. Taxpayer has the option to  
	 claim the TDS credit of earlier years, as ‘prior year TDS’ in schedule TDS, by  
	 mentioning the year in which TDS is deducted in the deducted year column.
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7.5.2.9.		 What are the reasons for disallowance u/s 36(1)(va) of the Act while  
	 	 processing of the ITR?

Ans.	 The due date for payment of PF/ESI is adopted as per the details of due-date,  
		  mentioned in the audit report. The due-dates for these payments are derived from  
		  the audit report only. 

		  Further, CBDT Circular No.22/2015 dated 17-12-2015 has clarified the issue with  
		  regard to employer’s contribution.

7.5.2.10.	Whether PFA adjustment proposed is carried out or not, how to know  
	 	 what adjustments are carried out? 

Ans.	 The adjustments proposed in the notice u/s. 143(1)(a) of the Act will be made to  
		  the ITR, if the response (if any) provided is not accepted or if no revised ITR is filed  
		  within the time provided in the notice. All the details of the adjustments made to  
		  the ITR are provided along with the Intimation as an annexure. 

7.5.2.11.	 Whether response to notice u/s.143(1)(a) is considered by CPC and how 
	 	 is it disposed?

Ans.	 If taxpayer has provided response via e-proceedings module of e-filing through  
		  any text response, such response will be considered based on the record of the  
		  taxpayer and appropriate action will be taken by the CPC. If the response is  
		  rejected, the rejection is intimated to the taxpayer by way of communication and  
		  a further period of 30 days is given to taxpayer to file revised return.

7.5.2.12.	Why there is disallowance of relief u/s.90 while processing of the ITR at  
	 	 CPC or ITBA? (with Form 67 or without Form 67)

Ans.	 Form 67 should be filed along with the return and the claim for relief amount  
		  in the ITR needs to be filled correctly. These returns where the claim for relief  
		  u/s.90 are claimed, are transferred to the AO for verification and AO has been  
		  empowered to allow the claim for foreign tax claim in the ITR in ITBA based on the  
		  records available with the AO as per annexures to Form 67 or other records. CPC  
		  processes the ITR initiated by the AO with appropriate amount of relief to be  
		  considered for processing u/s.143(1) and same is considered by CPC. In cases  
		  where AO has allowed the relief claimed in the ITR, same is allowed subject to  
		  correct claim in Form 67 and the extent claimed in the form. 

7.5.2.13. What is rationale on the basis of which interest u/s. 234 is computed 
	 	 at CPC?

Ans.	 The processing of ITR at CPC considers the tax credits as available in the Form  
		  26AS and date of payment mentioned therein, for purpose of computation of  
		  interest under the provisions of section 234 of the Act along with the information  
		  provided in the schedules of the ITR with strict adherence to the Act.

7.5.2.14:	What are the reasons for computation of interest/fee u/s.234F?

Ans.	 Taxpayer who files the ITR after the due date for filing of the ITR u/s.139(1) of the  
		  Act is required to pay the fee u/s.234F of the Act. At times when the due date  
		  for filing of the ITR is extended on the last day or at very short notice for making  
		  changes to processing software, the fee gets levied due to automated rules  
		  framed for processing considering the due date before the extension. The cases  
		  where the levy of fees u/s.234F is incorrect, the returns are identified and  
		  considered  for suo motu rectification by CPC. For AY2019-20, there are many  
		  extension of due date across India as well as for particular State within 
		  the country.
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7.5.2.15:	 	 Why is claim for relief u/s. 89 not allowed as per the claim in the ITR?

Ans.		  The relief u/s. 89 of the Act is required to be allowed in comparison with the  
		  information in Form 10E at the time of processing of the ITR u/s.143(1) of the Act.  
		  Sometimes taxpayer fails to file Form 10E along with the ITR, hence the claim  
		  is disallowed. However, if the Form 10E is filed post processing of the ITR (where  
		  claim for relief u/s.89 is disallowed), such ITR is taken for suo moto rectification  
		  by CPC.

7.5.2.16:	 	 Why is claim for prior year TDS not allowed in ITR?

Ans.		  Taxpayer has to claim the TDS credit as ‘prior year TDS’ in schedule TDS 2, by  
		  mentioning the year in which TDS is deducted in the deducted year column  
		  as applicable to its case based on the credit available in Form 26AS and records  
		  of the taxpayer. The claim for prior year TDS is disallowed at the time of  
		  processing of ITR for the following reasons:

		  a.	 The TDS credit for TAN-PAN AY for which TDS is claimed in another 
			   is already considered for processing and allowed for another AY.

		  b.	 The TDS credit for TAN-PAN-AY for which TDS is claimed 
			   is processed in the legacy system of the Department, hence such  
			   credit needs to allowed by the AO on ITBA system.

		  c.	 The TDS credit claimed is not commensurate with the income/gross  
			   receipts offered in the ITR and same is restricted as per rule 37BA r/w.  
			   Section 199 of the Act.

		  d.	 The claim in schedules of the ITR are incorrect or the TDS is not  
			   available in the Form 26AS for such year mentioned in the ITR.

7.5.2.17:	 	 Why are the rights for processing of return still with CPC and not  
	 	 transferred to AO? What are the circumstances under which the rights  
	 	 for processing are transferred to AO?

Ans.		  The rights for processing of the ITR will remain with CPC as matter of rule. In  
		  cases where the ITR is required for further processing under u/s.154, any other  
		  provisions of the Act like 143(3), etc., the rights are transferred to  
		  jurisdictional AO by CPC. AO has been provided option to call for  
		  rectification rights from CPC in any case by making request in the ITBA  
		  system and such requests are completed by CPC in 2 working days. In  
		  cases where a specific campaign or circular are issued by CBDT  
		  empowering the AO or field formations with specific powers, the  
		  rectification rights for such impacted cases are transferred to the AO 
		  by CPC in a bulk manner.

7.5.2.18:	 	 What are the reasons for disallowance of deduction under chapter VIA  
	 	 while processing of ITR?

Ans.		  Chapter VI A deductions claimed in the ITR are allowed subject to conditions  
		  imposed by the said provisions for deductions and from out of the nature of  
		  income that is eligible for such deductions. The deductions may be disallowed  
		  due to below reason:

		  a.	 Return is not filed within due date for deductions where Section 80AC 
			   is applicable.

		  b.	 Incomplete information is provided in the ITR and respective schedules are 
			   not filled.
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		  c.	 The head of income offered for taxation does not permit deductions under  
			   chapter VIA or restricts to a certain amount which is not in accordance  
			   with the claim in the ITR.

		  d.	 The claim is made in summary part of the ITR, without filing the  
			   detailed schedule (this is due to incorrect utility used by the taxpayer).

7.5.2.19:	 	 What are the reasons for disallowance of Section 80G?

Ans.		  The claim for deduction u/s 80G of the Act requires relevant information 
		  in schedule 80G in the ITR as well as other conditions like limiting to  
		  adjusted total income post re-computation of the schedules while  
		  processing u/s.143(1) of the Act.

7.5.2.20:		 What are the reasons for disallowance of Section 80TTA?

Ans.		  Deduction u/s 80TTA (up to Rs. 10,000/-) will be allowed only if there is income  
		  offered under the head of income ‘other sources’ in the ITR, and the income is  
		  required to be offered in the ITR as received from interest from savings bank  
		  account. The claim for interest offered under other sources like interest  
		  from fixed deposit, etc. will not be entertained while considering claim for  
		  deduction u/s.80TTA.

7.5.2.21:	 	 What are the reasons for disallowance of section 80QQB?

Ans.		  Taxpayer is required to meet the conditions set out under the provisions of  
		  section 80QQB, the deduction will b allowed from out of royalty income  
		  offered in the ITR for a taxpayer resident in India. Many taxpayers who  
		  claim to be non-residents in ITR claim this deduction and same is  
		  disallowed, also the claims are made against income from business/profession.

7.5.2.22:		 What are the reasons for disallowance of deduction section 80GG when  
	 	 HRA is also claimed in ITR?

Ans.		  In cases where Taxpayer claims deduction u/s 80GG as well as HRA, while  
		  processing of the return, any one of the claims will be allowed. 

		  Allowance u/s. 10—basis for the limits in the sections thereunder.

7.5.2.23:		 Why are claims for brought forward loss adjustment (BFLA) disallowed?

Ans.		  Claims for Brought Forward Loss Adjustments by taxpayer in the return  
		  of income are disallowed due to incorrect filling of information schedule  
		  CFL (carry forward loss) of the ITR and claims  for ITRs not filed within  
		  due date are disallowed.

7.5.2.24:		 Self-assessment tax(SAT) is paid, why CPC has not allowed the credit 
	 	 for SAT?

Ans.		  Taxpayer claiming SAT payment is required to fill the details of payment  
		  like BSR code, challan number, date of payment of SAT, amount paid in  
		  Schedule IT of the ITR. 

7.5.2.25:		 Why demand is shown after payment of regular tax on assessment made  
	 	 under minor code 400?

Ans.		  If taxpayer has made payment of demand under minor code 400, then  
		  the same will be considered against the open demand for the AY and  
		  demand will be reduced to the extent of payment. After closure of the  
		  demand, interest (where applicable) u/s. 220(2) of the Act is computed  
		  and same is required to be paid by the taxpayer for AY.
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7.5.2.26:	 Why are deductions claimed in ITR u/s 80P disallowed?

Ans.	 To allow the deduction u/s 80P return should be filed within due date and  
	 the 80P schedule should be filled correctly and relevant income should be  
	 available in the return of income after the adjustment of losses.

7.5.2.27:	 Taxpayer has responded to defective ITR by providing text response in  
	 e-proceedings but ITR is not processed within reasonable time?

Ans.	 If the response provided by taxpayer in case of defective return is not  
	 acceptable, the response is rejected and a communication is sent to the  
	 taxpayer. Post which the return will be invalidated after giving sufficient  
	 time for taxpayer to file a corrected ITR, as the time limit for filing revised  
	 return may not be available. The taxpayer is provided time to file a  
	 corrected return till fag end of time available for processing of ITR for the AY. 

7.5.2.28:	 Why are losses under head House property disallowed? 

Ans.	 If the taxpayer has claimed loss under the head house property in the ITR but  
	 the relevant information (like annual lettable value, flag for let out or self- 
	 occupied, etc.) is not provided in schedule HP, the loss will be disallowed.

7.5.2.29:	 Why is income from Capital gains taxed twice?

Ans.	 The information provided in the ITR is inconsistent leading to double taxation 
	 in certain cases. The section under which income is offered in the schedule of  
	 capital gains and section selected in Schedule special income may not be same.  
	 Based on the information in the ITR, income is treated as different and both are  
	 taxed at the rates selected in the ITR by the taxpayer. 

7.5.2.30:	 Why the addition is made on account of mismatch in turnover as per ITR  
	 & as per 26AS in cases where the explanation has been provided that the  
	 difference is due to “the deduction of TDS on gross amount including  
	 GST and the turnover declared as ITR is excluding of the same”. Why  
	 explanation/reconciliation not considered and additions are made? 

Ans.	 While processing of ITR u/s. 143(1), if the gross receipts offered in ITR is not  
	 commensurate with TDS claim in ITR, TDS credit is restricted as per rule 
	 37BA r.w.s. 199 of the Act. The taxpayer is required to provide the information  
	 in the ITR wherein provision is provided to reflect this difference and make  
	 necessary adjustment.

7.5.2.31:	 While processing the return exempt income has been disallowed. In the  
	 ITR-6, schedule BP has been correctly filled and exempt income is  
	 reduced in row 5. However, the amount has been disallowed and Demand  
	 has been raised due to this? 

Ans.	 In Schedule BP, Income credited to P&L account, which is exempt, 
	 is to be reduced and this amount has to be mentioned in the respective schedule  
	 (Sch. EI).  If there is any inconsistency, the lesser amount, mentioned in Sch.EI,  
	 will be taken as the amount to be reduced, in Sch. BP, thus enhancing  
	 the business income. Taxpayer is requested to fill the schedule EI correctly  
	 with the same amount, as reduced in schedule BP, in order to avoid 
	 this disallowance.

7.5.2.32:	 Why is the claim for deduction u/s.54 of the Act not allowed?
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Ans.	 The taxpayer is required to fill the relevant information in schedule CG under  
	 the relevant and applicable place holder in Schedule CG, often the information  
	 is provided in inconsistent manner leading to disallowance. The instruction for  
	 filling ITR needs to be adhered to.

7.5.2.33:	 Why is the income under DTAA taxed incorrectly at CPC? Income earned  
	 abroad by a resident in India, being dividends and bank interest was  
	 shown in appropriate schedule “computation of income for Non-  
	 Residents “ in addition to OS schedule on which pro rata tax was not  
	 calculated by ITR2 for A.Y 2019-20 by virtue of DTAA(income was $ 850)  
	 and U.S tax on that was not filled up  ; Intimation U/S 143(1) added further   
	 sum of same $850 Indian equivalent and sought taxes therefore-  
	 rectification u/s 154  was filed by showing the corresponding U.S Taxes  
	 payable at Rs.8953 out of $ 40000 demanded by IRS on global income  
	 which was rejected by CPC as fresh claims- 2 appeals have been preferred  
	 by virtue of CPC demand.

Ans.	 The processing of claim for DTAA has a bearing of the selection of TRC flag 
	 in the ITR, often it is noticed that claim is disallowed due to incorrect  
	 selection of the flags (Y) and (N). As verified for the given PAN,  schedule  
	 OS is filled incorrectly by taxpayer (DTAA Income - TRC Flag is N). Hence  
	 the income is considered as Normal income and charged at normal rate of  
	 tax. Taxpayer is requested to correct the same and file for online rectification.

7.5.2.34:	 Why is Surcharge computed more?

Ans.	 Surcharge is computed at the rates applicable for the respective AY, and 
	 it is often noticed that taxpayers compute the surcharge at 10% but slab  
	 rate is 15%, in such cases, the slab rate as applicable for the AY is applied  
	 considering the income and other information in the ITR.

7.5.2.35:	 Why is there difference in Marginal Relief computation at CPC?

Ans.	 The marginal relief is computed based on the information in the ITR.  
	 The variance could be due to change in method of computation of the  
	 same. CPC computation is as per the provisions of the Act.

7.5.2.36:	 Is filling the relevant schedules will all the information as per 
	 ISIN mandatory?

Ans.	 Vide PRESS RELEASE Dated: 26-09-2020, it is clarified by CBDT that  
	 there is no requirement of scrip wise reporting for day trading and short- 
	 term sale or purchase of listed shares. The scrip wise details in the return  
	 of income for AY 2020-21 is required to be filled up only for the reporting  
	 of the long-term capital gains for those shares/units which are eligible for  
	 the benefit of grandfathering. The scrip wise details are not required in  
	 income tax return forms for AY 2020-21 for computation of capital gains/ 
	 business income from shares/units which are not eligible for grandfathering.  
	 Thus, the main intent behind requiring scrip wise detail is to facilitate  
	 the taxpayer in correctly computing the long-term capital gains on these  
	 shares/units. Requirement to provide scrip wise information in the income  
	 tax return is not unique to India. Internationally also, the taxpayer is  
	 required to provide scrip wise information for reporting capital gains. For  
	 example, in USA, a taxpayer having capital gains from transfer of shares  
	 is required to fill scrip wise details in Schedule-D of Form 1040 – income  
	 tax return form in USA.
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7.5.2.38:	 Why tax is computed at Maximum marginal rate, when we are eligible 
	 to tax at slab rate? 

Ans.	 In order to compute tax at slab rate in case of AOP/BOI, details of members  
	 of AOP/BOI in sch -Partners Info should be filled with Percentage of share  
	 against each partner and the sum of percentage of share of all members  
	 should be 100%. Since the Partners info schedule is incorrectly filled, the  
	 Income was taxed at flat 30% as Maximum marginal rate.

7.5.2.39:	 In the earlier years AOP/BOI was correctly charged to tax on slabs basis.  
	 However, last year (AY 2019-20), tax was charged at 30% flat?

Ans.	 In case of AOP/BOI, tax is computed at slab rates only if the details of the  
	 members of AOP/BOI, in Sch., Partners Info, is correctly filled with the  
	 Percentage of share of each member. Further the sum of percentage  
	 of share of all members should aggregate to 100%.  If the Partners Info  
	 schedule is not filled, as above, the Income is taxed at flat 30% rate. To  
	 correct the above, taxpayer has to file online rectification after filling the  
	 relevant details in Schedule Partners Information 2. In case of Companies,  
	 if the Taxpayer chooses ‘Turnover /gross receipts in the previous year  
	 exceeds 250 crores’ Flag as ‘Y’, then the rate tax applied is @30%.

7.5.2.40:	 Why is income u/s. 44AE in ITR 4 considered incorrectly?

Ans.	 The information in the ITR u/s. Schedule 44AE is considered for the  
	 calculation of total income based on the data entered thereunder. Often  
	 the tonnage and number of vehicles information is provided incorrectly  
	 leading to computation of higher income. The instructions for filling ITR 4  
	 needs to adhered to by the taxpayers.

7.5.2.41:	 In which field the profit or loss should be disclosed in ITR in case of  
	 Individuals who have profit/losses from trading in Future/Options during  
	 the year?

Ans.	 Taxpayer can fill the income details in Part P&L in “any other income”  
	 column by specifying the nature of income.

7.5.2.42:	 The assessee, Central University substantially funded by Central Govt.,  
	 claimed exemption u/s 10(23C)(iiiab) but exemption not allowed during  
	 AY 2017-18 and AY 2018-19 while processing by CPC. Now, rectification  
	 filed with AO, DCIT Exemptions Chandigarh. Exemption granted in  
	 assessment u/s 143(3) during AY 2016-17?

Ans.	 As Verified for the given PAN, for AY 2017-18 & AY 2018-19, taxpayer has  
	 not provided information as to government grants in Schedule VC of  
	 the ITR. Hence exemption u/s 10(23C)(iiiab) is not allowed u/s. 143(1) of  
	 the Act. Rectification with the information in schedule VC of the ITR along  
	 with relevant information may be provided to the AO.

7.5.2.43:	 In the case of TRUST which are not registered u/s sec, 12AA. gross  
	 receipts are taxed without allowing deductions of expenses in ITR 7, why?

Ans.	 As per Rule 12A where Return has to be filed u/s 139(4A), (4B), (4C) or  
	 (4D) only those assessees have to file return in ITR 7. The Schedules  
	 to be filled by each category of person and conditions to be satisfied  
	 for claim of exemption. The help document for filing ITR 7 has been sent by  
	 email to all persons  who filed ITR 7 for AYs 2017-18, 2018-19 and 2019-20.  
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	 Taxpayers are requested to file their rectification request to the Assessing Officers.

7.5.2.44:	 The Assessee is an educational institute and mainly funded by central  
	 govt.  The income is exempt u/s 10(23C)(iiiab). It is also registered u/s  
	 12AA of income tax Act. We have correctly filled Table 3E-3, More than  
	 70% was Government Grant but Notice u/s 143(1)(a) states that  
	 government grant is less than 50%. Further the notice states that Table  
	 Part B T-1 has not selected, the exemption of 10(23C)(iiiab) whereas  
	 this drop down of this  option is not given in this Table. Actually this table  
	 is not applicable on such income. The Institute is eligible for both  
	 exemption u/s 11 and 10(23C)(iiiab) thus claimed in the Income Tax return.  
	 What is the resolution?

Ans.	 As verified for the given PAN, for AY 2019-20, the taxpayer has claimed  
	 same amount of exemption claimed u/s 11 and as well as u/s.10(23C) 
	 (iiiab). Exemption u/s 11 has been allowed based on the information in the  
	 ITR. The exemption u/s 10(23C)(iiiab) has not been allowed as section  
	 under which the claim is made  has not been selected in the ITR. The  
	 instructions for filing ITR 7 has not been followed by the taxpayer. For AY  
	 2019-20, the instructions to fill ITR 7 are provided and taxpayers are  
	 requested to adhere to the same.

7.5.2.45:	 Why is Cost of acquisition of new asset not allowed, in ITR-7?

Ans.	 As per details furnished in the return, assessee is registered under section  
	 12A/12AA. In Sch.EC taxpayer has claimed exemption under section 11(1A).  
	 This exemption is allowable to the extent of net consideration, on transfer  
	 of capital asset. However, net consideration has not been disclosed in Sl.  
	 No.8 of Schedule AI. Hence, exemption is not allowed.

7.5.2.46:	 Why Corpus Donation is being treated as taxable income, in ITR-7?

Ans.	 Taxpayer is disclosing this corpus donation in Sl. No.(biv) of Schedule  
	 Other Sources but is not including the same in Part B-TI. Due to this  
	 inconsistent information in the ITR, tax is computed on the income as  
	 mentioned in Schedule OS, at the rates applicable to the Status mentioned  
	 in the Schedule Part A General of the return.

7.5.2.47:	 What are the mandatory conditions to allow exemption under section 11  
	 or 10(23C)(iv to via)  i.e., in Sl. no 4 of Part BTI in ITR 7?

Ans.	 The mandatory requirements are as under:

	 a)	Registration or approval is required u/s 12A/12AA or 10(23C)(iv to via)  
		  and Details to be furnished in Schedule Part A General Personal Info.

	 b)	Audit report in Form 10B for 12A/12AA and 10BB for 10(23C)(iv to via)  
		  has to be furnished.

	 c)	Offer the contribution and income in schedule VC and AI.

	 d)	Amount applied for charitable purpose is required to be filled 
		  in schedule ER, EC.

	 e)	For claiming exemption through deemed application, it is required 
		  to fill details in schedule part BTI and to furnish Form 9A for 12A/12AA.
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	 f)	 For claiming exemption under section 11(2) in schedule part BTI  
		  following conditions to be satisfied for 12A/12AA:

		  (a)	 Return should file before due date (As per section 13(9)).

		  (b)	 Statement in Form-10 has to be furnished.

		  (c) Details of amounts accumulated/ set apart should furnish 
				    in Schedule I for 10(23C)(iv to via).

7.5.2.48:	 What are the changes to ITR 7 specific to AY 2018-19?

Ans.	 The changes specific to Form Type ITR 7 for AY 2018-19 are discussed 
	 in the form of question and answers below.

7.5.2.48.1: 	What are points to be borne in mind while filing ITR 7 and making claim  
	 for Exemption claimed u/s 10(23C)(iiiab)/10(23C)(iiiac)?

	 Exemption claimed u/s 10(23C)(iiiab)/(iiiac) (sr.no.9a/9b) will not 
	 be allowed if assessee does not provide Grants received from Government  
	 in Schedule VC and that grant should be more than 50% of total receipts.

	 If assesee is claiming any exemption in sr.no. 9a or 9b of Part BTI then has  
	 to furnish the Section under which exemption claimed in Schedule Part A  
	 General Personal Info.

7.5.2.49:	 What are points to be borne in mind while filing ITR 7 and making claim  
	 for Exemption u/s 10(23C)(iiiad)/10(23C)(iiiae)?

Ans.	 Exemption claimed u/s 10(23C)(iiiad)/(iiiae) (sr.no.9c/9d) is not allowed if  
	 assessee not provide total receipts or total receipts is more than 1Cr in  
	 Schedule Part A General Personal Info.

	 If assesee is claiming any exemption in sr.no. 9c or 9d of Part BTI then has  
	 to furnish the Section under which exemption claimed in Schedule Part A  
	 General Personal Info.

7.5.2.50:	 What are points to be borne in mind while filing ITR 7 and making claim  
	 for Exemption under other clause of section 10 other than 10(23C)(iiiab)/  
	 10(23C) (iiiac)/10(23C)(iiiad)/10(23C)(iiiae)?

Ans.	 If assesee is claiming any exemption in sr.no.8,9e to 9j and 10 of Part BTI  
	 then has to furnish the Section under which exemption claimed in Schedule  
	 Part A General Personal Info and need to fill Schedule IE1.

	 If any income mentioned in sr.no 3 of Part BTI then assessee is not eligible  
	 to claim exemption u/s 10 (sr.no.8,9e to 9j and 10) of Part BTI.

7.5.2.51:	 What are the changes to ITR 7 specific to AY 2019-20?

Ans.	 The changes specific to Form Type ITR 7 for AY 2019-20 are discussed 
	 in the form of question and answers below.

7.5.2.52:	 What are points to be borne in mind while filing ITR 7 and making claim  
	 for Exemption u/s 10(23C)(iiiab)/10(23C)(iiiac)?

Ans.	 Exemption claimed u/s 10(23C)(iiiab)/(iiiac) (sr.no.9a/9b) will not 
	 be allowed if assessee does not provide Grants received from Government  
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	 in Schedule VC/IE3 and that grant should be more than 50% of total  
	 receipts mentioned in IE3.

	 If assesee is claiming any exemption in sr.no. 9a or 9b of Part BTI then has  
	 to furnish the Section under which exemption claimed in Schedule Part A  
	 General Personal Info.

7.5.2.53:	 What are points to be borne in mind while filing ITR 7 and making claim  
	 for Exemption u/s 10(23C)(iiiad)/10(23C)(iiiae)?

Ans.	 Exemption claimed u/s 10(23C)(iiiad)/(iiiae) (sr.no.9c/9d) is not allowed if  
	 assessee not provide total receipts or total receipts is more than 1Cr in  
	 Schedule IE4. If assesee is claiming any exemption in sr.no. 9c or 9d of  
	 Part BTI then has to furnish the Section under which exemption claimed  
	 in Schedule Part A General Personal Info.

7.5.2.54:	 What are points to be borne in mind while filing ITR 7 and making claim  
	 for Exemption u/s 10(23A)/10(24)?

Ans.	 If assesee is claiming any exemption in sr.no.8c and 9h of Part BTI then has  
	 to furnish the Section under which exemption claimed in Schedule Part A  
	 General Personal Info and need to fill Schedule IE2.

7.5.2.55:	 What are points to be borne in mind while filing ITR 7 and making claim  
	 for Exemption under other clause of section 10 other than 10(23C) (iiiab)  
	 /10(23C) (iiiac) /10(23C)(iiiad)/10(23C)(iiiae)/10(23A)/10(24)? 

Ans.	 If assesee is claiming any exemption in sr.no.8,9e to 9j and 10 of Part BTI  
	 then has to furnish the Section under which exemption claimed in Schedule  
	 Part A General Personal Info and need to fill Schedule IE1. If any income  
	 mentioned in sr.no 3 of Part BTI then assessee is not eligible to claim  
	 exemption u/s 10 (sr.no.8,9 and 10) of Part BTI.

7.5.2.56:	 What are the additional parameters that ITR 7 filers need to know for 
	 AY 2018-19 and AY2019-20?

Ans.	 A. If any income mentioned in sr.no 5 of Part BTI then assessee is not  
		  eligible to claim any exemption against this income. However entire  
		  income is taxable without giving any benefit.

	 B. As per section 11(7)- Where a trust or an institution has been granted  
		  registration under section 12A/AA and registration is in force for the  
		  previous year exemption under any clause section 10 will not be allowed  
		  except exemption u/s 10(23C).

7.5.2.57:	 The assessee is an educational institute and Gross receipt are less than  
	 100 lakhs thus the income is exempt under section 10(23C)(iiiad). It is not  
	 registered under section 12AA of income tax Act. The ITR 7 was filed  
	 and expenses related to the activities were claimed but the same is  
	 disallowed in the computation by CPC. There might be a mistake in placing  
	 the information in ITR.  The Form is too complicated to enter the Table for  
	 income u/s 10(23C)(iiiad). In assessment year 2018-19. Now demand  
	 is outstanding due to wrong placing of expenses. In our opinion Net  
	 income is deducting expenses related to main object. Please suggest the  
	 method to apply for rectification of demand?
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Ans.	 As verified for the given PAN, for AY 2018-19 Taxpayer has offered income  
	 Rs.30 lakhs in part-B-TI but the exemption under section 10(23C)(iiiad)  
	 is claimed of Rs. 19 lakhs. Hence, the balance amount Rs. 11 lakhs is  
	 taken for tax computation and demand is raised. Since, this is AY 2018-19  
	 return taxpayer can’t file revised return u/s 139(5). Requesting tax payer  
	 to contact AO for rectification, with request to the AO to seek rectification  
	 rights from CPC and carry out rectification in ITBA system.

7.5.2.58:	 If the response or corrected ITR is not filed within the time limits provided  
	 by notice u/s.139(9) or its reminders, will be ITR be invalidated if the  
	 defect is due to Rule 37BA?

Ans.	 If the defect u/s. 139(9) related to Rule 37BA is not responded to 
	 in e-proceedings or by way of corrected or Revised ITR, then the existing  
	 ITR which contains the defect associated with Rule 37BA will be processed  
	 further without invalidation of the ITR by restricting the TDS credit claims  
	 in the ITR to the extent of gross receipts offered in the ITR.

7.5.2.59:	 Assessee is eligible for exemption u/s 10(23C)(via), but the exemption 
	 is not allowed in the CPC Assessment order for AY 18-19. We have filed  
	 Rectification return but still the exemption is not allowed. However,  
	 exemption is allowed for AY 19-20.

Ans.	 As verified for given PAN, tax payer has not filed the Form 10BB for 
	 AY 2018-19 along with return. As per Proviso 10 Section-10(23C) of Income  
	 tax Act  read with Rule 16CC and 1st Proviso to Rule 12(2) of the Income  
	 Tax Rules,  the audit report Form 10BB has to be  E-filed along with filing  
	 the return of income. Hence exemption u/s-10(23C)(iv/v/vi/via) 
	 is not allowable.

7.5.2.60:	 Can I file form type  ITR 4 for an AY when there is no business income for  
	 that year?

Ans.	 Form type ITR 4 is strictly meant for offering business or professional  
	 income, it should not be used if there is no business or professional income  
	 for a given AY.

7.5.2.61:	 Can I file ITR offering income u/s.44BB of the Act without filling the  
	 Part A- Balance sheet and Profit & Loss account? What are precautions  
	 to be taken while offering income u/s. 44BB of the Act?

Ans.	 The ITR where income u/s.44BB of the Act is offered can be filed without  
	 entering the details of Balance sheet in Part A section of the Part A- BS  
	 and Profit & Loss account schedule, they need to provide the information  
	 in Part B of that sections of the ITR mandatorily. If the part B of BS and P&L  
	 account is not filled, the ITR will be treated defective and invalidated if no  
	 response by way of the said information is provided in the corrected ITR. 

	 While offering income under section 44BB of the Act, the taxpayer 
	 is required to ensure that the income offered is more than or equal to 
	 10% of the gross receipts as per the ITR. 

	 In case, the taxpayer needs to offer income u/s.44BB below the stipulated  
	 10% of gross receipts, then an audit report u/s. 44AB of the Act is required  
	 to be furnished along with information in Part A of Balance Sheet and  
	 Profit & Loss account.
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7.5.2.62:	 Can I offer business income in ITR 3 and 5 without providing the details  
	 in Part A Balance Sheet and Profit & Loss account in cases where section  
	 44AA is applicable?

Ans.	 It is mandatory for the taxpayers who are required to maintain books of  
	 account u/s. 44AA of the Act to provide the information in Part A Balance  
	 Sheet and Profit and Loss account. In case the details are not provided,  
	 the ITR would be treated defective.

7.5.2.63:	 Whether taxpayer can file ITR 3 or 5, where the income is covered 
	 by Section 44AD or 44ADA of the Act, without filing Part A or B of the  
	 Balance Sheet or Profit & Loss account?

Ans.	 If the income offered in the said ITRs are presumptive in nature and covered  
	 by Section 44AD or 44ADA of the Act, then it is mandatory to provide  
	 information in either Part A or Part B of schedules Part A Balance Sheet  
	 and Profit & Loss account either in account case section or in ‘no accounts  
	 case’ section the scheduled without fail.

7.5.2.64:	 In case of one of my clients, Disclosure of club subscription expenses  
	 at point no. 21a of TAR is just a disclosure but CPC issuing 143(1)(a)  
	 proposing to disallow the same, in spite of objection to this filed, they  
	 are again and again issuing the notice of adjustment. Since TAR require  
	 whatever be the expenditure to be disclosed, it does not mean that it is 
	 to be disallowed. The expenditure is wholly & exclusively for the purpose  
	 of business.

	 In case CPC still feels, the language of the form at clause 21 requires amendment.

Ans.	 If the club expenses are incurred for the purpose of business, then such  
	 expenses will be allowed as business expenditure.

7.5.2.65:	 For a Charitable Trust, Form 10B not filed in time, due to which expenses  
	 were not allowed. Circulars issued by department and further time  
	 allowed. Even after filing 10B, rectification not allowed.

Ans.	 Condonation of Form 10B has given by Board. Please refer to the below  
	 CirculaRs.The Circular no.10/2019 dated 22-05-2019 and Circular No.2/2020  
	 dated 03-01-2020.

	 “The Commissioners of Income-tax shall, while entertaining such belated  
	 applications in filing Form No. 10B, satisfy themselves that the assessee  
	 was prevented by reasonable cause from filing such application within the  
	 stipulated time”.

	 Tax payer is requested to contact the concerned AO and request for  
	 condonation and file for rectification.

7.5.2.66:	 Non-availability of intimation u/s 143(1) - In many cases intimation 
	 u/s 143(1) is not available in e-filing Portal, what is the way to get it?

Ans.	 For re-issue of the intimation Tax payer can : Login to e-filing portal > 
	 Go to My Account Menu > Request for Intimation u/s 143(1)/154.

7.5.2.67:	 The nature of business should be appropriately mentioned in given list  
	 for example the assessee is running Kirana store, there is no such head 
	 in stipulated list, so business wise nature should be added in ?
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Ans.	 List of Nature of business codes provided as drop down and relevant code  
	 number also allocated based on the nature of business.

	 “Others”  also provided in the dropdown list to enter any other business  
	 details not provided in the dropdown.

7.5.2.68:	 At times losses are not set off in intimation say business loss is not set off  
	 against capital gains in intimation u/s. 143(1) what should be done?

Ans.	 Where for any assessment year, the net result of the computation under  
	 the head “Profits and gains of business or profession” is a loss to the  
	 assessee, not being a loss sustained in a speculation business, and such  
	 loss cannot be or is not wholly set off against income under any head of  
	 income in accordance with the provisions of section 71.Hence if it is non  
	 speculation loss same can be set off against capital gain.

7.5.2.69:	 Speculation business profits are considered separately in Special  
	 Business: Income from Firm, speculation, without books, 44AE. And  
	 not in Business and profession head. However, more often intimation us.  
	 143(1)(a) and intimation us.143(1) are received stating inconsistency with  
	 the total profit in the income tax return since speculation profit considered  
	 separately is not taken into consideration in the said intimation. The return  
	 is filed by duly deducting the speculation profit as income considered in  
	 other head and showing it as special profits.

Ans.	 Both speculative and non-speculative profits under profit and gains from  
	 business/profession will be part of the total taxable income (salary +  
	 rental + business + other sources). Tax payable would be the amount  
	 calculated on the aggregate taxable income based on the applicable  
	 income tax slab rate.

7.5.2.70:	 While processing the ITR exempt tonnage income has been disallowed.  
	 In the ITR 6, schedule BP has been correctly filled with exempt income  
	 reduced in row 5. However, the amount has been disallowed due to non- 
	 reporting in EI sheet of Form ITR 6. Demand has been raised due to this.

Ans.	 In Sch BP, Income credited to P&L account which is Exempt in Sl. No. A5d.  
	 The sum of total income shown in Schedule Exempt income are inconsistent.

	 Tax payer is requested to fill the schedule EI correctly as against schedule  
	 BP in order to get the credit.
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CHAPTER 8

REFUND 
ISSUANCE

Overview:

CPC processes the ITR filed by taxpayers and upon processing, the refund is 
determined from out of the tax paid in excess of the tax liability determined 
u/s.143(1) or 154. Refund is determined only when the assessee pays the tax more 
than what he is liable to pay. The processing of the returns is completely automated 
and if a particular assessee is eligible to receive refunds, such cases will flow into 
‘Ready for refund banker’ queue in the Financial Accounting System (FAS).  FAS 
system would then run the Refund Outward program & these files are uploaded to 
the Regional Computer Centre (RCC). These Refunds are later merged to National 
Computer Centre (NCC) at Delhi where all the Refunds generated across the country 
are pooled. After the consoLidation the files are transferred to State Bank of India, 
who is the authorized Bank for issuing the ECS Refunds to taxpayer.

8.1.2.	 Refunds will get processed only if all mandatory fields are filled correctly  
	 at the time of ITR filing or updated through online by the assessee any time  
	 before return processing is completed, like Account Number & IFSC. If any  
	 of the fields are left blank or is updated incorrectly, the refunds do not 
	 get processed.

8.1.3.	 The transmission of refund to the taxpayer is performed using the validation  
	 services of various agencies like Public Financial Management System  
	 (PFMS), National Payments Corporation of India (NPCI), etc., over the  
	 years and currently NPCI caters to this process. The first time issuance of  
	 refund is described in Para 1 of this Chapter.

8.1.4.	 National Payments Corporation of India: The bank account details are  
	 shared with National Payments Corporation of India for confirmation of  
	 the linkage of Bank account with PAN. This is required for error Free  
	 transmission of refund to the taxpayer. The name of the taxpayer as per the  
	 Bank and name of taxpayer in the PAN are matched, any mismatch is  
	 categorized and there are different actions for these mismatch cases and  
	 same is discussed separately in Para 2 of this Chapter.

8.1.5.	 Pre-validate Bank Account: The taxpayer is also empowered to Pre-validate  
	 a bank account that is linked to the PAN using the e-filing portal and steps  
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	 for preValidating a bank account are discussed in Para 3 of this Chapter.  

8.1.6.	 Notice u/s.245: The refund determined is considered for issuance only after  
	 checking if any outstanding demand(s) exist for the PAN. In case there is  
	 outstanding demand for the PAN, a notice u/s.245 is issued to the taxpayer  
	 with a proposal to adjust the refund against the outstanding demand in a  
	 chronological order of Assessment Years of the demand if there are more  
	 than one assessment year where demand exists. The process as to notice  
	 under section 245 is discussed in Para: 4 of this Chapter.

8.1.7. 	 Legal Heir: In cases where refund needs to be issued to the legal heir, the  
	 process is discussed in Para 5 of this Chapter. 

8.1.8.	 Representative: Refund to representative assessee is discussed in Para 6 of  
	 this Chapter.

8.1.9.	 Foreign Nationals/entities: Refund transmission in cases for foreign nationals  
	 or foreign legal entitled, the process is discussed in Para 7 of this Chapter. 

8.1.10.	 Refund failure and refund reissue: Refund Reissue is taken up if the  
	 transmitted refund fails to credit to the taxpayer for any reason based on  
	 the request from taxpayer and in certain cases by suo moto issuance by CPC  
	 based on the Pre-validation of the account on the e-filing. This process is  
	 discussed in Para 8 of this Chapter.

8.2.	 Refund issuance to taxpayer upon processing of ITR

8.2.1.	 Refund Outward to Refund Banker Process diagram

8.2.2.	 100% ECS from 01/March/2019:

	 From 1st March 2019 onwards, CPC is issuing the refunds only in ECS mode 
	 to validated bank accounts. The bank accounts validation is being done  
	 either through e-filing portal or NPCI.

	 For smooth transmission of refunds, the taxpayer should ensure:

	 a)	 	 Linking of PAN to bank account  
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	 b)		 The name as per PAN and Bank account should be same

	 c)		 The type of bank account should be Savings/Current/Over Draft 
			   /Cash   Credit/NRO

	 d)		 Avoid providing joint accounts, co-operative bank accounts, Virtual  
			   bank  account.

	 e)		 The bank account should be in India

	 f)		 The bank account should not be De-activated / non-operating accounts  
			   in the e-filing portal.

	 For speedy transmission of Refund, CPC is applying fallback logic i.e., 
	 if bank account provided in the return is invalid, CPC will issue refund to any  
	 other valid bank account present in the taxpayer data base.

8.2.3. 	 FAQs on Refund and Change of Bank details after filing of ITR

8.2.3.1.	 If I have paid excess tax, how and when will it be refunded to me?

Ans.	 To claim refund of the excess paid tax, the assessee has to file Income Tax  
	 Return, irrespective of the fact whether the income is taxable or not. The  
	 amount of refund will be remitted to the assessee’s validated bank account  
	 after the processing of the return.

8.2.3.2.	 My address/bank details mentioned on the Income Tax Return has changed  
	 and I have to receive a Refund. How can I change the address/bank details? 

Ans.	 You can change the Address/Bank details if the Income Tax Return is yet  
	 to be processed. To update the details of Income Tax Return, LOGIN and 
	 Go to ‘My Account’ --> Service Request ‘ --> ‘Change ITR Form Particulars’  
	 --> Provided the Acknowledgement number --> Change the necessary  
	 details --> Click Submit 

8.2.3.3.	 How to change of Bank account after filing the ITR?

Ans.	 After upload of the ITR, if any change occurs in taxpayers Bank Account,  
	 address, Mobile number and e-mail ID, then taxpayer can update these  
	 changes through ‘Change ITR Form Particulars’. Any update can be made  
	 only prior to processing of the return. 8.2.3.4. The steps to change the  
	 particulars in the submitted ITR Form: 

Step 1 Logon to the ‘e-filing’ Portal www.incometaxindiaefiling.gov.in

Step 2

Go to the ‘My Account’ menu located at upper-left side of the page ⇒ 
Click ‘Service Request’ ⇒ Select the ‘Request Type’ as ‘New Request’ 
and Select the ‘Request Category’ as ‘Change ITR Form Particulars’ ⇒ 
Click ‘Submit’ 

Step 3
Enter ‘Acknowledgement number’ of ITR and provide the necessary 
details ⇒ Click ‘Submit’ 

Step 4 To View the status of submitted form, click here to know more 

8.3.	 National Payments Corporation of India

8.3.1.	 Bank accounts provided in the returns will be taken up for account validation  
	 through NPCI. NPCI will share the validation status through Refund banker  
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	 (SBI). Based on the feed received from SBI, the status of the bank account  
	 will be updated in the master file. Once the refund record reaches the status  
	 code 06 (Accounting process completed) it will be picked for the Refund  
	 outward. The refund will be issued to valid bank account through ECS mode.

8.3.2.	 If the validation process confirms that the bank accounts provided by the  
	 taxpayer is invalid, the refund will fail at CPC and refund failure intimation  
	 will be triggered to taxpayer. Then the taxpayer has to file refund reissue  
	 request online through e-filing portal with new bank account/ by correcting  
	 the error as mentioned in the failure communication. Taxpayer needs to  
	 Pre-validate the bank account in the e-filing portal before initiating refund  
	 re-issue request if new bank account is provided in the request. On the basis  
	 of refund reissue request, CPC will reissue the refund to the latest validated  
	 bank account.

8.3.3.	 The validations of the NPCI and response from NPCI with respect to given  
	 bank account for PAN is as under:

	 1)	If NPCI response is “Valid” and also PAN is linked AND name matching %  
		  is more than 80% (‘M0’, M0a, M0b, MI) then issue ECS refund without any  
		  threshold (Category A).

	 2)	If NPCI response is “Valid” and also PAN is linked and irrespective of any  
		  name matching flag, then issue ECS refunds up to 50L. Else Fail & send  
		  communication to taxpayer if the refunds >50L. (Category B).

	 3)	If NPCI validation remarks is” PAN is Missing” (PAN not shared by the  
		  NPCI) AND name matching % is >85% (‘M0, ‘M0a’, MI) then issue ECS  
		  refunds up to 50L subject to more than 3 PAN’s check. Else Fail & send  
		  communication to tax payer (Category B).

	 4)	If PAN-A/C is not validated (No response from NPCI) OR PAN is not  
		  seeded (‘PAN is Missing’ is remarks), then refund up to 25K is issued  
		  through ECS only. If the bank account is not associated with the more  
		  than 3 PAN (Category C).

	 5)	“Bank account associated with more than 3 PANs” check should 
		  be applicable only where there is no response from NPCI or PFMS. (i.e.  
		  bank account belongs to taxpayer but PAN is not seeded)

	 6)	If there is no response from NPCI/PFMS and refund is Less than 25K ,  
		  then CPC will release refund for the same account number. If refund is  
		  more than 25K, Refund will fail with 157 reason code, need to send  
		  communication to taxpayer for changing the bank account details or  
		  Pre-validate the account details in e-filing portal. So that CPC can send  
		  he refund through ECS mode

8.4.	 Pre-validate Bank Account

8.4.1.	 Taxpayer needs to Pre-validate the bank account in the e-filing portal as  
	 general process to ensure risk and error Free transmission of the refund from  
	 CPC to the bank account. In all cases where there is Pre-validated bank account  
	 available, the transmission of refund is successful. In cases where pre- 
	 validated bank account is not there or the given bank account though pre-	 
	 validated is not receiving the refund from refund banker, there can be various  
	 reasons mentioned in the Para 8 of this document. Before initiating refund  
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	 re-issue request if new bank account is provided in the request, it needs to  
	 be Pre-validated. On the basis of refund reissue request, CPC will reissue the  
	 refund to the latest validated bank account.

8.4.2.	 The taxpayer is enabled to undertake the below activities as far as 
	 Pre-validation is concerned on the e-filing website.

	 •	 Only validated bank account in e-filing should be used by the respective  
		  Taxpayer in the Income Tax Return (under bank account details for refund  
		  claim) and Refund Re-Issue service request in e-filing portal.

	 •	 Bank account details provided by Taxpayer already in the Income Tax  
		  Return filed in the recent assessment years and validated by Centralized  
		  Processing Center will also be associated with the respective PAN holder  
		  account in e-filing.

	 •	 In case taxpayer logs in to e-filing through net banking login then bank  
		  account details provided by bank will be added under Pre-validated bank  
		  account details in e-filing account upon confirmation by the user if the  
		  account details were not present in Pre-validated bank account list.

	 •	 Taxpayer can add/remove bank accounts and can have multiple validated  
		  bank accounts. In case the validation fails with the bank while adding  
		  then such account will be removed from e-filing after 7 days. The list of  
		  Removed or Validation failed bank accounts can be viewed by clicking  
		  the link ‘View Failed/removed bank accounts’.

	 •	 EVC can be enabled for the validated bank account by Validating the  
		  mobile number (Mandatory) and email ID (optional) with the bank.  
		  Taxpayer can use the ‘Enable EVC’ button for the same by selecting any  
		  one of the validated bank account from the list. EVC can be enabled  
		  for only one bank account at any point of time. In case user trying to  
		  enable EVC for another validated account then, EVC option will be  
		  removed from the existing account. 

Note:	 ‘Enable EVC’ button is Applicable only to the Individual taxpayers.Other  
	 categories of taxpayers cannot use their Pre-validated bank account for  
	 generating EVC to e-Verify their Income Tax Returns and Forms.

	 •	 EVC Generation will be enabled only for the bank accounts with status  
		  “Validated and EVC Enabled”.

8.4.3. 	 Currently Pre-validate online option is available for specific banks 
	 listed below:

	 01.	 Allahabad Bank

	 02.	 Andhra Bank

	 03.	 Arihant Bank

	 04.	 Bank of Baroda

	 05.	 Canara Bank

	 06.	 Central Bank of India

	 07.	 City Union Bank
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	 08.	 Federal Bank

	 09.	 HDFC Bank

	 10.	 ICICI Bank

	 11.		 IDBI Bank

	 12.	 IDFC First Bank Limited

	 13.	 Jana Small Finance Bank Limited

	 14.	 Karur Vysya Bank

	 15.	 Kotak Mahindra Bank

	 16.	 Oriental Bank of Commerce

	 17.		 Punjab National Bank

	 18.	 Saraswat Bank

	 19.	 South Indian Bank

	 20.	 State Bank of India

	 21.	 Syndicate Bank

	 22.	 The Kurmanchal Nagar Sahkari Bank Ltd

	 23.	 UCO Bank

	 24.	 Union Bank of India

	 25.	 United Bank of India

8.4.4.	 Steps to Pre-validate a bank account details on the e-filing website:

Step 1 Logon to the ‘e-filing’ Portal www.incometaxindiaefiling.gov.in

Step 2 Select Profile Settings ⇒ Pre-validate your Bank Account

Step 3
Pre-validate form will be displayed in case no account exists. (Click 
on Add in case of new account or Select one of the existing Validated 
bank account in case validated accounts are available)

Step 4
Provide ‘Bank Account Number’, ‘Account Type’, ‘IFSC’, ‘Mobile 
Number’, ‘e-mail id’ and Click on ‘Pre-validate’. (email ID is optional if 
provided it will be validated with the bank)

Step 5
Status of the request will be sent to the e-mail id registered with the 
e-filing account.

8.4.5.	 FAQs on Pre-validated Accounts

8.4.5.1.	 In case if the taxpayer surname is short but ITR is having full name which 
	 is matching with PAN database and bank is having the name as on PAN  
	 card, what is the Pre-validation procedure?

	 EX:	 PAN name on card & Bank account name: Krishna C

	 PAN as per data base & ITR Name: Krishna Chaitanya

Ans.	 Refunds will be issued to the Pre-validated a/c which has been validated  
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	 through e-filing portal irrespective of any name match & the name matching  
	 validation process is applicable only for the NPCI validated a/c by comparing  
	 the PAN name & bank account name. Matching rule refers to Name as per  
	 PAN database and name as per Bank account.

8.4.5.2.	 Is the Pre-validation being one-time procedure or should it be done 
	 every year?

Ans.	 Pre-validation procedure is PAN level, so it is one-time validation unless and  
	 until taxpayer modifies the account in e-filing. (Ex: if account is closed then  
	 taxpayer should delete & update with new account number)

8.4.5.3.	While filing the return for AY 19-20 if taxpayer provides the Pre-validated  
	 account number, will the refund be paid through ECS?

Ans.	 Yes, If the taxpayer provides the Pre-validated a/c in the return irrespective  
	 of any assessment years, refund will be issued through ECS mode. (i.e. from  
	 Feb-19 onwards all paper refunds have been stopped from CPC)

8.4.5.4.	 If the status shows as “Validated and EVC enabled” taxpayer is saying it  
	 is Pre-validated? Is it true? Or how taxpayer will get to know the 
	 Pre-validation is accepted?

Ans.	 If the bank account is integrated with Income tax department, the validation  
	 happens immediately; else, it may take few days to update the validation status.

8.4.5.5.	 How much time will it take for Pre-validation status to change from Submitted  
	 to Validated?

Ans.	 Pre-validation is an option enabled for the tax payer in e-filing portal.

	 If the taxpayer provides the bank a/c details which is integrated with income  
	 tax department, then the validation process will happen immediately &  
	 status will be changed to ‘validated’.

	 In case if the taxpayer has provided the a/c details from the banks where  
	 e-filing is not integrated, then e-filing team sends the data to CPC for NPCI  
	 validation and in the interim process the status will be showing as ‘Submitted’.  
	 Once NPCI shares the validation details to CPC, the same will be shared to  
	 e-filing and then the status will be changed to ‘Validated’ or ‘Invalidated’.

8.5.	 Notice under section 245 of Income Tax Act, 1961

8.5.1.	 All the request will flow to the ETL queue through the automated program  
	 to validate the current status of the refund & accept the request if the  
	 refunds are in failed status. Later accepted request will flow to FAS queue  
	 through the automated program if there are any outstanding demands for  
	 any of the AYs, such cases will be marked as ‘Check for reissue’ status queue  
	 for 245 compliances. In this stage, 245 notice will be sent to the taxpayer for  
	 adjusting the open demands towards this refund amount. The same process  
	 will be followed as per Original/Revised & Rectification refunds for 
	 245 compliance. 

8.5.2.	 FAQs on 245 Notice

8.5.2. 1.	Why am I receiving Notice u/s 245? 



CPC HANDBOOK NOV 2020 99

Ans.	 Your return has been processed at CPC and the same has resulted in refund.  
	 The refund so determined is liable to be adjusted against the outstanding  
	 demand(s).  Notice u/s 245 informs you of such demands against which  
	 your refund would be adjusted within 30 days from the date of the notice  
	 u/s 245. 

8.5.2.2.	 What is Section 245 of Income Tax Act, 1961?

Ans.	 Under the provisions of the Income Tax Act, 1961(Act), if any refund is due 
	 to the taxpayer then before issuing such refund the Assessing Officer (AO)  
	 is required to check for outstanding demands. If there is outstanding  
	 demand, an intimation will be issued u/s.245 of the Act giving an opportunity  
	 to the taxpayer to act upon the outstanding demand by either agreeing or  
	 disagreeing for adjustment against the refund available.

8.5.2.3.	 How do I view my outstanding tax demand?

Ans.	 You can view outstanding demand by logging on to https://www. 
	 incometaxindiaefiling.gov.in with your user ID and password. Go to ‘e-file’  
	 tab-> Response to outstanding tax demand.  Alternatively, you can also  
	 check the demand after login select “My pending actions” in “Dash Board”  
	 or click for “For Your action” in Worklist tab on the menu bar. 

8.5.2.4.	 How do I respond to outstanding demand/ what is the action points needed  
	 to be taken up from my end for the outstanding demand? What should I do  
	 next after receiving the Notice u/s 245? 

Ans:	 Response can be made by logging into https://www.incometaxindiaefiling. 
	 gov.in with your user id and password. Go to ‘e-file’ tab-> Response to  
	 outstanding demand. 

	 i.	 In case the demand shown is correct: -        

		  a)	Against the Outstanding Demand- click on ‘Submit response’ and then  
			   select->’Agree with Demand’. 

			   On receipt of the confirmation, demand will be adjusted against the  
			   refund and the balance of refund, if any, will be issued. 

	 ii.	 In case the demand shown is partially correct 

		  a)	Against the Outstanding Demand- click on ‘Submit response’ and then  
			   select->’Demand is partially correct’. 

			   Enter the amount of Demand that is partially correct b) For the incorrect  
			   demand, please follow the steps mentioned in step 3 below.

	 iii.	In case the demand shown is incorrect 

		  a)	Against the Outstanding Demand- click on ‘Submit response’ and then  
			   select->’Demand is incorrect’ 

		  b)	Give detailed reasons and attach relevant documents to show why the  
			   demand is incorrect in your view. This will be reviewed by the Department. 

8.5.2.5.	 How to know the detailed procedure to file online response? 

Ans:	 To know the detailed procedure for filing online outstanding demand  
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	 response -> Please log on to https://www.incometaxindiaefiling.gov.in->Go  
	 to ‘Help Tab’ -> ‘Response to Outstanding tax Demand’ 

8.5.2.6.	 How to know my Jurisdictional Assessing Officer details?

Ans:	 To know your Jurisdictional Assessing Officer details -> Please log on to  
	 https://www.incometaxindiaefiling.gov.in and click on “Know Your  
	 Jurisdictional AO” under “SERVICES” menu.  

8.5.2.7. What are the Consequences for not responding to this communication? 

Ans:	 If no action is taken by you within 30 days of receipt of the notice u/s 245,  
	 the outstanding demand as on that date will be considered for adjustment  
	 against your refund.  

8.5.2.8.	 For which Assessment year (AY), intimation u/s.245 will be issued by the  
	 Income Tax Department (Department)?

Ans.:	 Intimation will be issued to the AY for which refund is determined.

8.5.2.9.	 What are the contents of intimation u/s.245?

Ans:	 Intimation contains the details of AYs, outstanding demand amount, Section  
	 under which the demand was raised, Source of demand, Demand  
	 identification number, Details of the Jurisdiction with whom the rectification  
	 rights are available for such AY.

8.5.2.10. What is the time limit for the taxpayer to respond to the intimation u/s.245?

Ans:	 Taxpayer is required to respond to the intimation u/s.245 within 30 days of  
	 issuance of the intimation u/s.245.

8.5.2.11.	How can the taxpayer respond to the outstanding demand details online 
	 in response to intimation u/s. 245?

Step 1:	 Taxpayer can login to the e-filing portal by www.incometaxindiaefiling.gov.in

Step 2:	 View the outstanding demands that are shown in the dashboard

Step 3:	 In e-file menu, click on response to Outstanding demand

Step 4:	 Click on hyperlink ‘Submit’ located under ‘Response’ column

Step 5:	 Choose any one of the listed responses.

	 •	 Demand is correct

	 • Demand is partially correct

	 • Disagree with the Demand

	 • Demand is not correct but agree for adjustment 

A.	 On choosing ‘Demand is correct’, click on ‘Submit’ button to ‘Confirm’ and  
	 complete the response submission process.

Note:	 o	 If you confirm ‘Demand is correct’ then you cannot disagree with the  
		  demand again.

	 o	 If any refund is due, the refund will be adjusted against the outstanding demand.

	 o	 The taxpayer can pay the demand by clicking the link under ‘Pay Tax’ option.

B.	 On choosing ‘Demand is partially correct’, Enter the ‘Amount which 
	 is correct’ and the ‘Amount which is incorrect’ will be auto filled. Select  
	 the appropriate reason(s) from the list and fill all the applicable fields, upload  



CPC HANDBOOK NOV 2020 101

	 the necessary supporting documents and ‘Submit’ the response. 

C.	 On choosing ‘Disagree with demand’, Select the appropriate reason(s) from  
	 the list and fill all the applicable fields, upload the necessary supporting  
	 documents and ‘Submit’ the response. 

D.	 On choosing ‘Demand is not correct but agree for adjustment’, Select  
	 the appropriate reason(s) from the list and fill all the applicable fields, upload  
	 the necessary supportin

List of Reasons and the additional details required on selecting each reasons are as under: 

Reasons Additional Details Required

Demand paid and Challan has CIN

BSR Code

Date of payment

Serial Number

Amount

Remarks

Demand paid and Challan has no CIN

Date of payment

Amount

Remarks

Upload copy of Challan

Demand already reduced by rectification / 
Revision / Appellate Order

Date of Order

Demand after rectification / revision / Appeal 

Details of AO

Upload Rectification / revision / Giving appeal 
effect order passed by AO

Demand already reduced by Appellate Order 
but appeal effect to be given

Date of Order

Order passed by

Reference Number of Order

Appeal has been filed - Stay petition filed

Date of filing of appeal

Appeal Pending with

Stay petition filed with

Appeal has been filed - Stay granted

Date of filing of appeal

Appeal Pending with

Stay granted by

Upload copy of Stay

Appeal has been filed - Instalment granted

Date of filing of appeal

Appeal Pending with

Instalment granted by

Upload copy of instalment order

Rectification / Revised Return filed at CPC

Filing Type

e-Filed Acknowledgement Number.

Remarks

Upload Challan Copy

Upload TDS Certificate

Upload Letter requesting for rectification

Upload Indemnity Bond

Rectification filed with AO
Date of application

Remarks

Others Others
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Step 6:	 A success message along with Transaction ID is displayed on successful  
	 submission of the response. 

8.5.2.12.  How can the taxpayer view the response submitted by him?

Ans:	 Step 1:	Taxpayer can login to www.incometaxindiaefiling.gov.in  

	 Step 2:	Go to ‘Response to Outstanding Demand’ and click on view link  
				    under the ‘Response’ tab. 

	 Step 3:	Click on ‘transaction ID’ hyperlink

Note:	 For the demand which is shown to be uploaded by AO, then the rectification  
	 right is with Assessing Officer and for the demand against which there 
	 is no ‘Submit’ response available is already confirmed by the Assessing  
	 Officer. Kindly communicate via email with your jurisdictional Assessing  
	 Officer for clarification.

8.5.2.13.	What are the consequences, if the taxpayer does not respond to the  
	 intimation issued u/s.245?

Ans:	 The Department is required to adjust the outstanding demand against the  
	 refund, if no   response is received within 30 days from the taxpayer after  
	 issuance of intimation u/s.245.

8.5.2.14.	Can the taxpayer respond to the outstanding demand without issuance of  
	 intimation u/s.245?

Ans:	 Yes. Taxpayer can respond to the outstanding demand in the e-filing portal 
	 anytime, even without an issuance of intimation u/s.245 from the Department.  
	 Such responses will be considered by the Department at the time of issuance  
	 of intimation or adjustment of outstanding demand.

8.5.2.15.	If the taxpayer acts voluntarily without any intimation u/s.245, is the  
	 response considered?

Ans:	 Yes. The response of the taxpayer will be considered by the Department 
	 at the time of issuance of refund.

8.5.2.16.	If the taxpayer chooses ‘Demand is collectible’, then what is the action  
	 taken by the Department?

Ans:	 By considering the option chosen by taxpayer, the Department shall adjust  
	 the refund available against the outstanding demand and if any refund is  
	 available after such adjustment, the same is issued to the taxpayer. Post  
	 adjustment, a communication (Communication for adjustment of refund  
	 against demand) is sent to the taxpayer by E mail mode to the latest email  
	 ID, giving the details of the outstanding demands adjusted against the refund.

8.5.2.17. If the taxpayer chooses ‘Demand is partially correct’ or ‘Disagree’ options,  
	 then what is the action taken by the Department?

Ans:	 If the taxpayer chooses ‘Demand is partially correct’ or ‘Disagree’ option,  
	 then Department is required to send a communication to the AO, to examine  
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	 the response by referring to the records and confirm if the response of the  
	 taxpayer is required to be considered or not.

8.5.2.18.	What is the time limit for the AO to respond to the communication giving  
	 the details of disagreement of taxpayer?

Ans.: 	 AO is required to respond to the communication sent within 30 days of  
	 issuance of such communication by providing the response on the system  
	 provided for this purpose.

8.5.2.19.	How the adjustment shall happen for those demands where taxpayer acted  
	 with ‘Demand is partially correct’ or ‘Disagree’ options?

Ans:	 AO is required to confirm whether to accept the reason for disagreement of  
	 the taxpayer with respect to the outstanding demand.

	 (a)	 If AO confirms that reason for disagreement by the taxpayer is valid 
			   by responding on the system, then the Department is required to  
			   release the refund to the taxpayer without making any adjustment.

	 (b)	 If AO confirms that reason for disagreement by the taxpayer is not  
			   correct and the ‘Demand is collectible’, then the Department is required  
			   to adjust the outstanding demand against the refund and release the  
			   net refund, if any.

8.6.	 FAQs on Demand

8.6.1.	 Whom should I approach to rectify the demand amount?  

	 The return has been processed at CPC: 

	 File online Rectification to CPC by logging into https://www. 
	 incometaxindiaefiling.gov.in with your user ID and password. Select  
	 “Rectification request” under My Account tab and enter the necessary details. 

	 The return has been processed by Assessing Officer: 

	 Kindly file a rectification application u/s 154 with the Jurisdictional 
	 Assessing Officer. 

8.6.2.	 How to know my Jurisdictional Assessing Officer details?

	 To know your Jurisdictional Assessing Officer details -> Please log on to  
	 https://www.incometaxindiaefiling.gov.in and click on “Know Your  
	 Jurisdictional AO” under “SERVICES” menu. 

8.6.3.	 Where can I view the details of tax payment and TDS deducted? 

	 The tax payment and TDS data available with the Department can be seen  
	 in the Form 26AS statement. To check the 26AS statement please login  
	 to your e-filing account at https://www.incometaxindiaefiling.gov.in and go  
	 to “My Account -> View form 26AS (Tax Credit)” 

8.6.4.	 How can I make payment for the outstanding demand?  
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	 Tax payments can be made through a bank authorized to collect Income  
	 Tax payments, after filling in the necessary particulars in the Challan provided  
	 for this purpose or Online tax payments can be made through the website  
	 www.incometaxindia.gov.in under ‘e- Pay Taxes. 

	 Please make the payment quoting minor head “400” only, as wrong minor  
	 head may delay the process of settlement of the outstanding demands.  

	 Challan Status: You can ascertain the status of your payment Challan through  
	 the website https://tin.tin.nsdl.com/oltas/index.html.These payment will  
	 also be reflected in Form 26 AS statement. Please refer question No 3 for  
	 further details on Form 26AS. 

8.6.5.	 I have made an error while making the payment through challan, how can it  
	 be corrected?  

	 In case you detect any mistake in the Challan after payment of the amounts  
	 you may approach the concerned bank branch within 7 days of payment  
	 for necessary correction in the challan. If the changes are to be made after  
	 7 days of payment, kindly communicate via email with the Assessing officer  
	 for the correction.

8.6.6.	 Consequences for non-payment of tax demand? 

	 Nonpayment of tax demand attracts penalty and prosecution as per the  
	 provisions of the Income Tax Act,1961 along with proceedings for recovery  
	 listed in Chapter XVII-D of the Income Tax Act, 1961. 

	 You are also liable to pay simple interest at the rate of one per cent for every  
	 month or part of a month for the period of default in accordance with section  
	 220(2) of Income Tax Act, 1961. 

8.6.7.	 How can I request for a copy of the order passed by CPC? 

	 In case you require the intimation order to be resent to you, please log 
	 on to https://www.incometaxindiaefiling.gov.in with your User ID and Password.

	 Go to My Account tab 

	 Request for intimation u/s 143(1)/ 154.  

	 The request can also be placed through CPC call center (Ph. No: 18004252229).

8.6.8.	 ‘Protective Assessment’ results in only a ‘paper demand’ which is not  
	 enforceable - so long as the assessment remains protective. However,  
	 CPC makes adjustment of refund even in cases where additions has been  
	 made on protective basis.

Ans.:	 Adjustment of refund against open demand will be duly made by sending  
	 245 notice to taxpayer and AO. If the demand is on protective basis, then  
	 appropriate comment needs to be provided by the taxpayer as soon as the  
	 demand is created by using the e-filing portal, so that the same is shared  
	 with AO and AO can confirm the same.
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CHAPTER 9

REFUNDS TO 
LEGAL HEIR

As legal requirement, a Legal heir is the individual appointed by law to succeed to 
the estate of an ancestor who died. It is commonly used today in reference to any 
individual who succeeds to property, either by will or law. 

9.2.	 When the taxpayer expires then the refund will be issued to the Legal  
	 heir. These Legal heirs are required to register themselves on the e-filing  
	 portal for purpose of filing any ITR or documents if needed. In order to  
	 claim any failed refund, they are required to send the documents to CPC as  
	 per the proforma issued by CPC in this regard. Once the documents are  
	 received at CPC, they are forwarded to the AO, who will process the paper  
	 in the ITBA system and share the Bank Account of the legal heir to whom  
	 refund of the deceased person is required to be transmitted. Once the bank  
	 account details are received at CPC via the interface with ITBA, CPC system  
	 transmits the refund of deceased person to the bank account of the legal  
	 heir as confirmed by the AO in ITBA system.

9.3.	 The procedure to key the Legal heir’s data is as follows:

Step1:	 Enter the PAN of the assessee in the PAN number field and click on submit. 

Step 2:	 When clicked on submit the above image is seen, and then now click on edit  
	 which will link you to another page as below.

Step 3:	 Now click on View, which will again link you to the page where in you will  
	 have to update the Legal Heir Communication Details.
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Step 4:	 Now enter the complete data given by the Legal Heir by looking into the  
	 image (Letter sent by Legal Heir), and click on to the tab below “Authorize  
	 capture of Legal Heir Details “which saves the data automatically. 

9.4.	 Communication to Legal Heir and JAO: The Intimation which is sent to Legal  
	 heir is called as L1 communication. The Intimation which is sent to the As 
	 sessing officer is L3 communication. These communications indicate the  
	 activity to be performed by the axpayer and AO with regard to confirmation  
	 of the Legal Heir bank account details.

9.5.	 The data entered by Refund team will be moved to AST table and the AO’s  
	 (Assessing Officer) will verify the details, update the Nominee’s Account  
	 Details and Re-initiate the Valid cases.

9.6.	 These Valid Cases will be sent back to FAS team in CPC which is also termed  
	 as reverse AO Approved Legal Heir feed, which is then validated and sent to  
	 the Refund Banker. The Banker (SBI) will Release the Refund to the concerned  
	 Legal Heir person.

9.7.	 FAQs on Legal Heir related matters

9.7.1.	 Can a LEGAL HEIR e-File the Income Tax Return of the deceased assessee?

Ans.:	 Yes. A Legal Heir can file Income Tax Return and view e-Filed Returns/Forms  
	 of the deceased person. 

9.7.2.	 How can I register myself as a LEGAL HEIR for a deceased person?

Ans.:	 Please refer under General Help --> Register as Representative section for  
	 complete details 

9.7.3.	 Once registered as a Legal Heir, can I e-File for the deceased person for  
	 compulsory DSC cases?

Ans.:	 Yes. Digital Signature Certificate (DSC) of Legal Heir can be used for the  
	 deceased person.

9.7.4.	 I am assigned as a Legal Heir for a deceased person. While uploading the  
	 Income Tax Return of the deceased, I am getting an error “PAN mentioned 
	 on Personal Information/Verification section is invalid”. What do I do?

Ans.:	 Please ensure that the PAN entered in the Verification section of the Income  
	 Tax Return is yours (Legal heir) PAN and not of the deceased person. 

9.7.5.	 For legal heir cases can taxpayer Pre-validate the legal heir account and file  
	 the refund reissue or needs to send the documents to CPC manually?

Ans.:	 Yes, when refund fails, for re-issue of refund in the name of legal heir, 
	 he needs to send the documents to CPC manually to initiating the legal heir  
	 proceedings. Pre-Validating the bank account is necessary issue the refund.

9.7.6.	 If there is no registered WILL left by the assessee, obtaining succession  
	 certificate takes time. By the time succession certificate is obtained ITR  
	 becomes time barred. The process should be easy. The legal representative  
	 can be any of the following i) Any relative as defined in section 2 (41) should  
	 be allowed to file ITR?

Ans.:	 Taxpayer is at liberty to choose any of the relative as Legal heir. Legal heir  
	 registration process on e-filing caters to this query and gives enough  
	 room for the taxpayer to register as legal heir and complete list of documents  
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	 is already published in e-filing portal under Help tab->Register as Legal  
	 Heir under Representative section. All the documents mentioned are  
	 mandatory to process the return further.

9.7.7.	 In case of clubbing of income of deceased husband by his wife. The income  
	 of the husband is clubbed in wife hand -ITR, but TDS of husband was  
	 reflecting in HUSBAND 26AS. Due to NON REFLECTION OF credit of  
	 husband TDS in wife pan (26AS). Demand is created. How to resolve this issue?

Ans.:	 In the ITR form, taxpayer has the option to claim the TDS credit as ‘Name of  
	 others’ in schedule TDS 2, by mentioning others PAN in which TDS credit 
	 is deducted. The taxpayer in above case, can select ‘others’, quote the PAN  
	 of husband and claim the TDS available against that PAN as per Form 26AS  
	 of the PAN, same will be allowed while processing of the ITR.
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CHAPTER 10

REFUNDS TO 
REPRESENTATIVES

10.1.	 Section’s 140, 159, 160,168,176, 178 etc. of the Income Tax Act, 1961 envisages  
	 many situations where a person would not be able to attend to their Income  
	 Tax related affairs on their own. In such cases, their guardian or any other  
	 competent person can act on their behalf with specific authorization. 

10.2.	 Under the circumstances mentioned below, a user can register as  
	 representative of another person for carrying out their activities in e-filing portal.

Prerequisite

10.3.	 The following table represents the categories available for applicable user type:

Categories of Assesses Who shall Register as ‘Representative’

Mentally incapacitated Guardian / Manager who is managing the affairs of such person

Deceased (Legal heir) Legal heir of the deceased person

Minor Guardian / Manager who is managing the affairs of such person

Lunatic or Idiot Guardian / Manager who is managing the affairs of such person

As Court of Wards etc.
Administrator General / Official Trustee / Receiver / Manager who 
manages the property

Trust in Writing Trustee

Oral Trust Trustee

Representative agent 
of a Non-resident

1.
Person employed by or on behalf of the 
non-resident

2. Person who has any business connection with the non-resident

3.
Person from or through whom the non-resident 
is in receipt of any income, whether directly 
or indirectly

4. Person who is the trustee of the non-resident
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10.4.	 Perform the following steps to register yourself on behalf of another person:

Step 1 Logon to 'e-filing' Portal www.incometaxindiaefiling.gov.in 

Step 2
Go to the 'My Account' menu located at upper-left side of the page ⇒ 
Click 'Register as Representative' 

Step 3
Select the 'Request Type' as 'New Request' and Select the applicable 
'Category to Register' --> Click 'Proceed'

Step 4
Enter the necessary details in the appropriate fields and attach the nec-
essary supporting documents based on category.

Step 5
Click 'Submit' A Success Message will be displayed confirming the sub-
mission of Register as Representative Request

Note:

Request will be sent to the e-filing Admin for approval. The e-filing Ad-
min will check the authenticity of the request details and may Approve/
Reject the request and Upon Approval/Rejection, an e-mail and SMS will 
be sent to the user who raised the request. 

10.5.	 The following table represents the types of documents and information one  
	 has to submit and furnish while registering to act as a representative:

Category
Documents Required to be 

submitted while making request
Details required to be provided 

in the portal

Mentally 
Incapacitated

• Copy of the PAN card of 
Mentally Incapacitated

• PAN of the Mentally 
Incapacitated

• Copy of the PAN card of the 
person who is representing on 
behalf of the incapacitated

• Date of Birth of the Mentally 
Incapacitated

• Medical Certificate issued by 
Authorized Medical Authority 
certifying the mental 
incapacitation of the represented.

• Surname of the Mentally 
Incapacitated

• Middle Name of the Mentally 
Incapacitated

[Click here for details] • First Name of the Mentally 
Incapacitated

Deceased 
(Legal Heir)

• Copy of the PAN card of Deceased • PAN of the Deceased

• Copy of the PAN card of the legal 
heir

• Date of Death

• Copy of Death Certificate • Surname of the deceased

• Copy of Legal Heir Proof as per 
the norms mentioned 
in e-filing portal

• Middle Name of the deceased

• Copy of the order passed in the 
name of the deceased (Mandatory 
only if the reason for registration 
is ‘Filing of an appeal against an 
order passed in the name 
of deceased’).

• First Name of the deceased

• Copy of the order /notice 
(Mandatory only if the reason for 
registration is ‘Filing of return of 
income/form of period in which 
deceased was alive through 
condonation request’ (or) ‘A 
notice/order received from Income 
Tax Department in the name of the 
applicant for compliance on behalf 
of a deceased’)

• Bank account details of 
Legal heir
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The following documents are 
accepted as Legal Heir proof 
(Any one from below):

Note: The user should select 
the ‘Reason for Registration’ if 
the date of death entered is for 
a period for which return filing 
timelines have lapsed u/s 139. 

• Legal Heir Certificate issued 
by Court of Law /Local 
Revenue Authority.

• Surviving family member 
certificate issued by the Local 
Revenue Authority.

• Family Pension certificate issued 
by Central/State Government.

• Registered will.

• Letter issued by the banking 
or Financial Institution in their 
letter head, with official seal 
and signature mentioning the 
particulars of nominee or joint 
account holder to the account of 
the deceased at the time demise.

Note: All the mandatory 
documents should be uploaded 
only in PDF format. 

Minor • Copy of the PAN card of Minor • PAN of the Minor

• Copy of the PAN card of the 
parent/ guardian

• Date of Birth of the Minor

• Proof of income as arises or 
accrues to the minor child on 
account of manual work done 
by child or activity involving 
application of skill, talent or 
specialized knowledge and 
experience of the minor 

• Surname of the Minor

• Proof of guardianship (Any one 
from below): 

• Middle Name of the Minor

o   Birth Certificate OR • First Name of the Minor

o   Passport of Minor OR • Nature of Minor’s Income

o   Court Order OR • PAN of 

o   Any other valid government    
     issued id o   Father (OR)

Note: All the mandatory 
documents should be uploaded 
only in PDF format. 

o   Mother (OR)

o   Guardian

Lunatic or Idiot • Copy of the PAN card of Lunatic 
or Idiot

• PAN of the Lunatic or Idiot

• Copy of the PAN card of the 
person who is representing on 
behalf of the incapacitated

• Date of Birth of the Lunatic 
or Idiot

• Certificate issued by Authorized 
Medical Authority. [Click here 
for details] 

• Surname of the Lunatic or Idiot

• Middle Name of the Lunatic 
or Idiot

• First Name of the Lunatic or Idiot
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As Court of 
Wards etc.

• Copy of the PAN card of the 
Person for whom Court of wards 
etc. is appointed

• PAN of the Person for whom 
Court of wards etc. is appointed

• Copy of PAN card of the Court 
of wards/ Receiver/Manager/ 
Administrator General/Official 
Trustee

• Surname of the Person for whom 
Court of wards etc. is appointed

• Middle Name of the Person for 
whom Court of wards etc. is 
appointed

• Copy of Court Order appointing 
Court of wards/ Receiver/
Manager/ Administrator General/
Official Trustee

• First Name of the Person for 
whom Court of wards etc. is 
appointed

• Date of Birth of the Person for 
whom Court of wards etc. is 
appointed

Trust in Writing • Copy of the PAN card of the 
Beneficiary of Trust in writing

• PAN of the Trust in writing

• Date of Incorporation of the 
Trust in writing

• PAN of the Trustee

•  Copy of the PAN card of trustee • Surname of the Trustee

• Middle Name of the Trustee

• First Name of the Trustee

• Copy of Registered Trust Deed • Date of Birth of the Trustee

• PAN of the Beneficiary

• Surname of the Beneficiary

• Copy of PAN card of the Trust 
in Writing

• Middle Name of the Beneficiary

• First Name of the Beneficiary

• Date of Birth of the Beneficiary

Oral Trust • Copy of PAN card of the 
Beneficiary of oral trust.

• PAN of the Oral Trust

• Date of Incorporation of the Oral 
Trust

• PAN of the Trustee

• Copy of PAN card of the trustee • Date of Birth of the Trustee

• Surname of the Trustee

• Middle Name of the Trustee

• Copy of PAN card of the Oral Trust • First Name of the Trustee

• PAN of the Beneficiary

• Surname of the Beneficiary

• Self-attested copy of Declaration 
made by the Trustee. 

• Middle Name of the Beneficiary

• First Name of the Beneficiary

• Date of Birth of the Beneficiary

Representative 
agent of a 
Non- resident

• Copy of the PAN card of 
Non-resident person/entity

• PAN allotted with respect of Tax 
Protected contract with Non-
resident person/entity• Copy of the PAN card of the 

resident representative agent

• Documentary proof of Tax 
protected contract wherein 
Resident is being held responsible 
for tax payment and well as return 
filing compliance requirement of 
the Non-resident 

• Name as in PAN 
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10.6.	 The following mentioned table gives portal access rights that each type of user  
	 will get when they are representing another person or being represented 
	 by another person:

Status 
of the 

assessee
Circumstance Who can sign 

the ITR/Form

Types of access 
to be given to 

represented signatory

Types of access 
to be given 
to Taxpayer

Individual Mentally 
Incapacitated

Guardian 
or Other 

competent 
person

Full Access except 
‘Profile Settings’, 
‘Authorize another 
person to act on behalf 
of self Or Register to 
act on behalf of another 
person’, ‘Register 
as Representative’ 
functionalities up to 
the date of revocation 
by e-filing admin. 
Thereafter, only 
view and download 
option of all forms/
returns uploaded in 
the capacity of Person 
Competent to Verify 

No access. However, 
on becoming sane, 
the user can seek 
for revocation of 
Guardian to ITD 
admin by providing 
the necessary 
medical records. On 
revocation, the user 
can register, if not 
registered earlier. If 
already registered, 
then the e-filing 
account shall be 
activated by ITD 
admin.

Individual Deceased Legal Heir

Full Access except 
‘Profile Settings’, 
‘Authorize another 
person to act on behalf 
of self Or Register to 
act on behalf of another 
person’, ‘Register 
as Representative’ 
functionalities for the 
period of authorization. 
Thereafter, only 
view and download 
option of all forms/
returns uploaded in 
the capacity of Person 
Competent to Verify

Account Deactivated.

Individual Minor

Guardian 
or Other 

competent 
person

Full Access except 
‘Profile Settings’, 
‘Authorize another 
person to act on behalf 
of self Or Register to 
act on behalf of another 
person’, ‘Register 
as Representative’ 
functionalities up to the 
date of minor becoming 
a major. Thereafter, only 
view and download 
option of all forms/
returns uploaded in 
the capacity of Person 
Competent to Verify.

No Access, as 
not competent to 
Register. On the day 
of becoming Major, 
the user will be 
allowed to register.

Once minor becomes 
a major, he/she 
shall be permitted 
to upload returns 
or revise returns of 
years when he/she 
was a minor.
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Individual Lunatic or 
Idiot

Guardian or 
Other 

competent 
person 

Full Access except 
‘Profile Settings’, 
‘Authorize another 
person to act on behalf 
of self Or Register to 
act on behalf of another 
person’, ‘Register 
as Representative’ 
functionalities up to 
the date of revocation 
by e-filing admin. 
Thereafter, only view and 
download option of all 
forms/returns uploaded 
in the capacity of Person 
Competent to Verify

No access. However, 
on becoming sane, 
the user can seek 
for revocation of 
Guardian to ITD 
admin by providing 
the necessary 
medical records 
through email or any 
other modes.

On revocation, the 
user can register, 
if not registered 
earlier. If already 
registered, then the 
e-filing account shall 
be activated by ITD 
admin.

Individual

Persons for 
whom Court 
of wards etc. 
is appointed

Court of Ward/
Receiver/
Manager/

Administrator 
General/ 

Official Trustee 

Full Access except 
‘Profile Settings’, 
‘Authorize another 
person to act on behalf 
of self Or Register to 
act on behalf of another 
person’, ‘Register 
as Representative’ 
functionalities up to 
the date of revocation 
by e-filing admin. 
Thereafter, only view and 
download option of all 
forms/returns uploaded 
in the capacity of Person 
Competent to Verify

Only View of all 
returns/forms 
uploaded when 
a Representative 
assessee is present.

Individual Trust in 
Writing Trustee

Full Access except 
‘Profile Settings’, 
‘Authorize another 
person to act on behalf 
of self Or Register to 
act on behalf of another 
person’, ‘Register 
as Representative’ 
functionalities up to 
the date of revocation 
by e-filing admin. 
Thereafter, only view and 
download option of all 
forms/returns uploaded 
in the capacity of Person 
Competent to Verify

Only View of all 
returns/forms 
uploaded when 
a Representative 
Assessee is present.

Individual Oral Trust Trustee

Full Access except 
‘Profile Settings’, 
‘Authorize another 
person to act on behalf 
of self Or Register to 
act on behalf of another 
person’, ‘Register 
as Representative’ 
functionalities up to 
the date of revocation 
by e-filing admin. 
Thereafter, only view and 
download option of all 
forms/returns uploaded 
in the capacity of Person 
Competent to Verify

Only View of all 
returns/forms 
uploaded when 
a Representative 
Assessee is present.
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CHAPTER 11

REFUNDS TO 
FOREIGN NATIONALS 

AND ENTITIES

11.1.	 FAQs: Non-residents and Foreign entities

11.1.1.	 Whether the refund can be credited to foreign Bank Account? 

Ans.:	 Currently, Refunds can be credited only to a bank account located in India. 

11.1.2.	 I am a Non- Resident User. I do not have a Mobile Number in India. How do  
	 I register in e-filing?

Ans.:	 A non-resident user can provide a foreign mobile number along with email ID  
	 while registration. But, all the relevant verification PINs/OTPs communications  
	 will be shared to only email ID.

11.1.3.	 The Principal Contact of my Company/Firm is a Foreigner/Non-resident and  
	 does not have a PAN and hence, not able to register in the new e-filing  
	 Application. What should be done?

Ans.:	 While registering with the e-filing portal, click on the checkbox ‘I am a Non- 
	 Resident Director without a PAN’ and proceed with the registration process  
	 without entering the PAN of the Principal Contact. 

11.1.4.	 The Principal Contact of my Company/Firm does not have a PAN. The  
	 Digital Signature Certificate (DSC) of the Principal Contact is with a default  
	 PAN. When I try to upload/register the DSC, PAN mismatch error comes  
	 up. What to do?

Ans.:	 Digital Signature Certificate with default PAN will not be accepted by the e-filing  
	 application. In this case, the Digital Signature Certificate without PAN encryption  
	 should be used. 

11.1.5.	 The Principal Contact of my Company/Firm is a Foreigner/Non-resident,  
	 how should the XML of the ITR be generated, because of verification in the  
	 return requires for a PAN to be filled up?

Ans.:	 If the Principal contact of the Company/Firm is registered as ‘Non Resident  
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	 Director without PAN’ then you should use default PAN ‘FFFPF9999F’ in the  
	 verification section of the ITR to generate and upload the XML seamlessly. It is  
	 again clarified, that the default PAN can be used only for the verification field  
	 and DSC with default PAN will not be accepted.

11.1.6.	 For Individual NRI cases what is the procedure to Pre-validate explain with  
	 the process flow or they have to send the response sheet to CPC?

Ans:	 There is no separate process for NRI tax payer. Hence tax payer a/c needs to be  
	 validated by e-filing (Pre-validated) or by NPCI for issuing of refunds.

11.1.7.	 For Foreign company’s cases what is the procedure to Pre-validate explain  
	 with the process flow or they have to send the response sheet to CPC?

Ans:	 For any Foreign company, they should have Indian bank a/c & the same should  
	 be Pre-validated by e-filing or by NPCI for issuing of refunds.
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CHAPTER 12

REFUND FAILURE 
AND REFUND REISSUE 

TO TAXPAYER

12.1.	 There are Two Types of Refund Failures handling processes at CPC:

	 The failure of refunds can be classified into two categories.

	 •	 Failure in FAS (CPC). This process caters to cases where refund transmission  
		  itself is not possible.

	 •	 Failure at Refund Banker (SBI Bank). This process caters to cases where  
		  refund transmission succeeded but refund was not credited by Banker to  
		  the destination bank account due to reasons provided by such destination  
		  bank to the refund banker.

12.2.	 The Refund Failed in FAS (CPC)

	 There are pre-checks done at FAS which help in capturing those ITRs which  
	 do not meet the criteria for processing of refunds. The below is the list of failure  
	 due to Bank Account validations.

	 For this below failure status will be “Error in refund banker” with this below  
	 reason code & communication will triggered with respective description  
	 mentioned below along with failed bank account number & IFSC code.

	 a)	153: “Invalid IFSC Code”: Refund is failed due to tax payer has provided  
		  Invalid IFSC code.

	 b)	154: “PAN name is not matching with account name’

	 This below name matching will be applied to between PAN name & Bank name.

New Name Matching Logic

Matching ID Name Match Percent Remarks

M0 100% 100% matching

MI >85% Match by Initials

M0a >85% Match >85%

M0b >80% Match >80%

MX Unmatched failed

M1 Unmatched failed



CPC HANDBOOK NOV 2020 117

	 c)	155: ‘PAN not linked to the Account’: The sub reasons provided by the NPCI  
		  for the Bank accounts provided by the tax payer.

	 d)	156: ‘Bank account needs validation through ECS Mandate form’.

	 e)	157: ‘Bank account not validated’

12.3.	 Refund Failure at Refund Banker:

	 The actions that would be taken in the CPC system for unpaid refunds are  
	 updated by the Refund Banker.  The codes updated by refund banker through  
	 the feed updated in NSDL are described below. The stated action  
	 is triggered only when the status is ‘’UNPAID’’ and the ‘’reason code ‘’  
	 as mentioned below.

S No Sub Reason Error Description

1
Account frozen or blocked so 
refund cannot be credited

The Bank Account is frozen, refund 
cannot be credited for this account.

2 Account closed The Bank Account is in closed status

3
Account in zero balance and no 
transaction has happened

The Bank Account is in Zero 
Balance and no transaction has 
happened. Hence refund cannot be 
credited

4
Account under litigation so 
refund cannot be credited

The Bank Account is under 
litigation, hence refund cannot be 
credited

5 Invalid account status
The Bank Account status is invalid 
hence refund cannot be credited to 
this account

6
Invalid account type or refund 
cannot be credited to this 
account type

The Type of Bank Account 
provided in the return is not eligible 
for crediting the refund

7 Invalid IFSC code
IFSC Code mentioned for the Bank 
Account is Invalid

8 PAN is mismatch
The PAN linked to the Bank 
Account is different or not 
matching

9 PAN is missing
PAN is not linked to the Bank 
Account

10
PAN is missing in the NPCI 
response feed

PAN is not linked to the Bank 
Account

11 PFMS/NPCI invalid case Invalid Bank Account

12 No such account No Such Account

Code Reason Description

12 Incorrect A/C No.

20 Account has been closed

21 Account Description incorrect

22 Others

23 Stop Payment
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12.4.	 Communications are sent to taxpayers by email.

12.5.	 Resolution: In all the above scenarios assessee will be intimated about  
	 the failure of refund and procedure of the same is explained below:

	 A Refund failure communication will be sent by the system. The Assessee  
	 has to file the online refund reissue request in e-filing by pre-Validating  
	 the bank account details.

12.6.	 Process steps to be undertaken by the taxpayer for refund reissue in the  
	 e-filing portal.

	 A.	Refund shall be issued to the Pre-validated bank account only. 

	 B.	In case of refund failure, taxpayer can raise the service request in e-filing  
		  portal upon receiving communication from CPC. 

12.7.	 The steps to raise Refund Re-Issue Request:

Step 1 Logon to ‘e-filing’ Portal www.incometaxindiaefiling.gov.in 

Step 2 Click on ‘My Account’ menu and click ‘Service Request’ link. 

Step 3
Select the ‘Request Type’ as ‘New Request’ and Select the ‘Request Category’ 
as ‘Refund Reissue’. Click ‘Submit’.

Step 4
Details such as PAN, Return Type, Assessment Year (A.Y), Acknowledgement 
No, Communication Reference Number, Reason for Refund Failure and 
Response are displayed. 

Step 5
Click ‘Submit’ hyperlink located under ‘Response’ column. All the 
Pre-validated bank accounts with status validated/validated and EVC enabled 
will be displayed. 

Step 6
Select the bank account to which the tax refund is to be credited and click 
‘Continue’. Details such as Bank Account Number, IFSC, Bank Name and 
Account Type are displayed for the taxpayer to cross verify the same.

Note : If the taxpayer does not have any Pre-validated bank accounts, then the 
taxpayer is directed to Pre-validate bank account Screen. In this screen the tax 
payer should enter all relevant details of the bank account where he intends 
receive refund and click on ‘Pre-validate’ button to proceed with the request 
submission. After this Account is Pre-validated by the concerned bank, the 
bank account will be automatically considered for refund re-issue. This account 
will now be displayed under Pre-validated bank accounts in the e-filing portal.

In case the Pre-validation of account fails, then the same will be communicated 
to the taxpayer by CPC. The taxpayer is required to resubmit the request for 
refund re-issue/Pre-validation of bank account. 

Step 7

Click ‘OK’ in popup if the details are correct and the options for e-Verification 
appears in the dialogue box. Choose the appropriate mode of e-Verification, 
Generate and enter Electronic Verification Code (EVC)/Aadhaar OTP as 
applicable to proceed with the request submission.

Note
If Digital Signature Certificate (DSC) is registered in the profile, generate the 
signature file by downloading the ‘DSC Management Utility’ and upload the 
same to proceed with the submission.

Step 8
A success message will be displayed confirming the Refund Re-issue 
request submission.

Step 9 To View the status of submitted Refund Re-issue, Click here to know more

12.8.	 Steps to check the Refund status in CPC portal for reissue after receiving  
	 request from taxpayer:

	 If the reissue is for other than the above reasons, then the following steps  
	 are taken up:
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	 Log in the CPC portal under processing status tab enter the pan:

	 •	 If the Processing Status shows ‘Refund Paid’, ‘Transferred to AST for  
		  Processing’, ‘No demand No Refund’,’ Demand Sent’, ‘Full RO Adjustment’,  
		  then such cases will be Rejected in the mailroom portal.

	 •	 If the Refund status shows, ‘Refund cheque dispatched’, ‘Re-issue initiated’,  
		  ‘Re-issue approved’, ‘Refund/Re-issue initiated’, then these cases would  
		  be put on Hold as the status may change in future to make necessary changes.

	 •	 If the data is not found in Processing Status and in the Assessee summary  
		  data as well then it is rejected with a comment ‘ITR Not Processed in CPC’.

	 •	 If the Accounting process is not completed such as ‘FAS Posting  
		  Completed’, ‘Refund Threshold Hold’ then the rejection comment would  
		  be ‘ITR Under Processing’

12.9.	 Refund Re-Issue Requests will not be accepted for this below 
	 following reasons: -

	 •	 Defective Return.		  •	 Demand Raised.

	 •	 Full RO Adjustment.		  •	 ITR Not Processed in CPC.

	 •	 ITR Not Processed Yet.		  •	 ITR under Processing.

	 •	 NDNR.		  •	 Refund Cancelled.

	 •	 Refund Determined.		  •	 Refund Paid.

	 •	 Sent for Re-Issue Approval.		  •	 Stop Payment.

	 •	 Transferred to AST (Legal Heir).		 •	 Transferred to AST for Processing.

12.10.	 Refund Reissue Process Diagram
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12.11.	 FAQs on Refund Reissue

12.11.1.	 I have e-Filed my Income Tax Return but not received my refund till now.

Ans.:	 If you have not received refund till date, it could be due to the following  
	 reasons:1. Your Income Tax Return has not been processed yet. Once the  
	 return is processed you may receive a Refund (if determined). To check the  
	 status LOGIN and go to ‘My Account’ --> ‘View e-Filed Returns/Forms’ -->  
	 ‘e-Filed Returns/Forms’.2. Your Income Tax Return has been processed but no  
	 refund is determined.3. Your Income Tax Return has been processed, a refund  
	 has been determined, but the ECS credit failed. LOGIN and Go to ‘My Account’  
	 → ‘View e-Filed Returns/Forms ‘ → ‘e-Filed Returns/Forms’ and check the  
	 status by clicking the link provided for Acknowledgement number. 

	 4.	If refund is processed, the status of refund can also be verified in NSDL  
		  web site by providing PAN, Assessment year and captcha code

12.11.2.	 I checked the status of my IT Return and it is displayed as ‘Refund Returned’  
	 or ‘Refund Failed’. How can I apply for it again?

Ans.:	 LOGIN and go to ‘My Account’ --> ‘Service Request’ --> ‘New Request’ -->  
	 ‘Refund Re-issue request’ --> select the validated account for refund -->  
	 Submit. The submission must be e-Verified using DSC or EVC. 

12.11.3.	 If the taxpayers account number by default shows as validated, then is it  
	 necessary to do the pre-validation again? 

Ans:	 No, once if the status is showing as Validated for the Pre-validated a/c. Then  
	 there is no need to do it again.

12.11.4.	 While doing the pre-validation can the taxpayer gives the same account  
	 number as per ITR Return or can he Pre-validate the different account  
	 number as well?

Ans:	 Yes, Taxpayer can Pre-validate different account number also. However, the  
	 preference is given to bank account mentioned in the ITR. The feature to  
	 interchange of bank account in not currently available in automated mode  
	 at CPC.

12.11.5.	 In case if the taxpayer has given the second or different bank account  
	 number to which account refund will be issued? Please explain with process flow?

Ans:	 Currently for issuing of refunds, we are referring the a/c number provided in  
	 return or in the ‘Change form particulars’ option through e-filing as first. If  
	 this is not validated account or invalid account, refund will be issued to the  
	 other bank account if the bank account is validated.

12.11.6.	 Taxpayer has done the Pre-validation but the status shows as submitted  
	 from one month, let us know what information to be provided?

Ans:	 Currently, if the bank accounts submitted by taxpayer is not integrated with  
	 Income tax department, it will be shared with NPCI for verification. Once  
	 we get the response from NPCI then the same will be shared to e-filing team  
	 & status will be changed to ‘validated’ or ‘Invalidated’ from ‘submitted’ based  
	 on the NPCI response. Few banks are sharing the response late and hence,  
	 the status shows submitted.
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12.11.7.	 As per the 6th question above taxpayer has submitted the Pre-validation  
	 but it’s not validated (status shows as Submitted) however CPC has sent the  
	 failure notice what action to be taken?

Ans:	 Taxpayer need to wait and file online refund reissue request or file re-issue  
	 request by providing new bank account.  The new a/c will be validated from  
	 e-filing or through NPCI then only refund will be issued to the taxpayer.

12.11.8.	 Taxpayer bank account name is correct but while filing the return he has  
	 mentioned wrong name or “shuffled the name”, what is the procedure to  
	 claim the refund with Pre-validation?

Ans:	 Refund will be issued to the Pre-validation account irrespective of wrong  
	 name or shuffled name in the return. Taxpayer has to ensure that the PAN is  
	 seeded to the bank account.

12.11.9.	 CPC has asked for ECS Mandate Form for Partnership refund and link to  
	 download the ECS mandate is not working and also mentioned that mail  
	 is sent, but no attachment is sent with the mail. Because of this Partnership  
	 firm is facing issue.

Ans. :	 As verified, refund failure notice has been sent to taxpayer on 27th Aug  
	 2020  ECS mandate form is included in the same communication. Taxpayer  
	 need to get certified from the branch and submit ECS mandate form through  
	 post to CPC.
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CHAPTER 13

RECTIFICATION 
PROCESS AT CPC

A online facility is provided on the e-filing website : www.incometaxindiaefiling.gov.
in for taxpayer to seek rectification of the intimation u/s.143(1) or Order u/s.154.There 
are two categories of rectification namely,

	 a. Online rectification where taxpayer needs to file rectification.

	 b. Suo moto rectification by CPC in cases where additional information 
		   is received.

13.1.	 Online rectification:

	 The return filed by the taxpayer will be processed by Income Tax Department  
	 (ITD) and intimation will be sent to the assessee under section 143(1)  
	 based on details disclosed by the taxpayer and rules deployed at CPC. In  
	 case if the taxpayer wants to seek rectification of a mistake in an order  
	 or intimation which is apparent from the record, then the taxpayer can seek  
	 rectification under section 154. The processing of rectification is a fully  
	 automated system. Processed rectification and providing of reason for  
	 rectification is carried out in batches based on the initial analysis of the  
	 order sought to be issued.

13.1.1.	 CPC accords highest priority to rectifications filed by the taxpayers in the  
	 processing system. The average time for processing of rectification in general  
	 is less than 30 days from the date of filing. In cases where there is delay, the  
	 same is due to non-closure of refund process in the earlier instance is not  
	 closed or any rule change is taken up at CPC, however all orders are passed  
	 within time u/s. 154.

13.2.	 Options to file 

13.2.1.	 Tax Credit mismatch correction only

	 The facility provides for auto filling of information in the ITR if the rectification  
	 is with regard to tax credit mismatch during earlier processing, in such  
	 cases taxpayer can choose option ‘Tax Credit mismatch correction only’,  
	 this options provides a pre-filled, editable table for verifying the tax credit  
	 claims made in the ITR and correcting the information, such newly provided  
	 or corrected information will be used by the CPC along with information  
	 in ITR for processing the rectification. Taxpayer needs to be careful while  
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	 filing information and take note of the alerts given by the system and adhere  
	 to the same.

13.2.2.	 Return data Correction (XML)

	 The facility provides for filing of an xml which is corrected by the taxpayer  
	 at a schedule level. The taxpayer after making the changes needed in the  
	 XML, at the time of upload is required to indicate the nature of corrections  
	 made in the new XML by selecting the appropriate statements provided 
	 in the facility. This information is used at the time initiation or rejection 
	 of rectification.

13.2.3.	 Only reprocess the return

	 The facility provides for reprocessing of the ITR without any additional  
	 information, this is particularly used where taxpayer has got correction  
	 effected in Form 26AS or has filed Form 10E or changed any information in  
	 PAN card like gender, date of birth, etc.

13.2.4.	 Correcting Status & Sub Status

	 Considering the uniqueness of the ITR 5 and 7 (till AY 2018-19), there is a  
	 specific provision made for filing rectification by changing only the status  
	 and/or sub status of the assessee. The taxpayer needs to give additional  
	 information or reason for making the change in rectification and there is  
	 provision to file documents. The changed status will be amended in the ITR  
	 already available at CPC and rectification is carried out.

13.2.5.	 Correcting Exemption Section Details 

	 Considering the uniqueness of ITR-7 (Till AY 2018-19), there is a specific  
	 provision made for filing rectification by changing section under which  
	 exemption is sought. The taxpayer needs to give additional information or  
	 reason for making the change in rectification and there is provision to file  
	 documents. The changed section will be amended in the ITR already available  
	 at CPC and rectification is carried out.

13.2.6.	 Additional information for 234C

	 In cases where the error sought to rectified is with regard to computation of  
	 interest u/s.234C only, then taxpayer is provided a facility to seek rectification  
	 of the same by providing additional information which can be considered in  
	 processing the rectification.

13.3.	 Online rectification gets priority over suo moto rectification:

13.3.1.	 If any rectification is to be carried by CPC and suo moto is required, if  
	 taxpayer also files a rectification, then online rectification will be taken up  
	 by holding the suo moto rectification in case they are not yet initiated.
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13.3.2.	 Process flow diagram of rectification: (Pardon the small text)
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13.3.3.	 Step by step process while filing:

	 The following steps are to be followed to file the Rectification request. 

	 1.	 Logon to ‘e-filing’ Portal www.incometaxindiaefiling.gov.in

	 2.	Go to the ‘e-File’ menu located at upper-left side of the page 
		  ⇒ Click ‘Rectification’.

	 3	 Choose the options of ‘Order/Intimation to be rectified’ and ‘Assessment  
		  Year’ from the drop down list. Click ‘Continue’.

	 4. Select any one of the following options of ‘Request Type’ from drop 
		  down list. 

	 A. Tax credit mismatch correction only - On selecting this option, following  
		  check boxes will be displayed. 

	 o	 TDS on Salary Details

	 o	 TDS on Other than Salary Details

	 o	  TDS on transfer of Immovable property/Rent

	 o	 TCS Details

	 o	 IT Details

	 You may select the check box for which data needs to be corrected. 

	 You can add a maximum of 10 entries for each of the selections. No upload  
	 of an Income Tax Return is required. 

	 Note:	 This option is available only for ITR 1 for AY 2019-20. For remaining  
	 ITRs for AY 2019-20 this option is not available, so the assessee should use  
	 Return Data Correction (XML) option for rectifying tax credit mismatch. 

	 B.	Return data Correction (XML) - Select the following 

	 o	 Reason for Rectification by clicking the button made available. (maximum  
		  of 4 reasons)

	 o	 Schedules being changed

	 o	 Donation and Capital gain details (if applicable)

	 o	 Upload XML, and 

	 o	 Digital Signature Certificate (DSC) (if available and applicable) 

	 Note: 

	 •	 When the user is uploading XML, the Gross Total Income and Deductions  
		  amount should be the same as in the processed return.

	 •	 For AY 2018-19 the assessee should select ‘Filing Type’ as ‘Rectification’ 
		  in the ITR utility and upload the XML

	 C.	Only reprocess the return – On selecting this option, user needs to just  
		  submit the rectification request.

	 Note: User can verify the Form 26AS details under My Account ⇒ View Form  
	 26AS and Tax Credit Mismatch under My Account ⇒ Tax Credit Mismatch

	 D.	Correcting Status (Only for ITR-5 & 7) (Till AY 2018-19) - On selecting this  
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		  option, the user should select the status applicable from the displayed drop  
		  down, answer the additional questions asked and upload the necessary  
		  attachments to submit the request.

	 E.	Correcting Exemption Section Details (only for ITR-7) (Till AY 2018-19) –  
		  On Selecting this option, the user must fill in all the applicable fields and  
		  upload the necessary attachments to submit the request.

	 F.	Additional information for 234C - On Selecting this option, the user must  
		  fill in all the applicable fields to submit the request. In this type of  
		  rectification tax payer is allowed to provide additional information for pre  
		  computation of 234C. This is applicable for ITR-2, 2A, 3, 4, 4S, 5 & 6  
		  for AY 2017-18 onwards for rectification returns. The below is the format  
		  in which information obtained:

	 5.	Submit to complete the rectification request. A success message will be  
		  displayed and a mail confirming the submission of rectification request  
		  will be sent to the user’s registered mail ID.

	 6.	Withdrawal of Rectification: Taxpayer can withdraw rectification within  
		  end of the day of request.

13.4.	 Rejection of rectification

13.4.1.	 The system verifies the rectification filed by taxpayer and if there is no data  
	 change or if there is data change that is not within the meaning of ‘error  
	 apparent from record’, the rectification is rejected at the outset and  
	 a communication is sent to the taxpayers.If the rectification is rejected after  
	 re-processing of the ITR, then the rejection reason is mentioned in the order  
	 u/s. 154. The following are main reasons for rejection:

	 Rectification is in Progress: A rectification earlier filed or suo motto  
	 rectification has been initiated for the same PAN and AY is in progress.

	 Transfer to AST: If the assessee has received Rejection letter saying that,  
	 “Application for Rejection is rejected as the cases transferred to AST”. That  
	 eans the particular case is to be further taken up with the AO in ITBA and  
	 assessee needs to contact local AO for the same. 

	 Refund in Progress: If there is any Refund in the particular case is either  
	 sent for payment or failed but such information is not available in system,  

Nature of Income or gain
Upto 15/6

(i)
16/6 or 15/9

(ii)
16/9 or 15/12

(iii)
16/12 or 15/3

(iv)
16/3 or 31/3

(v)

Income from PGBP accrue or 
arise, first time (Applicable for 
2016-17 onwards)

Income Special Income 
Mentioned in 2(24)(ix) Taxable 
u/s 115BB (Category wise - Can 
be crossed check through 
Schedule - Sl)

Income Referred in section 
115BBDA (FOR THIS SUM OF 
ALL Quarters to be checked 
and it should exceed 10 lakhs 
or else nothing to be entered. 
(Applicable for 2017-18 
onwards)
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	 in such cases rectification cannot be carried out. Once the refund procedure  
	 is completed, assessee can file Re-Rectification. 

	 Revised return in Progress: A revised return for the same PAN and AY is in  
	 progress, hence rectification cannot be taken up. Taxpayer can seek  
	 rectification on the revised return processed if required.

13.5.	 Transfer of rectification rights to AO

	 In some of the cases, where rectification at CPC is not feasible due to  
	 automated environment, the rights for rectification are transferred to the  
	 AO and an intimation about such transfer is provided to taxpayer by email.  
	 AO also is provided with an option to seek rectification rights from CPC and  
	 such requests are also automated. If there is delay in transfer, the same is  
	 due to non-completion of all the processes with respect to preceding order  
	 at CPC. Taxpayer can approach AO in both e-filing mode as well as paper mode.

13.5.1.	 Trend of rectification from taxpayers:

13.6.	 Suo Moto Rectification at CPC

	 After processing of the returns, if any shortcomings are noticed in the  
	 processed cases based on the internal information at CPC, fresh updates  
	 from other interfacing systems, any change in rule due to any clarification  
	 issued by the CBDT or feedback from the taxpayers via call center or  
	 e-Nivaran grievance, an exercise is carried to identify the impacted cases.  
	 Suo Moto Rectification is carried out in such cases. In cases where suo motto  
	 rectification is not favorable to the taxpayer, an opportunity is given to the  
	 taxpayer by a communication.

	 Suo Moto rectifications are classified upon identification as ‘Favourable’  
	 or ‘not Favourable to the Assessee’. In cases where the suo motto rectification  
	 is not favourable, a communication giving an opportunity for hearing is  
	 provided to taxpayer and a time limit is 15 days. The taxpayer is required  
	 to respond to notice only through a response sheet giving consent. Suo  
	 motto rectification is carried out in all identified cases and resultant order is  
	 issued to the taxpayer.
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13.6.1.	 Class of Cases usually taken for Suo Motto Rectification:

	 Suo motto rectification is carried out in the following class of cases:

	 a)		 Fresh Tax Credits: Suo-Moto under Re-Accounting will be initiated for  
			   allowing the fresh Tax credit received to CPC after the passing the  
			   previous order for which tax credit fully/partially allowed due to non- 
			   availability at that time.

	 b)		 RO-400: Suo-Moto will be initiated for giving the refund out of 
			   RO-400 in certain class of cases.

	 c)		 Section 89 Relief: Suo-Moto will be initiated for allowing section 89  
			   relief which was not allowed earlier due to non-availability of Form 10E at  
			   the time of processing u/s.143(1).

	 d)		 Change in Tax credit Position: Suo-Moto under Re-Accounting will be  
			   initiated for giving effect to the corrected Tax Credit position in Form  
			   26AS, which required to change in Tax credit position in the CPC  
			   processed return which was allowed in the previous order.

	 e)		 New Business rule change: Suo-Moto initiating for any new Business  
			   rule change & approved from CBDT and action is taken in ITD-CPC  
			   for giving the effect to the tax returns which is already processed in  
			   CPC post implementation of the new rule.

	 f)		 Accounting issue: Any accounting issue faced during the processing  
			   for the returns post ITD approval E.g. reversal issue, matching issue &  
			   FAS issue etc. 

13.7.	 Processing of suo moto rectification is done in two types:

13.7.1.	 Suo moto rectification by re-accounting only:

	 In this type of rectification, the ITR is taken for only re-matching of tax  
	 credits in the system without any processing of determination of the total  
	 income, the processing will lead to re-consideration of the tax credits which  
	 is sync with Form 26AS as available in financial accounting system at CPC,  
	 during the rectification.

13.7.2.	 The class of cases considered under this mode are:

	 A.		 Fresh Tax Credit.

	 B.		 Section 89 Relief due to availability of Form 10E.

	 C.	RO 400.

	 D.	To consider Tax Payment under minor code 300 (SAT)

13.7.3.	 Suo moto rectification with re-processing:

	 In this type of rectification, the ITR is taken for re processing including  
	 determination of total income by applying the rules to all the parts of the  
	 ITR using the latest rules. The resultant order is required to consider the  
	 changes rules and also consider the tax credits available at that point 
	 in time.
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13.7.3.1.	 The class of cases considered under this mode are:

	 •	 Business Rule changes.

	 •	 Relaxation provided by Board like Form 10, etc.

	 The processing under suo moto rectification is similar to online rectification  
	 in all other aspects and undergoes the same steps and process flow as  
	 discussed above in the Online Rectification Process description.

13.7.4.	 Time taken for Suo Moto Rectification:

	 Suo moto rectification takes same time as online rectification and it is around  
	 45 days on average in cases where reprocessing is taken up and it is less  
	 than 30 days for re-accounting type of cases.

13.8.	 Answers to commonly asked queries on  rectification

13.8.1.	 Can Taxpayer file for Rectification application through Paper mode?

Ans.	 Paper Rectifications will be accepted in CPC only for Paper returns the 
	 A.Y. 2008-09 processed in CPC. For returns filed electronically and processed  
	 at CPC, the rectification application should be filed online only.

13.8.2.	 What are Pre-Requisites to file for Rectification request with 
	 CPC, Bangalore?

Ans.	 Pre – Requisites for Filing Rectification are as follows:

	 •	 Online Rectification will be considered provided Original Returns filed 
		  by the Tax Payer through Online.

	 •	 The Income Tax Return for the Assessment Year should have been  
		  processed in CPC, Bangalore.

	 •	 Intimation under Section 143(1) or an order Under Section 154 Passed  
		  by CPC, Bangalore for the E-filed Income Tax Returns should be available  
		  with Tax Payer.

13.8.3.	 What are the Steps involved in Filing Online Rectification?

Ans.	 Following are the Steps involved in Filing Online Rectification:

Step 1:	 LOGIN to e-filing Application and GO TO ‘My Account’, ‘Rectification Request.’

Step 2:	 Select the Assessment Year from the drop down for which Online Rectification  
	 to be filed, enter Latest Communication Reference Number (As mentioned  
	 in CPC Order) and latest CPC Order Passed Date (As mentioned in CPC Order).

Step 3:	 Select the “Rectification Request Type”:

	 * 	Taxpayer correcting Data for Tax Credit Mismatch only: Once Tax Payer  
		  clicks, three check boxes TDS, TDS and IT will be displayed. Tax Payer can  
		  select the check box for which the data needs to be corrected. Based on  
		  the selection, TDS, TCS and IT fields are displayed.

	 * 	Taxpayer is correcting the data in Rectification: Taxpayer needs to select  
		  the reason for Rectification, Schedules being Changed, Donations and  
		  details regarding Capital Gains if Upload XML.
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	 *	 No further Data Correction required, Reprocess the Case : Once Taxpayer,  
		  three Check Tax Credit Mismatch, Gender Mismatch, Tax / Interest  
		  Mismatch will be displayed. Select the Check box where Reprocessing 
		  is required.

Step 4:	 Click on “Submit” button.

Step 5: 	On successful completion, an acknowledgement number got generated and  
	 sent for Processing to CPC, Bangalore.

13.8.4.	 Which CPC Number should I update while filing Online Rectification Request?

Ans.	 You need to update the Communication Reference Number as per the Latest  
	 Order /Intimation received from CPC Under Section 143(1) or 154.

13.8.5.	 Which Order Passed Date should I update while filing Online Rectification Request?

Ans.	 You need to update the Order Passed Date as per the Latest Order /  
	 Intimation received from CPC Under Section 143(1) and 154.

13.8.6.	 I am getting error as “Incorrect details. Please enter details as per Latest  Order”  
	 while filing Online Rectification, what should I do?

Ans.	 This error occurs due to One of the following reasons:

	 •	 When you are entering below fields wrongly:

	 *	 CPC Communication Reference Number

	 *	 CPC Order Passed Date

	 •	 Ensure that you have updated the above fields correctly as per the CPC  
		  Order and also ensure that you have selected the Proper Assessment  
		  Year from the drop down.

	 •	 If a subsequent CPC Order exists, you have to file Rectification Request  
		  by using latest CPC Order Passed Date.

	 For Example: If you have received an Intimation from CPC on 14th September,  
	 2011 and another on 11th January, 2012. You can file Rectification Request  
	 using the latest CPC Order Passed Date i.e. 11th January, 2012 for the relevant  
	 assessment year.

	 •	 If you have filed a Rectification Request for the relevant assessment  
		  year and the same has been rejected by CPC. Now if you are trying to file  
		  another rectification Request using the Old CPC Communication  
		  Reference Number, then this error message exists.

13.8. 7.	 I want to file an Online Rectification under Section 154 for Tax Credit   
	 Mismatch ONLY, what should I do?

Ans.	 In this scenario, there is no need to upload XML. Select the User Type as “Tax  
	 Payer correcting data for Tax Credit Mismatch Only” from the drop down  
	 and then update proper details with respect to TDS, TCS and IT. Submit the  
	 Request. No XML upload / Submission is required.

13.8.8.	 I want to file Online Rectification Under Section 154 to correct my data,   
	 what should I do?
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Ans.	 In this scenario, there is a need for a Taxpayer to upload XML. However, 
	 as per Provisions Under Section 154, Taxpayer can file Rectification for  
	 correction of mistakes which are apparent from the record.

13.8. 9.	 I want to file Online Rectification Under Section 154 for Reprocessing 
	 by Income Tax Return, what should I do?

Ans.	 In this Scenarios, No XML upload is required. Select the User Type as  
	 “No further Data Correction is required, Reprocess the Case” and then select  
	 the respective check box such as Tax Credit Mismatch, Gender Mismatch OR  
	 Tax / Interest Mismatch accordingly.

13.8. 10. How can I see the “Status of the Rectification Request”?

Ans.	 LOGIN and GO TO “My Account” and then GO TO “Rectification Status”.

13.8.11.	 My e-Filed Income Tax Return has been processed by CPC raising a demand  
	 OR less Refund, whom should I approach for Rectification?

Ans.	 In case your Income Tax Return for the relevant assessment year is Processed  
	 by CPC, then Taxpayer can file Rectification with CPC. In case if the  
	 Rectification Request has already been transferred to AST, then Tax Payer  
	 has to file Rectification Application on Paper.

	 In order to know whether rights are with CPC or AO, the Tax Payer should  
	 LOGIN and GO TO “My Account” and then GO TO “My Returns / Forms” and  
	 Check the Status.

13.8.12.	 If I have uploaded wrong Rectification Request, what is the Procedure for  
	 the Correction?

Ans.	 You can withdraw the Rectification Application within 7 days from the Date  
	 of Filing the Rectification Request. In order to withdraw the Rectification  
	 Application, LOGIN and GO TO “May Account” and then “Rectification Status”.

13.8. 13.	 In case if I have filed Income Tax Return with One ITR, can I rectify the same  
	 with different ITR Form?

Ans.	 No, for the purpose of rectification, form type cannot be changed. To change  
	 form type, Taxpayer has to exercise option of “revision of Return”.

13.8.14.	 The demand raised by CPC has been paid by me, Do I need to file Rectification  
	 Request in order to nullify the Demand?

Ans.	 No. There is no need for you to file Rectification Request, the demand will  
	 be automatically reduced.

13.8. 15.	For the A.Y.2009 – 10 I have Demand and for the A.Y.2010 – 11 I have arrived  
	 at Refund and that Refund has got adjusted with the Demand of A.Y.2009  
	 – 10. Demand raised for the A.Y.2009 – 10 has been already paid off, what  
	 should I do in order to get refund which is wrongly adjusted?

Ans.	 Apply for Rectification for the A.Y.2009 – 10.

13.8.16.	 How many times can I file Rectification?

Ans.	 Legally, a return can be rectified any number of times before the expiry of  
	 four years from Original Order Passed Date.
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13.8.17.	 Deductions Under Chapter VIA has not been allowed while Processing the  
	 Income Tax Return by CPC?

Ans.	 Check whether relevant information is furnished by you in Schedule Chapter  
	 VIA as well as in Part BTI at the time of filing Income Tax Return. If Yes,  
	 select User type as “No further Data Correction is required, Reprocess the  
	 case”. If No, upload new XML OR amend the latest XML after verifying the  
	 Order Passed by CPC.

13.8.18.	 Deductions under Chapter VIA have not been allowed while processing the  
	 Income Tax Return by CPC as Normal Income not disclosed?

Ans.	 You have to file Revised Return in case if the Original Return is filed within  
	 the due date OR Time limit to file Revised Return is not exceeded. Rectification  
	 is the Process for correcting the mistakes which is apparent from the Records.

13.8.19.	 Credit for Tax Payments has not been allowed by CPC at the time of  
	 Processing the Income Tax Return, what should I do?

Ans.	 First step is to check whether the details mentioned by you in Schedule TDS,  
	 TCS OR IT is correct or not. If Yes, select user type as “No further Data  
	 Correction is required, Reprocess the case”. In No, upload new XML OR  
	 amend the latest XML after verifying the Order Passed by CPC. 

	 In case if there is no issue with the Tax Credits in the earlier Income Tax Return,  
	 however the credit was not allowed in the latest Rectification Order Processed  
	 by CPC, then verify the Order passed by CPC and ensure the correctness  
	 of the data in the latest XML already processed by the CPC. If the data  
	 mentioned by you is correct, then select user type as “No further Data  
	 Correction is required, Reprocess the case”. If No, then select user type as  
	 “Tax Payer correcting the Data for Tax Credit Mismatch ONLY” and then,  
	 enter proper details with respect to Schedule TDS, TCS and IT.

	 In case if you have entered the Schedules as per the details available 
	 in 26AS and OLTAS, however the credit is not provided in the Order  
	 Processed by CPC due to Credits not available in CPC and if you have  
	 received any Communication from CPC regarding the Transfer of Rights to  
	 AST, then you have to Contact Local AO for the same instead of filing  
	 Rectification with CPC.

13.8.20.	My Gender is not correctly considered in the Order Processed by CPC, what  
	 should I do?

Ans.	 First, verify the Gender in NSDL and in the Latest XML. If the Gender 
	 in NSDL is “MALE’ then update the Gender as “FEMALE” in NSDL database  
	 before filing Online Rectification Request. 

	 Then select User Type as “No further Data Correction is required, Reprocess  
	 the case”. If the Gender is “FEMALE” in NSDL Database whereas Gender  
	 updated by you is “MALE” in the latest XML, then select User Type “Tax  
	 Payer correcting the Data in Rectification” and then correct the Gender.

13.8.21.	 I have not updated the Status Under the head Personal Information in 
	 ITR 5/ incorrectly updated, what I should I do?

Ans.	 You have to select User Type “Tax Payer correcting the Data in Rectification”  
	 and then update the Status / correct the Status in XML and ensure there are  
	 no other issues in the latest XML already Processed by CPC.
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13.8.22.	 I have not updated the Domestic Flag Under the head Personal Information  
	 in ITR 6/ incorrectly updated or not properly updated PE status, what I  
	 should I do?

Ans.	 You have to select User Type “Taxpayer correcting the Data in Rectification”  
	 and then update the Domestic Flag / correct the Domestic Flag in XML and  
	 ensure there are no other issues in the latest XML already Processed by CPC.

13.8.23.	 I have not updated the Residential Status / incorrectly updated, what 
	 I should I do?

Ans.	 You have to select User Type “Taxpayer correcting the Data in Rectification”  
	 and then update the Residential Status / correct the Residential Status in  
	 XML and ensure there are no other issues in the latest XML already Processed  
	 by CPC.

13.8.24.	My Date of Birth has been wrongly considered in the Order Processed 
	 by CPC, what should I do?

Ans.	 First verify the Date of Birth in NSDL database as well as in the latest XML  
	 uploaded by you. In case if the Date of Birth entered by you is incorrect,  
	 then change the DOB in NSDL database before filing Online Rectification  
	 Request. Then, select User Type “No further Data Correction is required,  
	 Reprocess the Case” and then submit.

	 In case, if the DOB is correct in NSDL database whereas you have updated  
	 incorrect DOB in the latest XML uploaded by you, then select User Type  
	 “Tax Payer correcting the Data in Rectification” and change the DOB and submit.

13.8.25.	 Credit for Relief Under Section 89 has not been allowed in the Order  
	 Processed by CPC as I filed Form 10E later, what should I do?

Ans.	 Select User Type “No Further Data Correction is required, Reprocess the  
	 case” and then select “Tax / Interest Mismatch Flag” then submit the Request  
	 and ensure there are no other issues in the latest order which was Processed  
	 by CPC.

13.8.26.	Rebate on Agricultural Income has been allowed as lesser as I have  
	 mentioned the Gender as “FEMALE” in the latest XML, however the Gender  
	 in NSDL database is “MALE”, what should I do?

Ans.	 You are required to Change the Gender as “FEMALE” in NSDL database  
	 before filing Online Rectification Request. Then, select User type as “No  
	 further Data Correction is required, Reprocess the Case” and then select  
	 “Status Mismatch” and submit.

13.8.27.	 Interest under Section 234A has been levied in the Order Processed 
	 by CPC, even though I have filed the Return within Due Date, what should I do?

Ans.	 First verify the Due Date and Date of Filing of the Return in the latest XML. If  
	 the Due Date /Date of Filing of the Return Original / Revised return is  
	 incorrect, then select “Tax Payer correcting the Data in Rectification” then  
	 correct Due Date / Date of Filing in the new XML and ensure there are no  
	 other issues in the Order Processed by CPC.

13.8.28.	 Interest under Section 234B has been levied in the Order Processed 
	 by CPC, even though I have paid 90% of the Prepaid Taxes, what should I do?
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Ans.	 First verify Is there is any mismatch in the Tax Credits in the Order Processed  
	 by CPC and also ensure the correctness of data in Schedule TDS, TCS  
	 and IT. If Yes, verify the Credits in 26AS and OLTAS and then select User  
	 Type “No further Data Correction is required, Reprocess the case” and then  
	 select “Tax Credit Mismatch” and then Submit.

	 In case if the details entered by you is incorrect, then select User Type “Tax  
	 Payer correcting the Data in Tax Credit ONLY” then enter details as per 
	 26A / OLTAS and then submit.

13.8.29.	 Interest Under Section 234C has been levied in the Order Processed 
	 by CPC, even though I have paid Advance Tax, what should I do?

Ans.	 Verify whether the Prepaid Taxes are paid within Due Date. If Yes, select user  
	 Type “No Further Data Correction is required, Reprocess the case” and  
	 then Submit. If the computation is for AY2017-18 onwards and due to income  
	 from dividends, a separate schedule is provided in rectification to provided  
	 date of payments where information can be provided to arrive at correct  
	 234C interest.

13.8.30. I have to Change my Heads of Income, Can I Rectification with the Changes?

Ans.	 Change of Income is not accepted in rectification; hence you have to file 
	 a Revised Return Provided Original Return is filed within the Due Date OR  
	 Time limit to file Revised Return is not exceeded. Rectification is the Process  
	 for correcting the mistakes which is apparent from the Records.

13.8.31.	 I have not claimed Current Year Losses in the Income Tax Return, can I file  
	 Rectification by claiming Current Year Losses?

Ans.	 Fresh / additional claim of loss cannot be accepted in Rectification; hence  
	 you have to file a Revised Return Provided Original Return is filed within the  
	 Due Date OR Time limit to file Revised Return is not exceeded.

13.8.32.	 I have not claimed Deductions under Chapter VIA in the Income Tax Return,  
	 Can I file Rectification by claiming Deductions under Chapter VIA?

Ans.	 Fresh / additional claim of Deductions Under Chapter VIA cannot be accepted  
	 in Rectification, hence you have to file a Revised Return Provided Original  
	 Return is filed within the Due Date OR Time limit to file Revised Return is 
	 not exceeded.

13.8.33.	 I have not claimed Brought Forward Year Losses in the Income Tax Return,  
	 Can I file Rectification by claiming Brought Forward Year Losses?

Ans.	 Fresh / additional claim of Brought Forward losses cannot be accepted 
	 in Rectification; hence you have to file a Revised Return Provided Original  
	 Return is filed within the Due Date OR Time limit to file Revised Return 
	 is not exceeded.

13.8. 34.	I have not claimed Relief Under Section 89 in the Income Tax Return, Can I  
	 file Rectification by claiming Relief Under Section 89?

Ans.	 Fresh/additional claim of Relief Under Section 89 cannot be accepted 
	 in Rectification; hence you have to file a Revised Return Provided Original  
	 Return is filed within the Due Date OR Time limit to file Revised Return 
	 is not exceeded.
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13.8.35.	Which return will be processed if revised return and Rectification are filed  
	 on the same date?

Ans.	 Revised return will be processed if the time processing the same is available.  
	 Rectification application will be rejected.

13.8.36.	What information is provided in the tax mismatch report shared 
	 with taxpayer?

Ans.	 Details of claims made in ITR which did not match during the matching  
	 process is provide in the report to help taxpayer to know which of credits  
	 were not considered by CPC.

13.8.37. Whether AO can seek transfer of rectification rights in tax credit mismatch  
	 cases to give effect to Circular No. 8/2015?

Ans.	 AO can seek transfer of rectification rights, if the taxpayer approached the AO  
	 with TDS certificates and indemnity bond. Such requests are handled  
	 automatically by the system in scheduled manner. If any rectification is in  
	 progress, the transfer is done after completion of the same. Taxpayer is  
	 intimated about the transfer of rectification rights to AO and is prevented  
	 from filing rectification at CPC as along as rectification rights are with AO.

13.8.38.	Whether CPC can revert the rectification rights available with AO, for the  
	 purpose any suo moto rectification?

Ans.	 Yes, CPC can revert back the rectification rights are with AO, by raising  
	 a request which is required to approved by the AO in the ITBA portal. Only  
	 after approval the rectification rights are reverted back to CPC.

13.8.39.	Whether I can change only the status or sub status for ITR 5 or 7 for AY2018-19?

Ans.	 Yes, there is a separate facility for providing additional information/ 
	 documents for changing the status/sub status in ITR 5 or 7.

13.8.40.	Whether I can change only the section under which exemption is claimed  
	 in the ITR 7?

Ans.	 Yes, there is a separate facility provided for changing the section under  
	 which exemption is claimed in the ITR and there is a provision to submit  
	 additional documents while making such changes to substantiate such  
	 change for ITR 7 only.

13.8.41.	 Can I submit rectification application or other correspondence with CPC 
	 in paper form?

Ans:	 No. 

13.8.42.	 I am getting error while filing rectification u/s 154, “Rectification application  
	 already submitted for this Assessment Year.” Can I file another  
	 Rectification request?

Ans:	 No. You can file another Rectification when previous one is processed by  
	 CPC. You will get an Order u/s 154 once the Rectification is processed.  
	 To view the status of your e-Filed Rectification, LOGIN and go to ‘My Account’  
	 ⇒ Rectification status’. 
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13.8.43.	I want to file a Rectification for correcting data for Tax Credit mismatch  
	 ONLY. Do I need to upload a fresh return XML (generated from the Excel  
	 Return preparing software utility)?

Ans:	 For ITR-1(From AY 2018-19) uploading of XML is not required, the user can  
	 select the request type as ‘Tax credit mismatch correction only’ and then  
	 provide TCS, TDS or IT details a fresh including those in which there was no  
	 mistake and submit the request. For other ITRs, assessee should use Return  
	 Data Correction (XML) option and upload the applicable XML for rectifying  
	 tax credit mismatch. 

13.8.44.	I want to file Rectification to correct data. Do I need to upload an XML  
	 (generated from the Excel Return preparing software utility)? 

Ans:	 Yes. However, according to the provision u/s 154 in Income Tax Act, 
	 an assessee can only file Rectification of a data which is apparent from 
	 the record. 

13.8.45.	I want to file a Rectification request for reprocessing my Income Tax  
	 Return. Do I need to upload a fresh return XML? 

Ans:	 No. Select the Request type as ‘Only reprocess the return’ and Submit the  
	 request. NO XML upload/submission is required. 

13.8.46.	I am audited under Section 44AB. Is it mandatory for me to file Rectification  
	 using Digital Signature Certificate? 

Ans:	 Yes. 

13.8.47.	I am the authorized signatory of a company. Is it mandatory for me to file  
	 Rectification for my company using Digital Signature Certificate?

Ans:	 Yes. 

13.8.48. How can I see the rectification status? 

Ans:	 LOGIN and GO TO ‘My Account’ ⇒ ‘View e-Filed Returns/Forms’ ⇒  
	 ‘Rectification Status’ 

13.8.49.	My e-Filed Income Tax Return has been processed by CPC raising 
	 a demand or with less refund. Whom do I need to approach 
	 for Rectification?

Ans:	 In case your Income Tax Return for the relevant Assessment Year is processed,  
	 online Rectification request may be made on e-filing portal. To know the  
	 status of processed Income Tax Return, the taxpayer should LOGIN and go  
	 to ‘My Account’ → ‘View e-Filed Returns/Forms’ → ‘Income Tax Return’ and  
	 check the status by clicking the link provided for Acknowledgement number.

13.8.50.	If assessee has uploaded wrong rectification request, what is the process of  
	 correction of rectification.

Ans:	 Assessee can withdraw rectification by midnight of the day of submitting  
	 the request, if assessee has uploaded wrong rectification request. LOGIN  
	 and go to My Account ‘→’ View e-Filed Returns /Forms’→ Rectification status
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13.8.51.	 Can an Income Tax Return e-Filed with one ITR Form say ITR-2 
	 be rectified in any other ITR form?

Ans:	 No. 

13.8.52.	I have filed the Original Income Tax Return in paper mode. Can I file the  
	 revised return electronically as e-Filed Income Tax Return?

Ans:	 No.

13.8.53.	I have e-Filed the Original Income Tax Return. Can I file the revised  
	 return in paper-form?

Ans:	 No. 

13.8.54. How many times I can file the revised return? 

Ans:	 ITR can be revised any number of times within relevant assessment year OR  
	 before the completion of the assessment by the Department; whichever  
	 event takes place earlier.

13.8.55.	Rectification has been processed by the CPC and demand has been  
	 removed. Afterwards again CPC has done suo-moto rectification and has  
	 again raised the demand without giving any intimation to us. How this is  
	 possible that once a rectification has been done but again it has been suo- 
	 moto reverted by CPC and original demand has been raised, why?

Ans:	 Rectification by Suo Moto are based on the information from TRACES, 
	 in cases where changes are effected by the deductors to the credit position,  
	 such change is conducted in CPC system of ITD, hence credit though allowed  
	 original, same is withdrawn based on TRACES. A notice u/s.154(3) of the  
	 Act is issued by email to the taxpayer in such cases giving taxpayer an  
	 opportunity of hearing.

13.8.56.	The assessee declared income of spouse in his income and claimed TDS  
	 on sale of property but credit of TDS of spouse was not allowed.  
	 Rectification was filed but demand still outstanding. Schedule TDS was  
	 complete and PAN of spouse was disclosed. Why?

Ans.	 As verified for the given PAN, for AY 2019 tax payer has filled schedule TDS3  
	 incorrectly (PAN of other person entered his PAN instead of the entering 
	 in PAN of the buyer/tenant. Requesting tax payer to fill the details in TDS3  
	 correctly and file for online rectification. It is crucial to fill the ITR with proper  
	 details while claiming credit for TDS in TDS 3. Instructions to the ITR are be  
	 read before filling the information to avoid disallowance of TDS.
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e-filing AnyTimeAnyWhere

UDIN-Salient features
E-filing and ICAI portal integration is almost complete

UDIN will be validated on real time

15 calendar days grace period is provided to update.
	 Three attempts in a day and max five such attempts

Consequence
	 Form uploaded treated as null and vold even if accepted by the taxpayers if UDIN is not linked
	 Once linked and accepted by te taxpayers, the form cannot be resubmitted with same UDIN

e-filing AnyTimeAnyWhere

UDIN-Expectations
Ensure Audit report and Certification are error Free

Ensure taxpayer accepts the uploaded report
	 Date of acceptance is deemed date of form submission

	 Deemed void if not accepted within reasonable time period

Revision under exceptional circumstance and date of certification will be the date of revision
	 As per ICAI guidelines, earlier UDIN is to be cancelled and to generate afresh 
	 On cancellation of UDIN, the earlier submission is treated as null and void

1.	 Presentations on e-filing Unit of CPC.

Presentations on the Processes at CPC
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e-filing AnyTimeAnyWhere

Bank Account Validation & EVC
Validation of Account through two processes
	 Direct integration with Banks (online validation on real time)

	 NPCI (Offline)

Basic requirements:

	 PAN linked to the Account

	 Account Name match with PAN Name

	 Account to be in active status

To enable EVC

	 Mobile number and email ID linked with Account to match with profile info

e-filing AnyTimeAnyWhere

Verification of return
Current status:
	 Nearly 25% through ITR-V mode

Expectation:
	 100% e-verification of return data

	 Preferably in ?? near real-timer process

	 To discourage ITR-V verification process

	 Educate taxpayers to link their mobile number to Aadhaart

	 Encourage Aadhaar based and other e-verification modes

CBDT circulart 13 of 2020
Past years return date e-verification window re-enabled YES

For AY-2015-16 to AY-2019-20

	 Open up to 30th September, 2020 ?? (Later extended till 30th November 2020)
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e-filing AnyTimeAnyWhere

e- Proceeding
Salient features & Expectations
	 Access taxprayers proceeding only as Authorized Representative

Upcoming features

	 Submission window limited to notice submission date

	 Seek Adjournment functionality

	 DIN based Appeal form submission

	 Appeal proceeding through e-proceeding module

e-filing AnyTimeAnyWhere

Return filing
Basic requirement
	 Updating the taxpayer Profile data in e-filing account

	 Prefer ITD utilities

		  In-built validations with near zero error return filing experience

	 Use latest released utility

	 Prefer pre-fill XML option

	 Complete PART-A General before started furnishing Income and other details
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2.	 Presentation on CPC

Processing of returns filed at CPC-ITR

This process, inter alia, comprises of the following activities:

Checking the return for defects u/s 139(9)
(including data inconsistencies)

Adjustments u/s 143 (1)(a)

Tax matching and processing

CPC processess all the ITRs filed by the taxpayers, except ITRs where Foreign Tax Credits 
(FTC) are claimed. Such ITRs are transferred to the jurisidictional AO (JAO) for verification 
of FTC and subsequently processed at CPC.	

Notice under section 245 of IT act

245 NOTICE

 	 The refund arising out of processing is liable to be adjusted against the outstanding demands, if any and  
	 notice u/s 245 intimates of such outstanding demands against which refund will be adjusted with.

 	 Response to notice u/s 245 needs to be provided by tax payer in E-filing portal within 30 days from 
	 date of issuance of notice.

 	 If no action is taken by tax payer within 30 days from receipt of notice u/s 245, then outstanding demand  
	 as on the date will be considered for adjustment against the refund.
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DEFECTIVE RULES

Defective Returns Statistics for AY 2019-20

0.59% of total Returns are defective: (99.41% are defect Free)

0.43% of the total taxpayers complied

0.16% did not respond and the returns were invalidated:

 	 Out of the 6.71 crore ITRs fied for AY 2019-20 as on 31/3/2020, defects within the scope of section 
	 139 (9) were notices in 3.3 Lakh ITRs

 	 2.84 lakh taxpayers responded to the notices either by response in e-proceedings on website or by revising 
the ITR. (72% people responded)

 	 Out of the 6.71 crore ITRs fied for AY 2019-20 as on 31/3/2020, defects within the scope of section 
	 139 (9) were notices in 3.3 Lakh ITRs
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Response to 139(9) & Removal of defect

Corrected Return 
u/s. 139(9)

Responses 
by text

No Responses

 	 A correction of the return in  
	 the form of 139(9) takes effect  
	 on the original return filed.

 	 If the taxpayer does not  
	 agree with the defect he/she  
	 can give a reason for  
	 disagreement (Max 500  
	 Characters) on e-proceedings  
	 module of e-filing.

 	 CPC analysis taxpayer’s  
	 response to 139(9) and takes  
	 further action either to  
	 process the ITR or reject the  
	 response by sending a notice  
	 before invalidating the ITR.

 	 If the taxpayaer does not 
respond to the notice/reminders 
than the Return is Invalidated 
after the time specified in 
such notice/remindeRs.
Communication of Invalidation 
is sent by email and speed post.

Defective Returns

Automated Process:

Notice & Reminders:
A notice u/s 139(9) is issued to the 
taxpayer through email, taking latest 
email ID from the ITR or profile (if 

profile email ID is changed after filing) 
and also by speed post

If there is no response, first Reminder is issued 
after the expiry of 15 days as provided in 

the notice u/s, 139 (9). The reminder allows 
additional 15 days to comply.

Second Reminder is issued after the 
expiry of 15 days time provided in the 
first reminder. The reminder allows a 
further time of 15 days to comply.

 	 Based on the ITR forms of respective AYs, defective checks are made using the software.

 	 Based on the  requirements of the Act/ Rule/ Scheme and instructions for processing of the ITRs u/s. 
	 143 (1), these defects are cgecked.

 	 All the checks are applied in automated manner.
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Upload level check - samples

Defect retirns - Reason and Resolution
Defect Rules (Samples)

ITR 1

Rebate u/s 
87A is claimed 

by Resident 
Individual having 
Total income of 

more than 
Rs.5,00,000

Income Details 
Part B Gross 
Total Income

In schedule Part 
B  Gross Total 
value in the 

field Sr. No. 7 
is greater than 
5,00,000 and 
Value in the 

field Sr. No. 9 of 
schedule Income 
details is greater 

than zero

Assessee with 
total income 
exceeding 

Rs.5,00,000 
cannot claim 

Rebate u/s 87A 
of Income tax 

act 1961

Reverify Income 
details and if 
total income 

exceeds 
5,00,000 remove 

the amount 
mentioned in 
relief u/s 87A

Do not 
allow 

taxpayers 
to upload 
the return

The assessee has 
claimed relief 
u/s 89 without 
furnishing of 

Form 10E

Income Details 
Part B Gross 
Total Income

In schedule 
Income details, 

relief u/s 89(1) to 
be provided only 

if Form 10E is 
filed by assesse

Please ensure 
you have 

furnished form 
10E order to 
claim relief 

u/s 89

Allow tax 
payer to 
upload 

the return

RULE DESCRIPTION PROBABLE RESOLUTION

As per rule 12 (1)(ca), a perso deriving income under the head 
“profis or gains from business/profession” and such income 
computed in accordance with special provisions of section 
44AD or 44AE or 44ADA, is required to furnished return in 
ITR-4. The Return of Income is filed using ITR 4, however, 
income from business or profession under section 44AD or 
44AE or 44ADA is not disclosed.

(ITR-4 cannot be used by persons not having presumptive 
business Income)

ITR 4 is not applicable to yout case since income 
from business or profession uner section 44AD 
or 44AE or 44ADA is not disclosed. If you do not 
have any income from business or profession 
under section 44AD, 44AE or 44ADA, ten kindly 
file corrected Return using ITR 2 (for individuals 
and H.U.F) or ITR 5 (In casse of Firm)

(Use correct ITR)

Tax Payer has claimed gross receipt or income under the 
head “Profits and gains of Business or Profession” more 
than 1 crore, however, he has not filled Balance Sheet and 
Profit and Loss Account and has not got the books of 
accout audited.

(Books of account not audited, though such liability 
is forthcoming from the data in the return)

The complete details of Profit and loss account 
and Balance Sheet are to be entered in Part A 
and taxpayaer has to e-file the audit report, 
specified under section 44AB.

(Furnish Audit report)
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PRIMA FACIE ADJUSTMENTS

Adjustment u/s. 143 (1)(a) Statistics for 
AY 2019-20

STATISTICS FOR AY 2019-20

 	 Out of these 6.71 crore ITRs filed, inconsistencies within the scope of section 143(1)(a) were notices 
	 in 12.64 Lakh returns and notices issued proposing adjustment to retured income.

 	 This works out to 2.01% of the total returns filed for the AY 2019-20
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Process for Adjustment u/s 143(1)(a)

What is adjustment u/s 143(1)(a)

Automated Process:

(o) the total income or loss shall be computed after 
making the folloing adjustment, namely:-

 	 Based on the ITR forms and statutory forms prescribed for each AY the checks for adjustments 
	 u/s 143(1)(1) are made using the software.

 	 The adjustments are proposed based on the requirement of the Act, Rules, Scheme and Instryctions  
	 for processing of ITR u/s 143(1)(a)(i) to (v) for AY 2019 at CPC.

 	 All the checks are automated and manual sample checks are done before triggering notices.

 	 For the purpose of Validating the information in the ITR under the provisions of Section 143(1)(a) 
	 (i) to (v) for AY 2019-20, the reference is made to different statutory forms/information in ITR 
	 in an automated manner.

 	 Any arithmetical error in the return;
 	 An income claim, if such incorrect claim is apparent from any information in the return;
•	 Disalloance of loss claimed, if return of the previous year for which set off of loss is claimed was  
	 furnished beyond the due date specified under sub-section (1) of section 139;
•	 Disallowance of expenditure indicated in the audit report but not taken into account in computing the  
	 total income in the return;
•	 Disallowance of deduction claimed under sections 10AA, 80-IA, 80-IAB, 80-IB, 80-IC, 80-ID or  
	 section 80-IE, if the return is furnished beyond the due date specified under sub-section (1) of section  
	 139: or
•	 Addition of income appearing in Form 26AS or Form 16A or Form 16 which has not been included  
	 in computing the total income in the return (Only for AY 2017-18)

Notice:
Notice u/s 143(1)(a) is issued to the taxpayer through email, taking the latest email ID from 

the ITR or profile (if profile email ID is changed after filing) and also by speed post.
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Adjustment u/s. 143 (1)(a) Sample

Response to 143(1)(a)

Options to respond to Notice in 3-Proceedings

No Response:

Taxpayer is 
provided with 3 

options to respond:

Analyses of Response Revised Returns:

 	 If the taxpayer does not  
	 respond to the notice, then  
	 the Return is processed  
	 with the proposed  
	 adjustments.

 	  Agree to adjustment and file revised ITR by incorporating the adjustment.
 	  Partially agree to the adjustment and file revised ITR by incorporating the adjustment.
 	  Disagree to the adjustment by providing an appropriate response.

 	If the taxpayer does not  
	 agree for the proposed  
	 adjustment, CPC analyses  
	 the taxpayer’s response  
	 and takes further action by  
	 processing the ITR  
	 without adjustment or 
	 with adjustment as the  
	 case may be.

	 Taxpayers are expected to 	
	 file revised ITR u/s 139(5) 
	 in case they accept 
	 the adjustment.

Schedule Error Descripton

Schedule 
Other 

Sources

In Schedule OS, the sum of Sl.No. to 1d if NOT EQUAL TO Sl.No. 1e 
{(1a+1B+1c+1d)<>1e}

In Schedule OS, Lottery income offered in Sl.No. d1 is inconsistent with S;.No. f(i)

In Schedule OS, Income under the head “Income from other sources” at column 
4 is inconsistent with the sum of Income from other sources (other than from 
owning race horse) and Income from the activity of owning and maintaining race 
horses. {4<>[(1fvii+1i)+(3c)]}

Schedule 
House 

Property

Sl.No. g (standard deduction u/s 24) should be restricted to 30% of Sl.No. f 
(Annual value of the property owned {own percentage share x e})

In Schedule HP, though the co-owned flag is YES, the total percentage of co-
owners has not been fully furnished or not wqual to 100%

Form Type 1: 
Income & 

Deductions

Total of chapter VI-A deductions is not consistent with the breakup of individual 
deductions.

Total of Gross Total Income is not consistent with the breakup of Incomes.
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Adjustment u/s 143(1)(a)(iv) Sample

Adjustment u/s. 143 (1)(a)(ii) Sample

Schedule Error Descripton

Partner 
Information

In Partner Information Schedule, Value entered by Assessee in Remuneration 
paid/payable is consistent with Sr.No. 38 of Part A - Profit and Loss

MAT
In Schedule MAT there is an inconsistency in the computation of Book profit 
from the amounts mentioned in Part A P & L account.

In Schedule VI A, the maximum limit allowable under section 80C, 80CCC AND 
80CCD(1) is Rs. 1,50,000/-

Chapter VIA

In Schedule VI A, the maximum limit allowable under section 80GG is 
Rs.60,000/- or 25% of the total income

In Schedule VIA,

a) Sl.No. 1e.80CCD(2) individual assessee has claimed more than 10% of salary

or

b) Assessee, not an individual has claimed deduction u/s 80CCD(2) which is not 
allowable

Deductions 
Disallowed

Particulars
Schedule 

OI
Form 3CD

Sec 36
Any amount of interest paid in respect of 
borrowed capital [36(1)(iii)]

Sr.No.6(d) Sr.No. 21(i)

Sec 37 Total amount of disalloance Sr.No.7k
Sr.No. 21(a) Amount 

column

40

Amount disallowable under section 40 (a)
(i), on account of non-compliance with the 
provisions of Chapter XVII-B

Sr.No.8a
Sr.No. 21(b)(i)A(II) 
& B(II) - Amount of 

payment

Amount disallowable under section 40(a)
(ia) on account of non-compliance with the 
provisions of Chapter XVII-B

Sr.No.8b
Sr.No. 21(b)(i)A(II) 
& B(II) - Amount of 

payment

Amount paid by way of royality, license fee, 
service fee etc., as per section 40(a)(iib)

Sr.No.8g Sr.No. 21(b)(vi)
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Response Pattern and Action:

Adjustment u/s. 143(1)(a)(v) Sample

Response Number Action Not Responded Action

Agreed 1.35 lakh
Adjustment as per revised RI or 
as per proposal

9.33 lakh
Adjustment 

as per 
proposal

Not Agreed 1.34 lakh Action as per analysis at CPC

Partially 
Agreed

0.24 lakh Action as per analysis at CPC

Total
2.93 lakh 

(24%)
9.33 lakh 

(76%)

Schedule Deduction Condition

Part BTI 10AA
Assessee claiming deduction u/s 10AA but return is filed 
after due date i.e. 30th Sep or due date as per extension

Schedule VIA 80IA
Assessee claiming deduction u/s 80IA but return is filed 
after due date i.e. 30th Sep or due date as per extension

Schedule VIA 80IB
Assessee claiming deduction u/s 80IB but return is filed 
after due date i.e. 30th Sep or due date as per extension

Schedule VIA 80IAB
Assessee claiming deduction u/s 80IAB but return is filed 
after due date i.e. 30th Sep or due date as per extension

Schedule VIA 80IC/80IE
Assessee claiming deduction u/s 80IC/IE but return is filed 
after due date i.e. 30th Sep or due date as per extension

Schedule VIA 80ID
Assessee claiming deduction u/s 80ID but return is filed 
after due date i.e. 30th Sep or due date as per extension

Rectifications sought against adjustment

•	 No. of rectifications filled: 5,097

•	 No. impact on Total Income: 1,781

•	 Request rejected due to changes in returned Income: 3,316
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Common issues/ errors.. contd:

Adjustment u/s. 143 (1)(a)(ii) Sample

Sl.No. Errors Category of error

1 Assessee is claiming deduction u/s 80D more than the specified limit Incorrect claim

2

In Schedule BP, Sl.No.14. Amounts debited to the profit and loss account, 
to the extent disallowable under section 36 (6s of Part A - OI) is not 
consistent with amount shown in Sl.No.6.s. Total amount disallowable 
under section 36 (total of 6a to 6r) of Part - OI.

Arithmetic 
within the ITR

3

Any sum received from employees as contribution to any provident fund 
or superannuation fund or any fund set up under ESI Act or any other fund 
for the welfare of employees to the extent not credited to the employees 
account on or before the due date [36(1)(va)]

Difference with Audit 
report

4
Inconsistency in amount debited to profitand loss account of the previous 
year but disallowable under section 43B

Difference with Audit 
report

5 Inconsistency in Total amount of disallowance under sec 37
Difference with Audit 

report

Sl.No. Errors Category of error

6
The amount entered in Schedule SI are inconsistent with the corresponding 
amounts entered in Sch CG/Sch OS. 

Arithmetic within 
the ITR

7
In Schedule Part BTI, Losses of current year are to be carried forward, 
is claimed but the original return is filled after due date or Brought forward 
losses are not adjusted against the current years Income.

Return not filled 
in time

8
There is inconsistency in the LTCG amounts/Totals entered in schedule CG 
or Taxpayer is claiming deductions u/s 54 which are more than amounts 
allowable as per the respective sections.

Arithmetic within 
the ITR

9
In Schedule BP, Sl.No. 15 - Section 37 amount of expenditure disallowed is 
not consistent with amount shown in schedule OI

Arithmetic within 
the ITR

10

In Part A Gen - 1 under “Details of registration or approval under Income Tax 
Act” the trust or institution has not furnished the details of registration u/s 
12A/12AA or approval u/s 10(23C)(iv) or 10(23C)(v) or 10(23C)(vi) or 10(23C)
(via), hence the exemption claimed in Sl.No. 4I to 4viii in Schedule Part B-TI 
is not allowed. PS: Filling of Form 108 is mandatory for assessee registered 
u/s 12A/12AA. Filling of Form 10BB is mandatory for assessee approved u/s 
10(23C)(iv) or 10(23C)(v) 0r 10(23C)(vi) or 10(23C)(via).

Audit report not 
filed within the 
allowed time
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Brought forward loss not being allowed

Filing Partners Information

 	The taxpayer needs to properly fill the partners information with partners’ details and their percentage of  
	 share and remuneration paid/payable, so as to allow the expenditure.

 	 In some instances it is notice that taxpayers have filled incomplete percentage share of partners in Part-A  
	 Gen Partners’ information.

 	Also in some instance there is inconsistency observed in remuneration amount as per schedule Part-A 
	 P & L and as per Part-A Gen Partners information.

 	The taxpayers are requested to fill schedule Partners information by providing complete (100%)  details of  
	 share of partners, along with partners PAN and remuneration paid/payable amount, so as to allow  
	 expense of salary/remuneration paid to partners.

 	The taxpayer is required to file the return of income within the due date to carry forward the loss.

 	 In order to carry forward the loss, taxpayer is required to fill schedule CFL (Carry Forward Loss).

 	Brought forward loss adjustment will be allowed, only if respective previous year loss was entered  
	 in schedule CFL to be carried forward.

PART-A P & L AND AS PER PART-A GEN PARTNERS INFORMATION

SCHEDULE CFL
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TDS Credit Variance

Income Computation and Disclosure Standard 
(ICDS) adjustments

 	 In some of the cases it was noticed that the Taxpayer has claimed ICDS (Income Computation and  
	 Disclosure Standard) adjustments in schedule BP but same is not reflected in schedule ICDS.

 	Taxpayer is required to add or reduce the amount in schedule BP as per ICDS standards and then  
	 details of adjustments needs be captured in schedule ICDS as well.

 	 If not, then decrease in profit or increase in loss as a result of application of ICDS standard may not  
	 reflect correctly in end result.

 	TDS mismatch on account difference with TRACES system is just 0.3% and major reasons for  
	 variance are as below.
 	Taxpayer has claimed TDS credit in schedule but incorrect TAN/Deducted year is quoted in the  
	 respective schedule.
 	Taxpayer has filled TDS credit in respective schedule but claiming the credit of same amount 
	 in Advance Tax/ Self Assessment Tax instead of TDS column.
 	Taxpayer are requested to fill Schedule TDS1/TDS2/TDS3/TCS with correct TAN. PAN (either TDS  
	 deducted in own hands or TDS deducted in other PAN and deducted year) and enter correct TDS/ 
	 TCS amount.
 	 In case, any TDS/TCS credit is being carrying forward to next year, it should be clearly indicated 
	 as being carried forward in respective TDS/TCS Schedule.
 	 In case, taxpayer has claimed TDS deducted in respect of other person PAN, details of such other  
	 person PAN has to be shown in respective TDS schedule.

SCHEDULE ICDS

SCHEDULE TDS
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Special Income

Capital Gain Schedule

 	 In some instance, taxpayer is claiming cost of acquisition without offering full value of consideration  
	 in schedule CG (Capital Gain). In such scenario, loss will be disallowed.

 	Taxpayer is offering capital gains income in schedule CG but showing different capital gain income  
	 in schedule CYLA (Current Year Loss Adjustment). In such scenario, higher of the two incomes will  
	 be considered for capital gain computation.

 	 In case, any loss is contemplated for set off against the capital gains of current year, then details  
	 of such set off loss should be filled in Schedule CYLA (Current Year Loss Adjustment) under the  
	 appropriate column. Otherwise, tax will be calculated on the total CG income without factorig 
	 in loss.

 	Taxpayer required to fill Schedule CG, Schedule SI (Special Income) and offer the same income 
	 in schedule Part BTI and calculate the tax accordingly.
 	 It is to be ensured that details entered in Schedule SI correcpond to Schedule CG entered details.
 	 In some instance, Taxpayer is offering long term capital gain with provison in schedule CG 
	 (10% applicable tax rate) but while selecting percentage in schedule SI, it is wrongly selected 
	 as “20%” instead of “10%”.
 	 In certain other instance, Taxpayer is offering long term capital gain without provison in schedule  
	 CG (20% applicable tax rate) but while selecting percentage in schedule SI, it is wrongly selected as  
	 “10%” instead of “20%”.
 	Also, in some instance, Taxpayer is offering special income of short term capital gain in schedule CG  
	 (15% applicable tax rate) but while selecting percentage in schedule SI, it is wrongly selected as  
	 “10%, 20%, others” instead of “15%”.

SCHEDULE CG

SCHEDULE CG AND SCHEDULE SI
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300 Challan needs to be claimed - Schedule IT

Schedule Business & Profession - 
Reduced Income

 	 In some cases, it was seen that tapayer is reducing income from House Property/Capital Gain/ 
	 Other Source/Exempt Income in schedule BP but same is either not offered or offered less 
	 in respective schedule.

 	Also, in some cases taxpayer has not credited the income in schedule Part-A P&L but reducing the  
	 same in schedule BP. The same will be disallowd since it is not offered in P&L account.

 	 In order to reduce the HP/CG/OS/EI Income (House Property, Capital Gain, Other Source/Exempt  
	 Income) in schedule BP, taxpayer should ensure that same income is shown in schedule Part A P&L  
	 under the head of “Other Income”. Also, reduced income in shcdule BP has to be shown in respective  
	 income schedule.

 	 In some of the instances, the Tax payers have paid the self assessment tax using the E-pay option 
	 in E-filling portal. 

 	However, the challan has not been claimed by tax payer in Schedule-IT.

 	 It is necessary that tax payer claims the 300 challan details in Schedule-IT so as to avail the credit of  
	 self assessment tax paid.

SCHEDULE BP

SCHEDULE TDS
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Response to putstanding demand

Post Processing

 	 In the E-filling portal, the tax payer needs to click on E-File TabResponse to outstanding demand.

 	 In case demand shown is correct, tax payer needs to click on ‘submit response’ and then ‘agree with  
	 adjustment’. In this scenario refund will be adjusted against demand.

 	 In case demand shown is partially correct, tax payer needs to click on ‘submit response’ and then  
	 ‘demand is partially correct’ and enter the amount of demand that is partially correct.

 	 In case demand shown is incorrect, tax payer needs to click on ‘submit response’ and then ‘demand  
	 is incorrect’. Detailed reasons may also be entered as to why the demand is incorrect as per tax payer.

THREE POSSIBLE OPTIONS

245 NOTICE

241A WITH HELD

RECTIFICATION AND 
REVISION OF RETURN
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Section 241A

Scenario where demand is incorrect or 
only partially correct

 	 In respect of above 2 scenarios, CPC-ITR will trigger a 245 notice to jurisdictional Assessing Officer  
	 (AO). The response as per Jurisdictional AO will be final and CPC-ITR is bound to follow the option  
	 exercised by AO.

 	 In this regard, it is requested that tax payer may kindly check for outstanding demands if any in  
	 E-filling portal and if any demand is found to be not agreeable totax payer, then either online  
	 rectification with CPC-ITR or rectification with Jurisdictional AO may be taken up with. This  
	 exercise can be done even before any 245 notice is issued by CPC-ITR to tax payer.

 	This will go a long way in clearing the non-agreeale demand as per tax payer and also better facilitate  
	 refund issuance to tax payer by CPC-ITR.

 	 Section 241A mandates that, in cases where notice u/s sub-section (2) of section 143 has been issued  
	 in case of a taxpayer, then Assessing Officer (AO) with the approval of competent authority can , 
	 ,,,,,,,,,, withhold refund arising out of summary processing (143(1) processing), till date of completion  
	 of scrutiny proceeding.

 	 In such cases ............ selected for scrutiny and the option to withhold refund as per section 241A has  
	 been exercised by field officer (AO), CPC-ITR is bound to withhold the refund till the pending  
	 scrutiny proceeding is completed.

TAKING UP NON AGREEABLE DEMAND FOR REDUCTION EVEN DEFORE 245 NOTICE

REFUND WITHHELD IN SCRUTINY CASES
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Rectification Request Types

Rectification u/s 154

 	Online rectification request can be filed with CPC-ITR.

 	The tax payer needs to click ‘E-file menu’ and then ‘rectification request’.

 	The tax payer nees to further select ‘order/Intimation to be rectified’ and ‘Assessment Year’ from the 
dropdown list and click on ‘Contine’

Tax payer can select one of the following ‘Rectification Request Type’ from the drop down menu:

 	Tax credit mismatch correction only (Available only for ITR-1)

 	Return Data Correction

 	Only reprocess the return

ONLINE RECTIFICATION

MAJOR TYPES
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Return Data Correction

Tax Credit Mismatch Correction

 	Here, Tax payer can correct data for tax credit mismatch under these request types.

 	On selecting this option, following check boxes will be displayed.

	 •	 TDS on Salary Details
	 •	 TDS on other than Salary Details
	 •	 TDS on transfer of Immovable Property/Rent
	 •	 TCS Details
	 •	 IT Details
 	Tax payer may select the check box for which data needs to be corrected.

 	No upload of an Income tax return is required.

 	Tax payer can correct return data under this rectification type through xml upload.

 	On selecting the request type as return data correction, tax payer can select a maximum of 4 reasons  
	 out of the list of reasons which will be displayed.

 	The schedules which are being changed/rectified can be specified ad xml can be uploaded with  
	 appropriate Digital Signature Certificate (If available and applicable).

 	When the user is uploading XML, the Gross Total Income and Deductions amount should be the  
	 same as in the processed return.

ONLY FOR ITR-1

XML UPLOAD
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Rectification and Revision of Return

No Data Coorection Require

 	Under this request type, there is no data correction. By selecting this option, user is just placing 
	 a rectification request to reprocess the return.

 	Before submitting the request, tax payer may kindly verify the Form 26 AS details under My Account  
	  View 26AS and tax credit mismatch under  My Account Tax credit mismatch.

  	After submission, success message will be displayed and a mail confirming the submission of  
	 rectification request will be sent to the tax payer’s registered mail ID.

 	Tax payers may kindly consider filling rectification application in respect of any mistake apparent 
from record. The indicative list ......... includes:

	 •	 Rectifying clerical mistakes
	 •	 Correcting arithmetical errors
	 •	 ....... mismatch in tax payment
	 •	 Inclusion of income chargeable to tax under a different head of income.	

ONLINE RECTIFICATION

MISTAKE APPARENT FROM RECORD
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Transfer of Rectification Rights by CPC

Option for filing Revised Return

 	 In cases, where there is a change in Gross Total Income, new deductions being claimed, new  
	 exemptons being claimed, then tax payers may consider exercising the option of filling revised return  
	 u/s 139(5) of Income Tax act rather than making 154 application.

 	Tax payer can file a revised return at any time before end of relevant assessment year or before  
	 completion of assessment whichever is earlier.

 	With effect from Assessment Year 2017-18, Income tax act has been amended to facilitate revision  
	 of even belatedly filled return.

 	The rectification rights are transferred by CPC-ITR to Assessing Officer (AO) based on the request  
	 made by AO.

 	On request made by AO, the rectificatoin rights are transferred to AO within 2-3 days.

 	The rectification rights transfer is an automated process and is system driven.

 	AO’s have internal mechanism to escalate the issue to CPC-ITR, if transfer of rectification rights 
	 as not happened within stipulated time and same is resolved immediately.

 	We shall discuss about some of the repeated issues which have been subject matter of rectification 
	 in ensuing slides.

REVISED RETURN U/S 139(5)

ON REQUEST MADE
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Grievance Redressal Overview

CPC-ITR BANGALORE

Grievance Redressal Overview

Grievance 
Source

CPGRAMS

Recept

e-Nivaran

Analysis

e-mail

Resolution

IVRS/Cust. Ser

QC

ORM

Response
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A. Refund Outward - Process flow

INCOME TAX DEPARTMENT

Centralized Processing Centre Bangalore
SLIDES RELATING TO ISSUE OF REFUNDS AND 

DEMAND MANGAMENT

Refund Failure 
communication Sent 

to Tax Payer

Failer Feed 
Sent to CPC

Failure Feed 
Sent to E-filing

Yes Yes
Refund is 

Determined 
(Processing 
Completed)

Refund Sent 
to tax Payer

Valid Bank 
account 
available

Bank 
account is 

correct 
& active
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C. Issues on refund Re-issue

B. Tips for Seamless Refund Flow

•	 From 1st Mar 2019 onwards, CPC is issuing the refunds only through ECS mode to  
	 validated bank accounts. The bank account validation is being done either through  
	 e-filing portal or NPCI

•	 For smooth transmission of refunds, the taxpayer should ensure:

	 a)	 Linking of PAN to bank account
	 b)	The name as per PAN and Bank account should be same
	 c)	 The type of bank account should be Savings/Current/Over Draft/Cash Credit/NRO
	 d)	Avoid providing joint accounts, co-operative bank accounts. Virtual Bank account
	 e)	 The bank account should be in India
	 f)	 De-activate non operating accounts in the e-filing portal

•	 For speedy transmission of Refund, CPC is applying fallback logic i.e. if bank account  
	 provided in the return is invalid, CPC will issue refund to any other valid bank account  
	 available in the taxpayer data base, (data is taken from ITRs filed in earlier years)	

•	 Refunds are issued totaxpayer based on the bank details provided in the ITR or  
	 validated bank account available in taxpayer’s data base.

•	 Refund may fail due to insufficient/incorrect bank account details. Once the refund  
	 is failed, a communication is shared with taxpayer indicating th reasons for failure  
	 to enable taxpayer to seek refund reissue on e-filing portal.

•	 Refund failure communication will be sent to taxpayer to file a refund re-issue  
	 request by providing valid bank account in e-filing website.

•	 For failed refunds, taxpayer need to apply re-issue request only through e-filing  
	 website except for Legal heir cases.

•	 If taxpayer furnishes new bank account, post validation from the concerned  
	 agency, the refund will be re-initiated through automated system.
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E. Documents to be submitted for 
Registration of Legal heir on E-filing portal

D. Process involved in intimation u/s. 245

•	 Once refund is determined, intimation u/s. 245 will be issued for outstanding  
	 demand. Taxpayer is required to confirm the demand position on e-filing portal  
	 within 30 days from the date of 245 intimation. In case no response in received, the  
	 demand will be adjusted against refund.

•	 If taxpayer disagrees for adjustment, A.O. will review the demand and he may agree  
	 or disagree for adjustment. If taxpayer or A.O. agrees for adjustment of demand, refund  
	 will be adjusted against the demand and net refund if any will be credited to  
	 assessee’s bank account.

•	 If taxpayer has already agreed to the demands, 245 Intimation will not be triggered.

•	 Registration of Legal Heir: For filing Income - tax return as Legal Heir, one has to  
	 get registered on e-filing portal through the functionality provided in e-filing portal.
•	 Legal Heir: Taxpayer need to register as Legal heir by uploading following  
	 documents on e-filing portal:
	 •	 PAN of the Deceased
	 •	 Bank account details of Legal heir
	 •	 PAN of the Legal heir
	 •	 Death Certificate
	 •	 Proof of document related to legal heir
•	 The following documents are accepted as Legal Heir proof (Any one from below):
	 •	 Legal Heir Certificate issued by Court of Law/Local Revenue Authority
	 •	 Surviving family member certificate issued by the Local Revenue Authority
	 •	 Family Pension certificate issued by Central/State Government
	 •	 Registered will
	 •	 Letter issued by the banking or Financial Institution in their letter head, with  
	 	 official seal and signature mentioning the particulars of nominee or joint  
	 	 account holder to the account of the deceased at the time demise.
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G. Refunds to Special Categories

F. Refund re-issue in Legal Heir Cases

•	 The process followed for re-issue of refund to Legal heir, where return is filed by  
	 taxpayer but the tax payer is deceased before issue of refund is provided below:

	 When refund fails, a communication will be sent to the address as provided in the  
	 return. Legal Heir need to submit the Legal heir PAN & Death Certificate of the Tax  
	 Payer to CPC to initiate verification process.

	 Once the request is received, a communication will be sent to the Legal Heir for  
	 further proceeding with jurisdictional AO & a communication will be sent to  
	 jurisdictional AO for Legal Heir compliance. Legal Heir is required to submit relevent  
	 document and bank account details to JAO.

	 If taxpayer contacts JAO directly, JAO will initiate legal heir request and CPC will  
	 issue refund to Legal heir.

•	 Amalgamation of Companies: Currently, the functionality for transfer of credits and  
	 issuance of refund is not available in CPC. Only JAO need to verify and issue the refunds.

•	 Refund to NRI: As per the functionality, refund is being issued only to the Bank  
	 account held by NRI in India or account held by NRI in a foreign bank having branch  
	 in India.	

•	 Representative Assessee: Currently there is no functionality for issue of refund in  
	 CPC. Taxpayer needs to contact JAO where refund has to be initiated in the name of  
	 representative Assessee.

•	 Refund adjustment on account of demands relating to other Departments: The  
	 functionality is under development, currently concerned A.O.s are co-ordinating  
	 with those department for adjustment of demands through refund adjustments.
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Presentation on upcoming new processes of Income Tax Department

Integrated E-filing and CPC-ITR Processing 2.0

Integrated system for E-filing and ITR processing
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Critical Enhancement Planned in the Integrated System

•	 Pre-Populated Return  
	 covering details of  
	 Taxpayer information

•	 Enhance taxpayer  
	 experience in return filling

•	 Prevent erroneous inputs  
	 from the Taxpayer and  
	 reduce rectifications.

•	 Processing of the returns  
	 on STP basis

•	 Prioritizing on the basis of  
	 risk score & risk profile

•	 Faster Refund disbursement  
	 to the taxpayer and speedy  
	 clearance of Demand

Call center, real time 
chat system and Virtual 
Assistant for the taxpayers 
to address their grievance 
Social Messaging Platform 
to directly communicate 
with ITD Faster closure of 
grievances and improved 
customer satisfaction

Pre-fill

Straight Thru Processing

Integrated 
Communication 
Management

New Initiative to Facilitate Tax Compliance

•	 An ecosystem of  
	 Accredited Demand  
	 Partners
•	Facilitate the taxpayers  
	 in managing an resolving  
	 their outstanding demands

•	 Continuous engagement  
	 with Taxpayers to  
	 increase compliance

•	Social media, Print media,  
	 Creative Campaigns

•	Educate and make aware

Taxpayer Outreach Programme

•	Certification of entities  
	 such as Employers, TRPs,  
	 ERIs, ets., with ITD to  
	 facilitate accurate and  
	 timely filing of Returns

Accreditation Programme

Demand Facilitation Program
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Annexure 1 : List of Income Tax Forms provided in the e-filing website.

Income Tax Forms (Forms Instructions) (654KB)

S.No. Form Description Applicability Online Offline

1 Form 3AC Audit report under section 33AB(2) 
Individual, HUF, Company, 

AOP/BOI/Trust/Firm/AJP/LA
YES NO

2 Form 3AD Audit Report under section 33ABA(2)
Individual, HUF, Company, 

AOP/BOI/Trust/Firm/AJP/LA
YES NO

3 Form 3AE
Audit report under section 35D(4)/ 
35E(6) of the Income-tax Act, 1961

Individual, HUF, Company, 
AOP/BOI/Trust/Firm/AJP/LA

YES NO

4 
Form 

3CA-3CD

Audit report under section 44AB 
of the Income-tax Act,1961 in a case 
where the accounts of the business 
or profession of a person have been 
audited under any other law

Individual, HUF, Company, 
AOP/BOI/Trust/Firm/AJP/LA

NO YES

5 
Form 

3CB-3CD

Audit report under section 44AB of 
the Income-tax Act,1961, in the case 
of a person referred to in clause (b) 
of sub-rule (1) of rule 6G

Individual, HUF, Company, 
AOP/BOI/Trust/Firm/AJP/LA

NO YES

6 Form 3CE
Audit Report under sub-section (2) of 
section 44DA of the Income-tax Act, 
1961

Individual, HUF, Company, 
AOP/BOI/Trust/Firm/AJP/LA

YES NO

7 Form 3CEA

Report of an accountant to be 
furnished by an assessee under 
sub-section (3) of section 50B of 
the Income-tax Act, 1961 relating to 
computation of capital gains in case 
of slump sale

Individual, HUF, Company, 
AOP/BOI/Trust/Firm/AJP/LA

YES NO

8 
Form 

3CEAA

Report to be furnished under 
sub-section (4) of section 92D of 
the Income-tax Act, 1961

Company, 
AOP/BOI/Trust/Firm/AJP/LA

NO YES

9 
Form 

3CEAB

Intimation by a designated 
constituent entity, resident in India, 
of an international group, for the 
purposes of sub-section (4) of 
section 92D of the Income-tax 
Act, 1961

Company, 
AOP/BOI/Trust/Firm/AJP/LA

YES NO

10
Form 

3CEAC

Intimation by a constituent entity, 
resident in India, of an international 
group, the parent entity of which is 
not resident in India, for the purposes 
of sub-section (1) of section 286 of 
the Income-tax Act, 1961

Company, 
AOP/BOI/Trust/Firm/AJP/LA

YES NO

11
Form 

3CEAD

Report by a parent entity or an 
alternate reporting entity or any other 
constituent entity, resident in India, 
for the purposes of sub-section (2) or 
sub-section (4) of section 286 of the 
Income-tax Act, 1961

Company, 
AOP/BOI/Trust/Firm/AJP/LA

NO YES

12
Form 

3CEAE

Intimation on behalf of the 
international group for the purposes 
of the proviso to sub-section (4) of 
section 286 of the Income-tax 
Act, 1961

Company, 
AOP/BOI/Trust/Firm/AJP/LA

YES NO

13 Form 3CEB

Report from an accountant to be 
furnished under section 92E relating 
to international transaction(s) and 
specified domestic transaction(s)

Individual, HUF, Company, 
AOP/BOI/Trust/Firm/AJP/LA

NO YES

14 

Form 3CEJ 
(Ceased to 
be effective 

from AY 
2019-20 )

Report from an accountant to be 
furnished for purposes of section 
9A relating to arm’s length price in 
respect of the remuneration paid by 
an eligible investment fund to the 
fund manager

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES No

15 Form 3CEK
Annual Statement under section 9A 
of the Income-tax Act, 1961 

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO
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16 Form 3CF-I

Application Form for approval 
under clause (ii) or clause (iii) of 
sub-section (1) of section 35 of the 
Income-tax Act, 1961 in the case of 
a research association 

Company,AOP/BOI/Trust/
Firm/AJP/LA

YES NO

17 
Form 
3CF-II

Application Form for approval under 
clause (ii) or clause (iii) of sub-section 
(1) of section 35 of the Income-tax 
Act, 1961 in the case of a University, 
College or other Institution

Company,AOP/BOI/Trust/
Firm/AJP/LA

YES NO

18 
Form 

3CF-III

Application Form for approval under 
clause (iia) of sub section (1) of 
section 35 of Income Tax Act, 1961 
in the case of company 

Company,AOP/BOI/Trust YES NO

19 Form 3CFA
Form for Opting for taxation of 
income by way of royalty in respect 
of Patent

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

20 Form 3CL

Report to be submitted by the 
prescribed authority to the Income-
tax Authority specified under section 
35(2AB) of the Income-tax Act, 1961 

External Agency YES NO

21 Form 3CLA

Report from an accountant to be 
furnished under sub-section (2AB) 
of section 35 of the Act relating 
to in-house scientific research and 
development facility

Company YES NO

22 Form 6B
Audit report under section 142(2A) of 
the Income-tax Act, 1961

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
NO YES

23 Form 8

Declaration under section 158A(1) of 
the Income-tax Act, 1961 to be made 
by an assessee claiming that identical 
question of law is pending before the 
High Court or the Supreme Court 

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

24 Form 9

Application for grant of approval or 
continuance thereof to a fund under 
section 10(23AAA) of the Income-tax 
Act, 1961 

Company,AOP/BOI/Trust/
Firm/AJP/LA

YES NO

25 Form 9A

Application for exercise of option 
under clause (2) of the Explanation 
to sub-section (1) of section 11 of the 
Income-tax Act, 1961. 

Company,AOP/BOI/Trust/
Firm/AJP/LA

YES NO

26 Form 10

Statement to be furnished to the 
Assessing Officer/Prescribed 
Authority under sub-section (2) of 
section 11 of the Incomer-tax Act, 1961 

Company,AOP/BOI/Trust/
Firm/AJP/LA

YES NO

27 Form 10A

Application for registration of 
charitable or religious trust or 
institution under clause (aa) of 
sub-section (1) of section 12A of the 
Income-tax Act, 1961

Company,AOP/BOI/Trust/
Firm/AJP/LA

YES NO

28 Form 10B

Audit report under section 12A(b) of 
the Income-tax Act, 1961, in the case 
of charitable or religious trusts 
or institutions

Company,AOP/BOI/Trust/
Firm/AJP/LA

NO YES

29 Form 10BA
Declaration to be filed by the 
assessee claiming deduction under 
section 80GG

Individual YES NO

30 Form 10BB

Audit report under section 10(23C) of 
the Income-tax Act, 1961, in the case 
of any fund or trust or institution or 
any university or other educational 
institution or any hospital or other 
medical institution referred to in 
sub-clause (iv) or sub- clause (v) or 
sub-clause (vi) or sub-clause (via) of 
section 10(23C).

Company,AOP/BOI/Trust/
Firm/AJP/LA

NO YES
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31 
Form 

10CCB
Audit report under sections 
80-I(7)/80-IA(7)/80-IB/80-IC 

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

32 
Form 

10CCBBA
Audit report under section 80-ID(3)
(iv)

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

33 
Form 

10CCBC
Audit report under section 80-IB(11B)

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

34 
Form 

10CCBD
Report of accountant under section 
80-IB(11C)

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

35 
Form 

10CCC
Certificate under sub-rule (3) of rule 
18BBE of the Income-tax Rules, 1962 

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

36
Form 

10CCD

Certificate under sub-section (3) of 
section 80QQB for Authors of certain 
books in receipt of Royalty income, 
etc.

Individual YES NO

37 
Form 
10CCE

Certificate under sub-section (2) 
of section 80RRB for Patentees in 
receipt of royalty income, etc. 

Individual YES NO

38 
Form 
10CCF

Report under section 80LA(3) of the 
Income-tax Act, 1961

Company,AOP/BOI/Trust/
Firm/AJP/LA

YES NO

39 Form 10DA
Report under section 80JJAA of the 
Income-tax Act, 1961 

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

40 Form 10E

Form for furnishing particulars of 
income u/s 192(2A) for the year 
ending 31st March, 20..... for claiming 
relief u/s 89(1) by a Government 
servant/an employee in a company, 
co-operative society, local authority, 
university, institution, association/
body

Individual YES NO

41 Form 10G

Application for grant of approval to 
fund or institution under clause (vi) of 
sub-section (5) of section 80G of the 
Income-tax Act, 1961

Company,AOP/BOI/Trust/
Firm/AJP/LA

YES NO

42 Form 10H
Certificate of foreign inward 
remittance 

Individual YES NO

43 Form 10-IB
Application for exercise of option 
under sub-section (4) of section 
115BA of the Income - tax Act,1961 

Company/Firm YES NO

44 Form 10-IC
Application for exercise of option 
under sub-section (5) of section 
115BAA of the Income - tax Act, 1961

Company YES NO

45 Form 10-ID
Application for exercise of option 
under sub-section (7) of section 
115BAB of the Income-tax Act, 1961

Company YES NO

46 Form 15CA
Information to be furnished for 
payments to a non-resident not being 
a company, or to a foreign company 

Individual, HUF, Company, 
AOP/BOI/Trust/Firm/AJP/LA, 

Tax Deductor & Collector
YES YES

47 Form 15CB Certificate of an accountant
Individual, HUF, 

Company,AOP/BOI/Trust/
Firm/AJP/LA

NO YES

48 Form 15CC

Quarterly statement to be furnished 
by an authorised dealer in respect of 
remittances made for the quarter of 
..... of ..... (Financial Year)

Individual, HUF, Company, 
AOP/BOI/Trust/Firm/AJP/

LA,Tax Deductor & Collector
NO YES

49 Form 15G 
(Consolidated)

Statement of Declaration under 
section 197A (1) and section 197A 
(1A) by an individual or a person (not 
being a company or firm) claiming 
certain incomes without 
deduction of tax.

Tax Deductor & Collector NO YES
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50 Form 15H 
(Consolidated)

Statement of Declaration under 
section 197A(1C) by an individual who 
is of the age of sixty years or more 
claiming certain incomes without 
deduction of tax.

Tax Deductor & Collector NO YES

51 Form 24Q

Quarterly statement of deduction of 
tax under sub-section (3) of section 
200 of the Income-tax Act, 1961 in 
respect of salary for the quarter 
ended...(June/September/December/
March) ...(Financial year)

Tax Deductor & Collector NO YES

52 Form 26A

Furnishing Accountant certificate 
under the first proviso to sub-
section(1) of section 201 of the 
Income Tax Act, 1961 

Tax Deductor & Collector YES NO

53 Form 26Q

Quarterly statement of deduction 
of tax under sub-section (3) of 
section 200 of the Income-tax Act, 
1961 in respect of payments other 
than salary for the quarter ended...
(June/September/December/March) 
...(Financial year)

Tax Deductor & Collector NO YES

54 Form 27BA

Furnishing Accountant certificate 
under the first proviso to sub-
section(6A) of section 206C of the 
Income Tax Act, 1961 

Tax Deductor & Collector YES NO

55 Form 27EQ

Quarterly statement of collection of 
tax at Source under section 206C of 
Income-tax Act, 1961 for the quarter 
ended... June/September/December/
March ...(Financial year)

Tax Deductor & Collector NO YES

56 Form 27Q

Quarterly statement of deduction 
of tax under sub-section (3) of 
section 200 of Income-tax Act, 1961 
in respect of payments other than 
Salary made to non-residents for the 
quarter ended.... June/September/
December/March ...(Financial year)

Tax Deductor & Collector NO YES

57 Form 29B
Report under Section 115JB of the 
Income-tax Act, 1961 for computing 
the book profits of the company

Company YES YES

58 Form 29C

Report under section 115JC of the 
Income-tax Act, 1961 for computing 
Adjusted Total Income and Alternate 
Minimum Tax of the person other 
than a company

Individual, HUF,AOP/BOI/
Trust/Firm/AJP/LA

YES YES

59 Form 35
Appeal to the Commissioner of 
Income-tax (Appeals) 

Individual, HUF, Company, 
AOP/BOI/Trust/Firm/AJP/

LA,Tax Deductor & Collector
YES NO

60 Form 40C
Application for recognition of a 
recognisied provident funds

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

61 Form 41
Form for maintaining accounts of 
subscribers to a recognised provident 
fund

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

62 Form 49C
Annual Statement under section 285 
of the Income-tax Act,1961 

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

63 Form 49D
Information and documents to be 
furnished by an Indian concern under 
section 285A 

Company,AOP/BOI/Trust/
Firm/AJP/LA

YES NO

64 Form 52A

Statement to be furnished to the 
Assessing Officer under section 285B 
of the Income-tax Act, 1961, in respect 
of production of a cinematograph film 

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

65 Form 56

Application for grant of the 
exemption under sub-clauses (iv), 
(v), (vi) and (via) of clause (23C) of 
section 10 of the Income-tax Act, 1961 

Company,AOP/BOI/Trust/
Firm/AJP/LA

YES NO
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66 Form 56F
Report under section 10A of the 
Income-tax Act, 1961

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

67 Form 56FF

Particulars to be furnished under 
clause (b) of sub-section (1B) of 
section 10A of the Income-tax Act, 
1961 

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

68 Form 62

Certificate from the principal officer 
of the amalgamated company and 
duly verified by an accountant 
regarding achievement of the 
prescribed level of production and 
continuance of such level of 
production in subsequent years.

Company YES NO

69 Form 63

Statement to be furnished to the 
Assessing Officer designated under 
rule 12B of the Income-tax Rules, 
1962, in respect of income distributed 
by the Unit Trust of India

Company YES NO

70 Form 63A

Statement to be furnished to the 
Assessing Officer designated under 
rule 12B of the Income-tax Rules, 
1962, in respect of income distributed 
by a Mutual Fund

Company YES NO

71 Form 64

Statement of income paid or credited 
by Venture Capital Company or 
Venture Capital Fund to be furnished 
under section 115U of the Income-tax 
Act, 1961. 

Company,AOP/BOI/Trust/
Firm/AJP/LA

YES YES

72 Form 64A

Statement of income distributed by a 
Business Trust to be furnished under 
section 115UA of the Income-tax Act, 
1961.

Company,AOP/BOI/Trust/
Firm/AJP/LA

NO YES

73 Form 64D

Statement of income paid or credited 
by investment fund to be furnished 
under section 115UB of the Income-
tax Act, 1961. 

Company,AOP/BOI/Trust/
Firm/AJP/LA

NO YES

74 Form 64E

Statement of income paid or credited 
by a securitisation trust to be 
furnished under section 115TCA of the 
Incometax Act, 1961

Company,AOP/BOI/Trust/
Firm/AJP/LA

NO YES

75 Form 65

Application for exercising/renewing 
option for the tonnage tax scheme 
under sub-section (1) of section 115VP 
or sub-section (1) of section 115VR of 
the Income-tax Act, 1961 

Company YES NO

76 Form 66
Audit Report under clause (ii) of 
section 115VW of the Income-tax Act, 
1961 

Company YES NO

77 Form 67
Statement of income from a country 
or specified territory outside India 
and Foreign Tax Credit 

Individual, HUF, 
Company,AOP/BOI/Trust/

Firm/AJP/LA
YES NO

78 RGESS
Annual Report to be submitted by 
the depository to the Income Tax 
Department

External Agency NO YES
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AIR Annual Information Return

AJP Artificial Jurisdiction Person

AO Assessment Officer 

AOP Association of Persons 

AST Legacy System used by AO till FY2015-16

ATM Automated Teller Machine

AY Assessment Year

BOI Body of Individual

BSR Basic Statistical Report

CA Chartered Accountant

CBDT Central Board of Direct Taxes

CCA Controller of Certifying Authorities

CDSL Central Depository Services (India) Ltd

CIN Corporate Identity Number

CPC Centralized Processing Centre

DIN Document Identification Number

De IN Demand Identification Number

DOB Date of Birth

DSC Digital signature certificates

DTAA Double Taxation Avoidance Agreement 

ECS Electronic Clearing Service

ERI e-Return Intermediary

EVC Electronic Verification Code

FY Financial Year

HP House Property

HTTP Hypertext Transfer Protocol 

HTTPS Secure Hypertext Transfer Protocol 

HUF Hindu Undivided Family

ITBA Income Tax Business Applications Systems
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ITDREIN 
Income Tax Department Reporting Entity 
Identification Number 

ITR Income Tax Return 

ITR-V Income Tax Return Verification 

IVRS Interactive Voice Response System

LLP Limited Liability Partnership

Legal Heir Legal Representative of a deceased person

NCLT National Company Law Tribunal 

NMS Non-filers Monitoring System

NPCI National Payments Corporation of India

NRI Non-Resident Indian

NSDL National Security Depositary Limited

OTP One Time Password

OS Other Sources (Heads of Income)

PAN Permanent Account Number

Part A or B Part A or B of the ITR

PFMS Public Financial Management System

POA Power of Attorney

Pre Validation Pre validation of bank account on e-filing System

SFT Statement of Financial Transaction

Suo Motu An action taken by Department on its own

TAN Tax Deduction and Collection Account Number 

TCS Tax Collected at Source

TDS Tax Deducted at Source

TRACES TDS Reconciliation, Analysis and Correction Enabling System 

UIDAI Unique Identification Authority of India

USB Universal Serial Bus

XML Extensible Markup Language
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